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Copyrights 

 

BIA Financial Network, Inc. 
This database is Copyright© 2003 by BIA Financial Network, Inc. and may not be 
reproduced in whole or in part by any means, including photocopying or recording 
on or for any information storage or retrieval system without prior express written 
permission.  All rights reserved. 

Information in this database is solely for the use of BIA Financial Network, Inc. 
clients and is not intended as the basis for private offering or for use in a prospectus 
without the express permission of BIA Financial Network, Inc.  Permission is 
normally granted upon request, pursuant to execution of an indemnification and 
release form. Please contact BIA Financial Network, Inc. (http://www.bia.com) for 
further information regarding your requirements. 

Arbitron, Inc. (Radio) 
Copyright © 2003 Arbitron, Inc.  For use by licensed subscribers only. Reprinted 
with permission. All audience estimates and/or data contained herein are copyrighted 
by and proprietary to Arbitron, Inc. Arbitron reserves all rights with respect to its 
data. No such data may be reproduced or transmitted in any form or by any means 
including but not limited to photocopying or recording on or for any information 
storage or retrieval system, including the internet, without the prior express written 
consent of Arbitron. All Arbitron data are subject to the qualifications and limitations 
stated in Arbitron’s reports.  Due to these qualifications and limitations, the accuracy 
of Arbitron’s data cannot be determined to any precise mathematical value or 
definition. 

For more information, visit http://www.arbitron.com. 

Nielsen Media Research (Television) 
Copyright © 2003 Nielsen Media Research, Inc..  All audience estimates contained 
herein are copyrighted by and proprietary to Nielsen Media Research (Nielsen). 
Nielsen reserves all rights with respect to its audience estimates and data. No such 
estimates or data may be reproduced or transmitted in any form or by any means, 
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including photocopying or recording on or for any information storage or retrieval 
system without the prior express written consent of Nielsen. All Nielsen audience 
data are estimates and are subject to the methodological limitations stated in 
Nielsen’s local market reports. Due to these limitations, the accuracy of Nielsen’s 
audience estimates cannot be determined to any precise mathematical value or 
definition. 

For more information, visit http://www.nielsen.com/nielsen_media_research.html. 

Audit Bureau of Circulations (Newspaper) 
Circulation Data was obtained from Copyright 2002 material of the Audit 
Bureau of Circulations and reprinted by permission. 

For more information, visit http://www.accessabc.com. 

Market Statistics, Inc. (All Versions) 
The market demographic and economic data in this publication is based on data 
prepared by Market Statistics, published in Demographics USA© 2002—County 
Edition and is Copyright 2002 by Interactive Market Systems, Inc.  Any questions or 
comments regarding these data should be directed to: 

 

  TradeDimensions 

  45 Danbury Road 

  Wilton, CT  06897 

  Tel: (203) 563-3000 

  Fax: (203) 563-3131 

  www.TradeDimensions.com 
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Data and Software Licensing 
Agreement 

Software License Agreement 
It is important that you carefully read this notice before proceeding with accessing 
the information contained on these diskettes/CDs. Please be aware that this product 
is copyrighted material and to copy this product, in whole or in part, for any reason 
other than to have a single backup copy, constitutes a violation of copyright laws and 
can lead to the imposition of penalties and fines. 

By continuing, you agree to be bound by all of the terms and conditions of this 
license agreement.  If you do not accept the following terms, do not continue. Call 
BIAfn for further instructions. 

Software License Agreement 
BIA Financial Network, Inc. (formerly BIA Publications, Inc.) licenses (not sells) 
this data and/or software and data contained therein to you.  It is important you 
understand that you are only granted a non-exclusive, non-transferable license to use 
this copy of specific data and/or software program, including all additional modules, 
with the data contained therein, (to be referred to as “MEDIA Access Pro” or 
“program” through the remainder of this contract), according to the following terms: 

YOU MAY use one copy of the data and/or MEDIA Access Pro on a single 
computer. You may install the data and/or MEDIA Access Pro on more than one 
computer (i.e., a laptop or home computer) as long as your original copy of the data 
and/or MEDIA Access Pro is not also being used at the same time on a different 
machine. If you purchased multiple licenses, then at any given time, you may have as 
many copies in use for which you are licensed. 

YOU MAY use this data for any legitimate purpose connected with your business 
provided it does not violate any of the exclusions or conditions listed below. 

YOU MAY distribute the results of your research (reports and/or verbal information) 
to clients and generally use this data and/or MEDIA Access Pro for any legitimate 
purpose for which it was designed. 

YOU MAY export the data into other software packages, as long as the person(s) 
accessing the data is deemed an authorized user and/or additional user of the data 
and/or the MEDIA Access Pro program. 
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YOU MAY NOT make copies of the data and/or MEDIA Access Pro for the 
purpose of commercial or mass distribution. This applies to any business partner, 
affiliates, or any person who is not a direct employee of the licensing company and 
an additional user of the data and/or MEDIA Access Pro program.   

YOU MAY NOT distribute the data files or MEDIA Access Pro to clients or anyone 
not directly affiliated with you, the licensee, for the purpose of allowing them to 
conduct their own research. 

YOU MAY NOT use this data as the starting point for a derivative work including 
but not limited to publications or a different database that you intend to distribute, 
either by sale or giveaway, in whole or in part. 

YOU MAY NOT use this data and/or MEDIA Access Pro on more computers than 
for which you are licensed. 

YOU MAY NOT make any changes to the data or the program. Specifically, you 
cannot modify, translate, reverse engineer, decompile, disassemble, create derivative 
works based on, or copy (except for one backup copy) this program, or 
accompanying documentation. 

YOU MAY NOT rent, transfer, sublease or grant any rights for the program, the 
data or accompanying documentation in any form, to any person, except as provided 
above, without express written permission from BIA Financial Network, Inc.. 

Limited Warranty 
BIA Financial Network, Inc. warrants the physical media and physical 
documentation to be free of defects in materials and workmanship for the term of the 
license agreement. If you encounter defects in materials or workmanship during the 
license term, contact BIA Financial Network, Inc. for a replacement. BIA Financial 
Network, Inc. strives for high data integrity, but at no time guarantees 100% 
accuracy. 

The entire and exclusive liability and remedy for breach of this limited warranty 
shall be limited to replacement of defective media or documentation.  It shall not 
include or extend to any claim for or right to recover other damages, including, but 
not limited to loss of profit, data, or any other damages or other similar claims. In no 
event will BIA Financial Network, Inc.'s liability for any damages to you or any 
other person ever exceed the price paid for the license to use this data or software, 
regardless of the form of the claim. 

BIA Financial Network, Inc. specifically disclaims all other warranties, 
representations, or conditions, express or implied, including but not limited to any 
implied warranty or fitness for a particular purpose.  Specifically, BIA Financial 
Network, Inc. makes no representation that the software, data or documentation are 
error free or meet any particular user’s standards, requirements or needs.  BIA 
Financial Network, Inc. will not be liable for any loss of profit or any other 
commercial damage resulting from the use of this product. 

General 
In addition to the above, you agree to use reasonable efforts to protect the program 
and data from unauthorized use, reproduction, distribution or publication. Unless 
otherwise stated, the initial term of this agreement will be for a ONE YEAR 
licensing period from the date of payment; however, all terms and conditions of this 
"Data & Software License Agreement" will remain in effect throughout all renewal 
periods of this master agreement.  

The laws of the Commonwealth of Virginia govern this agreement. 
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If you have any questions, please contact BIA Financial Network, Inc., 15120 
Enterprise Ct., Chantilly, VA 20151  (703) 818-2425, FAX: (703) 803-3299. 
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Technical Support 

BIA Financial Network, Inc. provides detailed documentation and online help as the 
first means of supporting your use of MEDIA Access Pro™. If these sources do not 
contain the answers to your questions, contact MEDIA Access Pro™ customer 
support by phone, fax, or e-mail. Unless otherwise agreed, technical and customer 
support is unlimited to licensed users.  

To help us help you, please follow these steps when contacting customer support: 

1. If you call, be at your computer and have the documentation at hand. 

2. Provide the following information: 

• Licensed user’s name and company name 

• Your MEDIA Access Pro™ Registration Number(s) 

• The wording of any messages that appear on your screen or the 
basics of the search you are trying to perform. 

• If applicable, lists of what steps were taken leading up to the 
problem. 

MEDIA Access Pro™ customer and technical support is available as follows: 

Phone:  1-607-936-6737 

Hours:  Monday - Friday, 9:00 a.m. - 5:30 p.m. EST 

Fax:   1-703-803-3299 

E-mail:  mahelp@bia.com 

Web Site:   http://www.bia.com 
 

NOTE: MEDIA Access Pro™ customer and technical support policies are subject to 
change without notice. 
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1: About BIAfn's MEDIA Access 
Pro™ 

Overview 
MEDIA Access Pro™ is an easy to use program that gives you full access to the 
databases BIAfn uses to produce our Investing in Radio®, Investing in Television®, 
Radio Yearbook® and Television Yearbook® publications. Also included is a digital 
database of newspaper industry information. The program also supports the analyses 
profiled in BIAfn's periodic media-related State of the Industry studies. You can 
query, sort and manipulate the databases, print reports or mailing labels and even 
export data to other programs. MEDIA Access Pro™ interprets your instructions and 
turns them into commands the computer can understand. You can perform very 
powerful searches without learning any database programming commands. 

This program, and all data included with this program, are the property of BIA 
Financial Network, Inc. The user of this program has licensed the software and data 
from BIA Financial Network strictly for the purposes agreed upon in the license 
agreement. 

This program may be used only by the party identified in the license agreement and 
only under the terms specified in the license agreement. This program cannot be 
copied. Violators will be prosecuted. 

As a practical matter, we make every effort to maintain our data in the most 
complete form possible, and this involves many people and valuable resources.  We 
do not believe you could possibly maintain a database with the quality approaching 
our standards, unless you spend the hundreds of thousands of dollars and multitude 
of man-hours each year that we do to ensure its accuracy.  This is unnecessary, 
because unless otherwise agreed upon, you have the ability to update your MEDIA 
Access Pro™ data as frequently as once per day via the Internet. 
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What's New With Version 4.0 
New versions, features and enhanced functionality is provided with the release of 
Version 4.0. See the short overview below. 

Newspaper Database Now Available  
Based on the same philosophy and successful model of our comprehensive and 
value-added databases for Radio and Television, BIAfn now captures, provides, and 
updates data on the Newspaper industry. Presently it contains nearly 600 fields of 
data for every daily newspaper in the U.S. This includes contact information for key 
personnel on the Newspaper Contacts Tab, ownership data, buying and selling 
activity, circulation, BIAfn’s estimate of revenues from advertising and circulation 
on the Newspaper Tab, market statistics, coverage maps and a great deal more. Of 
course it is available with all the familiar functionality in either the Contacts or 
Analyzer packages and you can add Coverage Maps to either one. Custom research 
on the Newspaper industry by BIAfn’s analysts is now also greatly enhanced by this 
new offering. Information power crucial for M&A, financial, operational, and 
marketing decisions regarding the newspaper industry has leaped to new heights with 
BIAfn’s MEDIA Access Pro™ Newspaper program. 

Integrating Media Industry Data 
Clients have requested and now it is here—the ability to look at and work with the 
Radio and Television data, and now Newspaper as well, all at one time. With the 
new Multi-Media functionality of Version 4.0, just click a button to view and 
compare cross-media data all on one screen. The power increases by the ability to 
link and sort the data by either Coverage, County, Owner, Arbitron Radio Market 
(MSA®) or Nielsen Television Market (DMA®). There is an impressive Excel Export 
feature that sends the data to a workbook to manipulate and further analyze. And 
that’s not all—Coverage Maps has been enhanced allowing you to visually see a 
coverage comparison of radio versus television versus newspaper. The multi-media 
integrated functionality found in MEDIA Access Pro™ Version 4.0 is not available 
anywhere else. This is a must-have tool for those expanding, competing, or investing 
in any of the media industries. 

Coverage Maps Enhanced and Improved 
Through the expertise of our partner, SiteSafe, Inc., the Coverage Maps feature of 
MEDIA Access Pro™ has been radically improved. The whole program has been 
redesigned using the premier mapping software, MapInfo®, providing a whole new 
range of added functionality. With the new mapping program, you now have the 
flexibility to display certain aspects of a coverage map via layers. The new program 
allows the flexibility to outline Arbitron or Nielsen markets; display state, county, 
and city borders and names; map highways and major roads; and more—just the way 
you want it to appear. Based on the results of a search, Radio and TV stations 
contours can still be plotted, and now Newspapers, and, depending, on the features 
for which you are licensed, the data can be integrated to create a map showing 
selected stations or newspapers all on the same map. These maps are easily printed 
or exported to different electronic file types for graphic presentations. You really 
have to see it and work with it to realize the full impact of the improvements.  

Other Beneficial Enhancements 
• The Quick Search and New Search features for Radio and Television now 

provide an easy solution for capturing only those stations you want to see by 
popping up a box called Search Only   that allows the elimination of Canadian, 
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Mexican, non-commercial, or stations of certain broadcast types (translators, 
low-power, etc.) from the results. 

• Digital television data has been beefed up to allow viewing of technical 
attributes for both analog and digital. See the Television Contacts Tab. 

• Television data has expanded more than 100% with the addition of Translators 
and completion of Low-power, giving a more complete picture of the television 
industry. 

• Television stations operating with translators now have a button on the Contacts 
tab that provide a pop-up screen that displays all of the Translators affiliated 
with the subject station. See the Television Contacts Tab for the button to access 
Translators. 

• A new field, Market Designation Date  has been added to the Radio Station 
Tab. This field reflects the date that BIAfn designates the home market for that 
station as determined by Arbitron. This is important as it pertains to the new 
two-year FCC safeguard, as outlined in paragraph 278 of the Commission's 
recent report and order. Starting with the issuance of that report and order going 
forward, any change in market definition (e.g., adding or deleting a county to a 
market) or change in home status of a particular radio station will have to be in 
place for two years before a radio owner can act on it. The Commission has 
designated data contained in MEDIA Access Pro™ as of July 3, 2003 as the 
benchmark. The Market Designation Date will change when a station moves in 
or out of a market or changes to a new market. 

• Coverage Area Population  has also been added to the Radio Station Tab and 
Television Station Tab as a new data point for assessing the reach of a station, 
important for station benchmarking, competitive analysis and valuation 
assessment. This data is provided by SiteSafe and will be updated weekly for all 
commercial and non-commercial stations.  

• Under Saved Searches in Radio, the FCC Geographic Market Stations  Saved 
Search has been added. This built-in search will provide a list of all the stations 
that are home to a particular market rank plus all stations that are physically 
located in one of the counties in the market but are home to another market 
according to the Arbitron definition. This includes non commercial stations as 
well as the commercial stations. Under Print > Custom Reports in Radio, the 
FCC Geographic Market Definition Report  prints this listing showing the 
stations which belong to that market plus what the "home market" is for that 
station. It also gives the total number of stations in the geographic market (i.e. 
New York has 145 stations in the geographic market). 

We thank our clients for all your continued support and input on how we can 
improve MEDIA Access Pro™. We look forward to your feedback and to 
announcing our launch of the Cable Television database coming soon. 

 MEDIA Access Pro™ Database Components 
BIA Financial Network, Inc. takes extreme pride in providing you the most up-to-
date information available on the radio, television and newspaper industries. We 
collect and maintain data daily from various sources such as the FCC, trade 
publications, press releases, and market contacts. Each radio station , television 
station, and daily newspaper  (13,000+ , 10,000+, and 1,400+ respectively at the time 
of this publishing), as well as their owners, are called, e-mailed, and faxed repeatedly 
during the year by BIAfn's trained staff of research professionals confirming contact 
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and other critical information. Annually, we survey the industries by e-mail, US 
mail, fax and phone to derive BIAfn's proprietary estimated revenues. This 
information is provided in various single media or multi-media databases to our 
clients through MEDIA Access Pro™. 

The contents of this User Manual covers all the features available for MEDIA 
Access Pro™, therefore, you may find that it covers more than that for which you are 
licensed. The following is a short description of the various packaging and features 
covered in this manual and available at this time through BIA Financial Network, 
Inc.: 

Contacts 
Overview: With approximately 400 fields of information for every station or 
newspaper, the Contacts feature of MEDIA Access Pro™ supplies you with the 
information you need to reach the decision makers at stations and newspapers in the 
U.S. and some areas of Canada and Mexico. 

What You Get: 

• Mailing and physical address, phone, fax, e-mail, Web site 

• Key personnel 

• Technical facility data 

• Format (Radio), affiliation (TV), or frequency (Newspaper) 

• Market and geographic location 

• Owner mailing and physical address, phone, fax, e-mail, Web site 

• Owner key personnel and individual mailing address, etc. 

• Parent company mailing and physical address, phone, fax, e-mail, Web 
site 

• Parent company key personnel and individual mailing address, etc. 

• 10+ built-in, custom reports 

• Standard mailing label printing capability (eliminating duplicates) 

• Data exporting to Excel, Lotus, ASCII, WordPerfect and other database 
programs 

• Customizing options for add your own contacts 

• Integrated data searching, viewing, exporting and printing for all multi-
media subscribers (i.e., radio + television; television + newspaper; 
radio + newspaper; or radio + television + newspaper) 

• The option to add the Rankers or Expanded Ratings (Radio only) and 
Coverage Maps features  

Who Uses It: Contacts are a "must-have" if you need to stay on top of who's who 
and who's where in the radio, television, and newspaper industries - especially with 
the ability to download daily updates! Equipment manufacturers and suppliers, 
programming consultants and sources, and other critical service providers to the 
industry rely on BIAfn's MEDIA Access Pro™ Contacts as their contact 
management data source.  

Contacts are a part of each full database package. However, Contacts can be 
purchased as a separate database service. 
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Analyzer  
Overview: With between 800 and 1,100 fields of data for nearly every U.S. (and 
selected Canadian and Mexican) radio stations, television stations and daily 
newspapers, MEDIA Access Pro™ is the most comprehensive analytical tool 
available to meet the needs of these dynamic industries. Critical decision-making 
data, includes ratings, revenues, market and transactional information. 

What You Get: 

• Integrated data searching, viewing, exporting and printing for all multi-
media subscribers (i.e., radio + television; television + newspaper; 
radio + newspaper; or radio + television + newspaper) 

• 16 books of historic audience shares (Radio - Arbitron; Television - 
Nielsen) for rated stations and up to 7 years of historic circulation 
estimates for newspapers 

• Station advertising revenues estimated for most rated radio and 
television stations and estimated advertising and circulation revenues 
for newspapers 

• Financial, audience and subscriber performance indicators: revenue 
share, power ratio, and local commercial share for stations with 
estimated revenues 

• Historic transaction information: who bought and sold what from 
whom, when, for how much and the terms of the deal 

• Estimated historic and projected market revenues 

• Historic and projected market population and financial statistics 

• Market demographic breakdowns by gender and age groups  

• Market and industry competitive factors 

• For radio and television, a map depicting the counties included in that 
market and the cities of licensed stations identified. 

• The option to add the Rankers or Expanded Ratings (Radio only) and 
Coverage Maps features 

Who Uses It: Owners, investors and advertisers rely heavily on BIAfn's MEDIA 
Access Pro™ to maintain their competitive edge with the program's continually 
updated, critical information.  

Brokers, commercial bankers, investment bankers, Wall Street firms, FCC law firms, 
consulting firms, and the like use MEDIA Access Pro™ to analyze potential deals 
and to search for opportunities in the marketplace.  

Service and equipment providers to the industry use MEDIA Access Pro™ to 
identify and contact media industry target market opportunities. 

Regulatory agencies, trade associations and major networks utilize the program as 
reference tools and to update their own in-house databases. 

There is no other source that can be updated daily, is as comprehensive, and as easy 
to use as BIAfn's MEDIA Access Pro™. 
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BIAMapX™ Coverage Maps 
BIAMapX™ is built on a MapInfo® platform that allows you to produce station 
contours and newspaper county Coverage Maps based on the results of your search 
from BIAfn’s MEDIA Access Pro™. 

With BIAMapX™ you won't have to wait days for a coverage map to be produced 
and delivered. You'll have the power to draw, view, export and print maps with the 
click of a mouse. Just select as few or as many of the stations or newspapers from 
your search that you want to plot. You can also easily control the detail displayed 
(market outlines, city names, rivers and highways, etc.) and the color and format of 
your output. When satisfied, send the map to your printer or you can easily create an 
electronic graphic file to attach to an e-mail or place as an image in a document. 

Expanding the power of coverage maps is the ability of BIAMapX™ to display the 
integrated elements of all media editions at once. Subscribers to two or more 
industry editions (radio + television; television + newspaper; radio + newspaper; or 
radio + television + newspaper) can plot contours and coverage areas of all licensed 
media on the same map. 

Available for radio, television, and newspaper. 

Radio Rankers 
BIAfn's MEDIA Access Pro™ Radio Rankers gives you the ability to track the 
rankings of a radio station's ratings in its critical demographics and dayparts for 
every market in which it's rated by Arbitron. 

With Rankers you can generate a custom report profiling a station's demographics 
and its ranking within a rated market. 

With MEDIA Access Pro™'s Rankers, you can even perform due diligence for 
acquisitions or other important strategic maneuvers-all within minutes! 

Available for Radio only. 

 

Radio Expanded Ratings 
BIAfn's MEDIA Access Pro™ Expanded Radio Ratings takes Rankers ten steps 
further, by giving you the ability to track the actual shares, persons and calculated 
rankings of a radio station's ratings in its critical demographics and dayparts for 
every market in which it's rated by Arbitron. 

With Expanded Ratings you can generate a custom report profiling a station's 
demographics and its share, number of persons and ranking as it relates to its 
competitors within a rated market. 

With MEDIA Access Pro's Radio Expanded Ratings, you can even perform due 
diligence for acquisitions or other important strategic maneuvers-all within minutes! 

Available for Radio only to those companies with a current licensed Arbitron 
subscription. 
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About This Manual 
This User Manual provides an overview of the features available and tasks you can 
accomplish using BIAfn's MEDIA Access Pro™.  

This manual assumes that you: 

• Are familiar with working in the Windows operating systems 

• Know how to find and open files 

• Have a familiarity with the Radio, Television and/or Newspaper 
industries 

The User Manual to BIAfn's MEDIA Access Pro™ covers the complete functionality 
of all of the available MEDIA Access Pro™ editions and features. Depending on the 
edition you are licensed to use, you may or may not find some of the features 
described herein available to you. For information on how to expand your licensed 
edition of MEDIA Access Pro™, call your BIAfn sales executive at 1-800-331-5086. 
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2: Installation and Data Updates 

This chapter provides you with requirements for operating MEDIA Access Pro™, 
program installation, data updating, and program starting instructions. 

Assumptions 
The Online Help and User Manual assumes you have a basic understanding of 
Windows fundamentals -- using the mouse, keyboard, and working within Windows, 
etc. If you are new to the Windows environment, refer to your Windows manual or 
take a few minutes to run through the Windows User and Systems Guide  and 
Windows Basics  accessed by left clicking on the open Windows desktop and 
pressing the F1 function key.  NOTE: This may require that your Windows CD-
ROM be installed in your CD-ROM drive. 

System Requirements 
BIAfn’s MEDIA Access Pro™ is a Microsoft® Windows™ program and requires a 
reasonably fast Windows™ personal computer that includes the following: 

• At least a Pentium™ processor 

• A minimum of 16 MB of RAM (the more RAM, the faster the program 
will operate) 

• Microsoft® Windows95™, Windows98™, Windows NT™, 
Windows2000™, WindowsME™, or WindowsXP™ operating system 

• Microsoft Internet Explorer Version 5 or newer installed on your 
computer. This program can be downloaded from Microsoft at 
www.microsoft.com/windows/ie/default.htm.  

• A mouse 

• A CD-ROM (or access via a network for installation) 

The following minimum hard disk requirements: 

Contacts 
• Radio -- 60 MB 

• Television -- 45 MB 
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• Newspaper -- 32 MB 

• Combined: Radio, TV & Newspaper -- 95 MB 

Analyzer  
• Radio -- 86 MB 

• Television -- 56 MB 

• Newspaper -- 35 MB 

• Combined : Radio, Television and Newspaper -- 135 MB 

Radio Rankers 
• additional 5 MB 

Expanded Radio Ratings 
• additional 20 MB 

Coverage Maps  
• Installed on Hard Drive -- additional 650 MB (recommended -- 

installing all data to a hard disk or network drive will derive the best 
performance) 

• Run from CD-ROM -- additional 50 MB  

Optional, But Recommended: 
• A printer supported by Windows. You can print reports and/or labels to 

any printer supported by Windows, however, a laser printer will be the 
easiest to use and will produce the fastest and best looking output. 

• Internet access for updating station / newspaper / coverage maps data. 

BIAfn’s MEDIA Access Pro™ Package Contents 
When you purchase BIAfn’s MEDIA Access Pro™ you must sign a license 
agreement. You should then receive a package containing the following. 

• The CD-ROM containing the program files (Contacts, Analyzer, Radio 
Rankers, Expanded Radio Ratings, and/or Coverage Maps (possibly on 
a separate CD-ROM)) and this User Manual formatted for the Adobe 
Acrobat Reader™ (also included on the CD-ROM). 

• Documentation containing your MEDIA Access Pro™ Registration 
Number (sometimes referred to as “Serial Number”), username and 
password 
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License Agreement 
License agreements for BIAfn’s MEDIA Access Pro™ are available for a single 
user, multiple users in one office (not networked); multiple users networked in one 
office; and multiple users in multiple offices (sites).  Regardless of which license 
agreement you signed, your copy of the program is licensed to and is to be used by 
you only. 
 

MEDIA Access Pro™ Installation Instructions 
The following instructions guide you through the installation of MEDIA Access 
Pro™ for a Full Version (on a stand-alone machine or on a Network), a Workstation 
on a network.  

Full Version Installation (Stand-alone and Network) 
The Full Version installs on your stand-alone machine or on the network file server, 
the components of MEDIA Access Pro™ for which you are licensed. For installation 
to a workstation connected to a network see Workstation Installation Instructions.  

Important Network Installation Notes 
 Even though the network installation of MEDIA Access Pro™ is relatively 

uncomplicated, it is highly recommended that your Network Administrator 
perform this process. The Administrator will have the necessary network rights 
and an understanding of how the network is configured.  

 Because, no matter what drive or filepath it is installed to, MEDIA Access Pro™ 
allows only one copy of the program to be installed to a computer, it is highly 
recommended that the installation for the Network server be installed directly 
from the network computer and not from a connected workstation. If this is not 
possible, e-mail (mahelp@bia.com) or call your MEDIA Access Pro™ Client 
Services (607-936-6737) for assistance. 

 With a re-installation or an upgrade of MEDIA Access Pro™ to your network, it 
is important to backup the customized network files (Network Comments, Saved 
Network Searches, Owner and Station Custom Contacts, etc.) prior to 
proceeding. From the BIADATA\Master\Data directory on your network drive, 
make a copy of the following files to a separate location to help ensure retention 
of the data. 

• nNetNote (Newspaper Network Comments and Custom 
Newspaper Contacts) 

• nNetOwn (Newspaper Custom Owner Contacts) 

• rNetNote (Radio Network Comments and Custom Station 
Contacts) 

• rNetOwn (Radio Custom Owner Contacts) 

• newsql  (Network Saved Searches) 

• tNetNote  (Television Network Comments and Custom Station 
Contacts) 

• tNetOwn (Television Custom Owner Contacts) 
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Full-Version Installation Instructions 
1. With your MEDIA Access Pro™ Registration number available, start 

Windows™ 

2. You should be at the Windows™ Desktop. (NOTE: Please refer to 
your Windows™ documentation for questions on the Windows™ 
Desktop.)  

3. For best results, close all other programs. 

IMPORTANT NOTE: If this is a re-installation or an upgrade and you 
have used the custom features such as Saved Searches, Custom 
Reports, Network and Local Comments, Custom Contacts, etc., to be 
on the safe side, it is very important that you stop and back up your 
custom features first. Follow the instructions under “Backing up 
Customized Files” under System Maintenance. 

4. Insert the MEDIA Access Pro™ CD-ROM into your CD-ROM drive. 

5. If your computer system supports the Auto Run feature, the MEDIA 
Access Pro™ installation will automatically launch (give it a few 
seconds). If not,  

• Click on Start  

• Choose Run  

• Type in or select from Browse:  d:\SETUP.EXE, where d is the 
name of your CD-ROM drive. 

NOTE: Previous versions of MEDIA Access Pro™ will be removed 
before the installation program will allow a replacement or upgraded 
version of the program to be installed. The installation procedure will 
automatically prompt you when this is necessary. After the previous 
version is uninstalled, follow the manual instructions for re-installing 
MEDIA Access Pro™ beginning at number 5 above. 

6. Read the “Welcome” message and press Next. 

7. Read the “License Agreement” and click on Yes if you agree with the 
agreement’s terms and conditions. Clicking on No will close the setup 
program. 

8. In the Setup Type screen select Full Version. 

9. Enter the appropriate Name and Company Name on the User 
Information screen and enter the Serial Number (also sometimes 
referred to as Registration Number) supplied to you by BIAfn in the 
appropriate space provided and click on Next.  

10. In the Choose Destination Location screen you designate the folder in 
which you want MEDIA Access Pro™ installed. Unless you are 
installing to a network or have a good reason to change the default 
directory, it is strongly recommended that you accept the directory 
suggested by the installation program (C:\BIADATA\MASTER). To 
accept this directory click on Next. Otherwise type in the new 
destination folder or click on the Browse button to open the Choose 
Folder box, locate the appropriate folder, click on OK and then on 
Next.  

11. The Setup Status screen next appears reporting the progress of your 
MEDIA Access Pro™ installation. When installation is complete you 
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will see the Setup Complete window. In some instances, you may be 
required to restart your computer before you can use the program. 
Select Yes and click on the Finish button.  

NOTE: Licensed BIAMapX™ Coverage Maps users should see Coverage Maps 
Installation for further instructions. 
 
Full Version Installation- Stand Alone, Continue to Page # 7 
 
Network Installation (Full Version) Continue to Page # 8 “Coverage Maps Network 
installation” 

NOTE: If you are doing a full number upgrade (from 3.X to 4.X), the installation 
process will NOT remove the 3.X MEDIA Access Pro™ icon from your desktop. To 
remove the icon, go to your Windows Desktop, right click on the 3.X icon, click on 
Delete, and OK. 

Congratulations! You have successfully installed MEDIA Access Pro™. When you 
purchase MEDIA Access Pro™ for the first time, a dataset is included, however, 
because the program is sometimes mass produced on CD-ROMs, the data may not be 
current and you will want to install a data update via the Internet. See Installing Data 
Updates later in this section. To start using the program immediately, proceed to 
Starting the Program later in this section. 

Workstation Installation Instructions 
Once the network installation is completed, you will need to setup MEDIA Access 
Pro™ on each of the user’s workstations. While this process is relatively 
uncomplicated, it is recommended that your Network Administrator perform this 
process. The Administrator will have the necessary network rights and an 
understanding of how the network is configured. This process will install the USER 
subdirectory on each workstation, along with any necessary Windows and FoxPro 
support files.  

Important Notes 
• Install the User files to the same directory location on each 

workstation, as MEDIA Access Pro™ assumes they are all using the 
same path. 

• Make certain that all users have full Read/Execute/Write/Modify access 
to the BIADATA\Master directories where MEDIA Access Pro™ and 
its affiliated programs are installed.  

Workstation Installation Instructions 
1. Start Windows™ 

2. You should be at the Windows™ Desktop.  

3. For best results, close all other programs. 

IMPORTANT NOTE: If this is a re-installation or an upgrade and 
you have used the custom features such as Saved Searches, Custom 
Reports, Network and Local Comments, Custom Contacts, etc., to be 
on the safe side, it is very important that you stop and back up your 
custom features first. Follow the instructions under “Backing up 
Customized Files” under System Maintenance. 

4. Insert the MEDIA Access Pro™ CD-ROM into your CD-ROM drive.  
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NOTE: If you prefer, it is possible to perform workstation installations 
of MEDIA Access Pro™ from a network drive instead of the CD-
ROM. Just copy all of the files from the CD-ROM to a network drive 
and proceed using the following instructions. 

5. If your computer system supports the Auto Run feature, the MEDIA 
Access Pro™ installation will automatically launch (give it a few 
seconds). If not,  

• Click on Start  

• Choose Run  

• Type in or select from Browse:  D:\SETUP.EXE, where d is the 
name of your CD-ROM drive. 

NOTE: Previous versions of MEDIA Access Pro™ will be removed 
before the installation program will allow a replacement or upgraded 
version of the program to be installed. The installation procedure will 
automatically prompt you when this is necessary. After the previous 
version is uninstalled, follow the manual instructions for re-installing 
MEDIA Access Pro™ beginning at number 5 above. 

6. Read the “Welcome” message and click on Next. 

7. Read the “License Agreement” and click on Yes if you agree with the 
agreements terms and conditions. Clicking on No will close the setup 
program. 

8. In the Setup Type screen select Workstation Install. 

9. On the User Information screen enter the appropriate Name of the User, 
Company Name and the Serial Number (also sometimes referred to as 
Registration Number) supplied to you by BIAfn in the appropriate 
space provided and click on Next.  

10. In the Choose Destination Location screen designate the folder in 
which you want the MEDIA Access Pro™ User Files installed. Unless 
you have a good reason to change the default directory, it is strongly 
recommended that you accept the directory suggested by the 
installation program (C:\BIADATA\MASTER). To accept this 
directory click on Next. Otherwise type in the new destination folder or 
click on the Browse button to open the Choose Folder box, locate the 
appropriate folder, click on OK and then on Next.  

REMINDER: As mentioned under Important Notes above, for proper 
operation by all workstation users, MEDIA Access Pro™ must be 
installed to the same directory path on each user’s machine. 

11. The Setup Status screen next appears reporting the progress of your 
MEDIA Access Pro™ installation. When installation is complete you 
will see the Setup Complete window. In some instances, you may be 
required to restart your computer before you can use the program. 
Select Yes and click on the Finish button.  

NOTE:  If you are a Coverage Map Subscriber, you will need to continue the 
installation of coverage maps please do so by going to Page # 9 “Workstation 
Installation.”  Otherwise, continue with next page.  
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Setup Icon 
After the workstation installation is complete, it is recommended that you add a new 
icon for MEDIA Access Pro™ to the workstation’s desktop.  

12. Right click on the Windows desktop. 

13. Select New > Shortcut. 

14. Click on Browse 

15. Open the BIADATA folder from the network drive on which you have 
installed the Full Version of MEDIA Access Pro™. 

16. Open the Master folder 

17. Select the Master.exe file 

18. Click Open 

19. Click Next 

20. Change (or rename) Master.exe to BIAfn’s MEDIA Access Pro. 

21. Click Finish. The FoxPro icon will now be on the desktop. 

 
22. To apply the MEDIA Access Pro™ icon, right click on the new icon 

you just created on the Windows Desktop and select Properties to 
open the Properties window. 

23. In the Shortcut tab, click on the Change Icon… button to open the 
Change Icon window. 

24. Click on the Browse button to locate the BIADATA\MASTER 
directory and highlight the icon file, MAPro.ico. 

25. Click Open. 

26. Click OK to replace the FoxPro icon with the MEDIA Access Pro™ 
icon. 

 
NOTE: If you are doing a full number upgrade (from 3.X to 4.X), the installation 
process will NOT remove the 3.X MEDIA Access Pro™ icon from your desktop. To 
remove the icon, go to your Windows Desktop, right click on the 3.X icon, click on 
Delete, and OK. 

Set User Path 
Next you need to instruct the workstation where to locate its User Files. 

27. Start the network copy of MEDIA Access Pro™ from the icon on the 
workstation desktop.  

NOTE: At this time the program will update all the files requiring you 
to wait several minutes until the “Updating Messages” cease appearing 
in the upper right corner of the screen. 

28. Select File > Change Settings 
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29. Click on Yes when the message, “WARNING: Any changes made to 
the Path Settings will affect all networked users of the program! Are 
you certain you want to proceed?”  

30. Change the User Path from the default of USER\ to the full path of the 
location on the local machine (default installation is 
C:\BIADATA\MASTER\USER) and confirm locations for the 
remaining settings (refer to the section on Change Settings in 14: 
System Maintenance). 

31. Click on Save.  

NOTE: With the first workstation you install you may get a series of 
Error Messages (this should not occur with subsequent workstation 
installations) such as “Rannotes.dbf not found” and “Open dataset 
box.” Although annoying, these errors are appropriate and you should 
click on the IGNORE button on all of the Error Messages and 
CANCEL on all of the OPEN messages until you eventually reach the 
clean MEDIA Access Pro™ screen. 

32. To initialize the local USER files and to begin using the program at this 
workstation, Exit (either File > Exit or click on the Quit button) and 
restart MEDIA Access Pro™.  

33. Repeat steps 1 through 32 for each workstation. 

NOTE: Licensed BIAMapX™ Coverage Maps users should see Coverage Maps 
Installation for further instructions. 

CONGRATULATIONS! BIAfn’s MEDIA Access Pro™ is now installed on the 
network and its users’ workstations.  

Coverage Maps Installation 

Stand-Alone Default Installation 
The following instructions take you through the steps of installing the BIAMapX™ 
Coverage Maps program to the hard drive of your computer, accepting all the 
defaults. 

1. Place the MEDIA Access Pro™ CD-ROM in the CD-ROM drive. If 
you are continuing the installation from the Page #4.  Your CD will 
already be in the drive and your program will (if auto run is supported) 
begin the Coverage Maps installation. If not, move to the next step. 

2. Click on Start > Run to open the Run window. 

3. Click on Browse. 

4. Double click on the BIAMapX subdirectory. 

5. Double-click on the Setup.exe file to open the BIAMapX InstallShield 
Welcome screen. 

6. Read any notes and warnings on the Welcome screen and click on 
Next. 

7. Read the “License Agreement” and click on Yes if you agree with the 
agreements terms and conditions. Clicking on No will close the setup 
program. 
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8. In the Setup Type screen, click on Complete and Next. 

The Installing BIAMapX window appears and the InstallShield 
program installs the appropriate BIAMapX files and reflects the 
progress in the bar under Status. 

9. The InstallShield Wizard Completed screen will appear when 
installation is complete. Click on Finish to complete the installation 
process for Stand-Alone. 

Stand-Alone with Data Run from the CD-ROM 
The BIAMapX™ installation includes some 400+ megabytes of base layer data 
(Counties, Cities, Streets, etc.) that is installed to your hard drive by default when 
you select the Complete setup. However, if hard drive space is at a premium, by 
selecting the Custom installation, you can opt to access this data from the program 
CD by following the instructions below. 

1. Follow steps 1 through 9 under Coverage Maps Stand-Alone Default 
Installation.  

2. In the Setup Type screen, click on Custom and Next. 

3. In the Custom Setup screen click on the plus sign to the left of the 
BIAData folder to see the BIAMaps subfolder. 

 

 
 

4. Click on the down arrow next to the BIAMaps subfolder and click on 
the “X  This feature will not be available” and then click on Next to 
proceed with the custom installation. 

The Installing BIAMapX window appears and the InstallShield 
program installs the appropriate BIAMapX files and reflects the 
progress in the bar under Status. 

5. The InstallShield Wizard Completed screen will appear when 
installation is complete. Click on Finish to complete the installation 
process for Stand-Alone and Network installations. 

6. With the MEDIA Access Pro™ CD-ROM in your CD-ROM drive, go 
to the Windows Desktop and double click on the BIAMapX™ icon to 
open the program. 

 
7. Click on File > Properties to open the Properties window. Under 

Paths 

8. MA MAP Data- should always remain C:\BIADATA  
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9. Contours- Click on the Browse button    and locate the \BIAData 
Folder on your Hard Drive and click on OK. 

10. MapX Data- Browse button    and locate the 
BIAMapX\BIAData\BIAMaps subdirectory on the CD-ROM drive 
and click on OK. 

11. In the Properties window, click on OK. 

12. Close the BIAMapX™ viewer to set the new properties. 

Network and Workstation Installation 
The following instructions provide you with the information for setting up the 
BIAMapX™ Coverage Maps for operation and data updating via a shared network 
drive and installing to the workstation user’s computer. 

Network Installation 

1. Place the MEDIA Access Pro™ CD-ROM in the CD-ROM drive of a 
workstation computer. 

2. Create the folder \BIAData\ on one of your network drives. 

3. Copy the contents of the BIAData folder (approximately 425 MB) from 
the MEDIA Access Pro™ CD-ROM (including the BIAMaps sub-
folder) to the newly created folder on the network. Therefore, on your 
network, you should have a BIAData folder with:  

• BIA.DAT 

• CONTOUR.DAT 

• CONTOUR.NDX, and 

• A BIAMaps sub-folder with the files BIA.GST and 
BIA_DATA_DIC.DAT, as well as Cities, County, Other and 
Streets sub-folders. 

Workstation Installation 

1. Click on Start > Run to open the Run window. If you are installing 
MEDIA Access Pro Workstation installation and your computer 
supports Auto run, you will start at step #5 below. Otherwise, continue.  

2. Click on Browse. 

3. Double click on the BIAMapX subdirectory. 

4. Double-click on the Setup.exe file to open the BIAMapX InstallShield 
Welcome screen. 

5. Read any notes and warnings on the Welcome screen and click on 
Next. 

6. Read the “License Agreement” and click on Yes if you agree with the 
agreements terms and conditions. Clicking on No will close the setup 
program. 

7. In the Customer Information screen type in the Name of the 
workstation user and the Organization Name. 

8. In the Setup Type screen, click on Custom and Next. 
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9. In the Custom Setup screen click on the plus sign to the left of the 
BIAData folder to see the BIAMaps subfolder. 

 

 
 

10. Click on the down arrow next to the BIAMaps subfolder and click on 
the “X  This feature will not be available” and then click on Next to 
proceed with the custom installation. 

The Installing BIAMapX window appears and the InstallShield 
program installs the appropriate BIAMapX files and reflects the 
progress in the bar under Status. 

11. The InstallShield Wizard Completed screen will appear when 
installation is complete. Click on Finish to complete the installation 
process for Stand-Alone and Network installations. 

12. With the MEDIA Access Pro™ CD-ROM in your CD-ROM drive, go 
to the Windows Desktop and double click on the BIAMapX™ icon to 
open the program. 

 
13. Click on File > Properties to open the Properties window. Under 

Paths 

14. MA MAP Data- should always remain C:\BIADATA (location of 
BIA.DAT file) 

15. Contours- Click on the Browse button    and locate the \BIAData 
Folder on your Server Drive and click on OK. 

16. MapX Data- Browse button    and locate the 
BIAMapX\BIAData\BIAMaps subdirectory on the Server drive and 
click on OK. 

17. In the Properties window, click on OK. 

18. Close the BIAMapX™ viewer to set the new properties..  

Sample DEMO Installation Instructions 
The MEDIA Access Pro™ CD-ROM contains a one-time, 30-day trial demo for all 
media databases (radio, television and newspaper). The demo allows you to run 
searches and view information. It does not, however, provide you with the ability to 
export or print any results of your searches. In addition, due to licensing restrictions 
with Arbitron Inc., the Ratings tab in the Radio Station Information will not exhibit 
data for the purposes of the demo.  
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1. Start Windows™ 

2. You should be at the Windows™ Desktop.  

3. For best results, close all other programs. 

4. Insert the MEDIA Access Pro™ CD-ROM into your CD-ROM drive. 

5. If your computer system supports the Auto Run feature, the MEDIA 
Access Pro™ installation will automatically launch (give it a few 
seconds). If not,  

• Click on Start  

• Choose Run  

• Type in or select from Browse:  D:\SETUP.EXE, where d is the 
name of your CD-ROM drive. 

NOTE: Previous versions of MEDIA Access Pro™ will be removed 
before the installation program will allow a replacement version of the 
program to be installed. The installation procedure will automatically 
prompt you when this is necessary. After the previous version is 
uninstalled, follow the manual instructions for re-installing MEDIA 
Access Pro™ beginning at number 5 above. 

6. Read the “Welcome” message and click on Next. 

7. Read the “License Agreement” and click on Yes if you agree with the 
agreements terms and conditions. Clicking on No will close the setup 
program. 

8. In the Setup Type screen select Sample DEMO Version.  

9. Enter the appropriate Name and Company Name on the User 
Information screen and click on Next. 

10. In the Choose Destination Location screen you designate the folder in 
which you want the MEDIA Access Pro™ user files installed. Unless 
you have a good reason to change the default directory, it is strongly 
recommended that you accept the directory suggested by the 
installation program (C:\BIADATA\MASTER). To accept this 
directory click on Next. Otherwise type in the new destination folder or 
click on the Browse button to open the Choose Folder box, locate the 
appropriate folder, click on OK and then on Next.  

11. The Setup Status screen next appears reporting the progress of your 
MEDIA Access Pro™ installation. When installation is complete you 
will see the Setup Complete window possibly informing you that you 
need to restart your computer before you can use the program. Select 
Yes and click on the Finish button.  

Proceed to Starting the Program later in this chapter. 

Installing Program Updates 
Periodically, BIAfn makes improvements to the MEDIA Access Pro™ program. 
When this occurs, you will be notified via e-mail or some other vehicle that an 
upgraded version of the program is available for download from BIAfn’s website. 
Instructions for installing the program update will be provided on the website. If the 
Internet is unavailable to you, contact your Client Services Department (607-936-
6737 or mahelp@bia.com) to request the upgrade be shipped to you on CD-ROM. 
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Installing Data Updates 
Because much of the power of MEDIA Access Pro™ is in the accuracy and 
timeliness of the data, BIAfn makes available daily data updates via Internet 
download. If you don’t have access to the Internet, updates can be made available to 
you on CD-ROM on a mutually agreed upon schedule (there may be a charge for this 
service). When you purchase MEDIA Access Pro™ for the first time, a dataset is 
included, however, because the program is mass produced on CD-ROM, it will most 
likely not be current and you will want to install a data update via the Internet. 

SPECIAL FEATURE: BIAfn is constantly tracking radio, television and newspaper 
trading, personnel changes, etc. and continually makes changes to its database. Every 
weeknight we perform an overnight updating process to our master MEDIA Access 
Pro™ data. What this means to you is that any changes BIAfn makes today will be 
available to you the next business morning. 

If you should have any problems or questions regarding the updating process, please 
call BIAfn’s Client Services Department at 607-936-6737 or send us an e-mail at 
mahelp@bia.com. 

Before receiving your first Internet update, you must have a valid Username and 
Password registered with BIAfn. If not pre-arranged or supplied by BIAfn with your 
documentation, contact your MEDIA Access Pro™ Client Services Department 
(607-936-6737 or mahelp@bia.com) to get set up. 

There are two ways to update your data via the Internet — automated (also referred 
to as “scheduled”) or manually.  

Automated Internet Data Updates 
BIAfn’s MEDIA Access Pro™ provides a built-in feature that enables you to 
schedule (between now and 12 hours from now) an automatic download of updated 
data. 

How it Works 
At the scheduled time, MEDIA Access Pro™ automatically launches your default 
Web browser and goes to BIAfn’s FTP site. Once there it inserts your Username and 
Password and proceeds with the download. The data is captured in a .exe file named 
update.exe and is stored under the BIADATA\MASTER\DATA\UPDATE 
subdirectory overwriting any previous update files. The MEDIA Access Pro™ 
program then closes down and, if Backup First is checked, Data Update will start by 
backing up your old data files to a directory named Backup under the 
BIADATA\MASTER\DATA directory where your MEDIA Access Pro™ program 
resides. It then runs the .exe file installing your new data. When you next open 
MEDIA Access Pro™ your data will be updated to the date reflected on the Title 
Screen. 

How Long Does it Take? 
On average your data updates can take anywhere between 5 minutes and several 
hours. The length of time required to download a MEDIA Access Pro™ data update 
is dependent upon: 

• The file size of the version of MEDIA Access Pro™ you are updating 
(Contacts is quicker than Analyzer; Radio is slower than Television). 
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• The speed of your Internet connection (a T1 line will be faster than a 
DSL or Cable modem which will be faster than a dial-up connection). 

Requirements 
The following requirements must be met to successfully complete a scheduled 
update:  

• Valid License Agreement for MEDIA Access Pro™ allowing for 
updated data. 

• Valid Username and Password registered with BIAfn (contact your 
Client Services Department at mahelp@bia.com or 607-936-6737). 

• Internet access. 

• Your default browser or Internet access must have any Disconnect 
features disabled (e.g., Microsoft Internet Explorer 5: Tools > Internet 
Options > Connections > Settings > Advanced > deselect any 
Disconnect features). For any problems with your Internet connection 
timing out, call your Internet Service Provider. 

• In the case of a network installation, all users of MEDIA Access Pro™ 
must be out of the program for an update to be successful. 

To schedule a data update: 
1. Open MEDIA Access Pro™ 

2. Click on File > Data Update to open the Update Data screen. 

 
3. Enter your registered Username 

4. Enter your registered Password 

IMPORTANT NOTE: Because MEDIA Access Pro™ has undergone 
several upgrades over the recent years, it is important that you confirm 
you are applying the correct Username and Password for the Version 
(4.0, 3.1 or 3.0) you are updating. If the wrong Version data file is 
downloaded for the Version you are operating, you will experience 
error messages and the program will not function properly. If you 
experience any problems, contact your Client Services Department at 
mahelp@bia.com or 607-936-6737.  
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5. Click on the down arrow to select when you want to perform your 
download (any time between now and 12 hours from now in 1-hour 
increments) 

6. As a safety measure in the off-chance there is a problem with the new 
data download, check Backup First to retain a copy of your old data. 

7. Under “Update Options” select whether you want to update your 
Station Data and/or Coverage Map data. The date to the right of each 
selection indicates the last time you downloaded a data update for each 
type of data.  

8. Click on the Proceed button to activate the countdown clock or start 
the downloading process.  

NOTE: For a successful download, you must…  

• leave the Update Data screen open (you can minimize both it and 
MEDIA Access Pro™ and work in other programs on your 
computer during this process); and  

• when installing a data update on a network, make certain all other 
users have closed MEDIA Access Pro™ on their workstations. 

Manual Internet Updates 
If for some reason the automated updating process does not work for you, there is a 
manual process via BIAfn’s website. This method does involve several steps as 
outlined below.  

1. From your Internet browser, go to BIAfn’s home page: www.bia.com.  

2. Click on the MEDIA Access Pro Users button located on the left hand 
side of the page.  

 
3. This opens the Members Area of the BIAfn website. If there have been 

any important notices posted as it regards MEDIA Access Pro™, a 
pop-up window will appear. Read these messages. Click on the X in the 
upper right corner of the pop-up window to close it. 

4. On the Members Area screen, click on the Data Updates button  

. 

NOTE: the other offerings available in the Members Area.  

5. Select the Version of MEDIA Access Pro™ you wish to update by 
clicking on the appropriate icon for either Version 4.0 or Version 3.1. 

6. Click on OK or Yes for any security messages you may encounter. 
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7. The MEDIA Access Pro™ Registration screen will appear. Enter your 
User ID (Username) and Password in the spaces provided and click on 
the Next button. 

IMPORTANT NOTE: Because MEDIA Access Pro™ has undergone 
several upgrades over the recent years, it is important that you confirm 
you are applying the correct Username and Password for the Version 
(4.0, 3.1 or 3.0) you are updating. If the wrong Version data file is 
downloaded for the Version you are operating, you will experience 
error messages and the program will not function properly. If you 
experience any problems, contact your Client Services Department at 
mahelp@bia.com or 607-936-6737.  

8. Click on OK or Yes for any security messages you may encounter. 

9. In the “Ready to Download” screen, select one of the appropriate 
datasets you wish to update and answer OK or Yes to any Security 
messages.  

NOTE: Depending on the combination of industries and features to 
which you subscribe, you will see a selection of one or more datasets 
that you can update (e.g., Radio Analyzer Update File, Radio Ratings 
Update File, Television Analyzer Update File, Multiple Industry 
Update File, etc.). With this feature you have the flexibility of updating 
one or more sets of data as is necessary.  

NOTE: If you are a subscriber to Coverage Maps, a data update for 
maps are also available on this screen. Just scroll down on the screen 
and click on the message [Click here to update your COVERAGE 
MAPS]. The Coverage Maps EXE download file will need to be 
downloaded into the BIADATA folder on your Server or Local Hard 
Drive, depending on the location upon installation.  Then continue with 
step 13. 

10. A File Download screen will appear asking, “What would you like to 
do with this file?”. Always select Save this program to disk and choose 
the appropriate directory in which to save your download. We 
recommend saving it to default directory suggested at installation 
located in C:\BIADATA\MASTER\DATA. If you changed the 
defaults to another drive for network purposes, locate and point to the 
DATA directory.  

11. File name: BIAfn automatically assigns a file name with a .EXE 
extension according to the dataset you are currently downloading. (As 
an example, if you are downloading a Radio Analyzer Update File, the 
file will be downloaded with the name RA.exe.)  

12. Click the Save button to download your updated self-extracting file. If 
requested, choose Yes when asked if you wish to replace the existing 
file.  

13. Your download is in process. Download time will vary depending on 
your Internet connection and modem speed. The file size and estimated 
download time will be shown before you begin.  

14. Once the download is complete, you can, if applicable, repeat steps 9 
though 13 for each dataset you desire to update.  

15. When all update files have been downloaded, you are ready to run the 
update. Exit MEDIA Access Pro™. It is also recommended that you 
close any other applications open on your computer.  
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16. Press the Windows Start button on your desktop.  

17. Choose Run.  

18. Either type the path and name of one of the files you just downloaded, 
OR use the Browse feature to find the .EXE file and Open it.  

19. Click OK to run the update.  

20. When you start running your update, a DOS Window will open with a 
warning that some of the files already exist and asks you if you want to 
overwrite the existing files in your data directory with a yes/no (y/n) 
option. Type the letter A (for “All”) on your keyboard so that all of 
your information will be updated with the most current data.  

21. Once the file is finished extracting (as shown by the word “Finished” in 
the upper left corner of the DOS screen), click on the X button in the 
upper right corner of your DOS window to close it.  

22. Repeat steps 17 through 22 for each updated dataset you downloaded. 

23. Open MEDIA Access Pro™. You will notice messages flashing in the 
upper right corner of the screen signifying that your data files are 
automatically updating. Once those messages stop appearing and the 
screen buttons appear at the top of the screen, your data has been 
refreshed. Check the update date on the Title Screen to confirm the 
download was a success.  

NOTE: The “Information as of” message on the lower left corner of 
the MEDIA Access Pro™ title screen should have the same date as that 
of your download 

CD-ROM Data Updates 
BIAfn strongly urges its MEDIA Access Pro™ users to employ the flexibility and 
timeliness of using the Internet to update their data. For those unable to use the 
Internet process, BIAfn provides updates shipped on CD-ROM based on a mutually 
agreed-upon schedule (NOTE: There may be a charge for this service). 

To ensure that you have the latest program upgrades, CD-ROM Data updates are 
provided through an entire new build of MEDIA Access Pro™. Follow the 
instructions under MEDIA Access Pro™ Installation. 

Starting the Program 
To begin working with MEDIA Access Pro™ after you have installed it, either 

• Click on Start > Programs > BIAfn’s MEDIA Access Pro 

• Or double click on the BIAfn’s MEDIA Access Pro™ icon    on 
the Windows desktop. 

The program will load and you will see the MEDIA Access Pro™ title screen as 
shown below.  
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• Active Links: Having a problem? Click on E-mail: mahelp@bia.com 

on this screen to open an actively linked e-mail message addressed to 
BIAfn’s Customer Support Department. Click on www.bia.com on this 
screen to go directly to BIAfn’s Web site to find answers to frequently 
asked questions or check the Member Area for new information 
regarding data or product updates. 

• Change Version: Click on the appropriate radio button on the screen or 
button on the toolbar to switch between the Radio, Television, and 
Newspaper databases of MEDIA Access Pro™. The databases for 
which you are not licensed will be grayed-out. 

• Contact Info: Information for contacting BIAfn for technical, sales or 
customer support. 

• Last Update Date: Indicates the date of your most recent data update 
from BIAfn. 

• Menu Bar: The menu from which to select the program and data 
actions and options. 

• Multi-Media: Click the button either on the screen or in the toolbar to 
view data integrated across the media databases for which you are 
licensed. 

• Screen Buttons: Provides quick access to the various MEDIA Access 
Pro™ screens and for exiting the program. 

o Quick Search: Opens the screen that provides an expeditious 
filtering of data based on basic field searches. 

o New Search: Opens the screen that allows you to design and 
execute more complex searches. 

o Saved Searches: Displays the window that houses the BIAfn-
supplied system searches and your own custom saved searches. 

o Station (or Paper) Information: Opens the screens that provide 
the results and details of your searches. 

o Quit: Click this button to close MEDIA Access Pro™. 
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• Status Bar: Displays the title of the activated database in which you 
are working. It also provides you with a count of the number of records 
returned out of the total number of records possible in your search 
results that are available to browse on the Station Info screen. 
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3: Database Basics 

This chapter provides you with a quick overview of database basics. If you are 
already familiar with how databases are structured, move on to next section, Getting 
Started. 

What is a Database? 
 database is an electronic collection of data consisting of records and fields. A record 
consists of several different pieces of information that relate to one station or 
newspaper. A field is one of the components of each of those records. For example, 
each radio station is a record. Each bit of information about that radio station (Call 
Letters, Tower Height, General Manager’s name, etc.) is a field. 

There are more than 13,000 records in the radio database alone and each record 
contains nearly 1,000 fields of data pertaining to that radio station. Each field holds 
different information for every station. If you are familiar with spreadsheets (Lotus, 
Excel, etc.), think of each record as a row on the spreadsheet and each field as a 
column on the spreadsheet. See sample below. 

 

Types of Fields 
All fields have a data type, which is dictated by the type of information it stores. 
Most of the fields in MEDIA Access Pro™ contain characters, but some contain 
numbers and others contain logical expressions (True or False). To conserve space, 
fields requiring unlimited space capacity are created as Memo fields such as Notes 
fields. For everything to work properly, you must know what data type is appropriate 
for each field and use it accordingly. There is a help box, at the bottom of the screen 
where you enter this information that tells you what kind of data that field is 
expecting. 
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Character Fields (Text) 
Character fields can contain any character (A-Z), including numbers (like the address 
“1234 Main Street”).  

Number Fields 
Number fields can contain ONLY numbers, like the Tower Height (HAAT) field, 
which might contain 1000. Number fields do not contain any punctuation, just the 
numbers. Therefore, in the HAAT example above, you would type in 1000, not 
1,000’. Later in the processing, this punctuation formatting is put in automatically by 
the program. 

Logical Fields 
Logical fields contain just a “T” for True or an “F” for False. 

Memo Fields 
Memo fields are used for fields that require unlimited space capacity such as Notes 
fields (e.g., Local Comments, Network Comments, Deal Terms, etc.).  A memo field 
only takes up as much space on your hard disk as there is content in the field, thereby 
saving valuable disk storage capacity. These field types have only one option for 
searching -- “Contains the text.”   

NOTE: Not all export formats accept memo fields. See section on Exporting for 
more information. 

Commands or Filters 
MEDIA Access Pro™ gives you access to data without requiring you to understand 
database commands. You can type in simple search commands like “Format equals 
Jazz” and MEDIA Access Pro™ will sort through all of the records to find just the 
ones that match your criteria. 

The real power is in combining several commands together to limit the results to just 
the information you care about. For example, if you tell MEDIA Access Pro™ that 
all you want to see are stations that meet the following criteria, the program will find 
just those stations and present them to you. 

The following statement might describe a typical search: 

• Format equals Talk AND 

• State of License equals NY AND 

• Share 2000 Fall is greater than 2.5 AND 

• Revenue-Station 2000 is less than 3000 ($3 Million) AND 

• Owner does not equal ABC 

Some searches may not find any stations. This can be just as useful in making a 
decision as a search that finds many matching stations. 

NOTE: Because BIAfn’s estimated Station Revenues are stored in the database in 
thousands (000), in the above example of revenue less than $3 million, revenue is 
expressed as 3000. See the HELP information for each field at the bottom of the 
Selection Criteria Screen. 

The above criteria can easily be selected in MEDIA Access Pro™ without learning 
any database commands. In fact, you can issue even more lengthy and/or 
complicated searches. In most cases, the number of conditions in your search is 
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unlimited. The exact number depends on exactly which fields with which you are 
working. Some fields take up more room than others. 

The above example illustrates a simple search that links several “AND” conditions 
together. You can also use “OR” commands as in “Format equals Jazz OR Talk.” 
Just tell MEDIA Access Pro™ how you want the results presented and what 
information you care to see and that is exactly what you will get. 

Results (Output) 
After you have found what you are looking for, you can view the results on your 
screen, print reports or mailing labels, or export the data for use with another 
software package like Microsoft Word™, WordPerfect™, Lotus 1-2-3™, Microsoft 
Excel™, or any other program which accepts an ASCII or .DBF file. You also have 
the option of saving the search criteria to use again. 

Sorts or Indexes 
With the results we get using the above command or filter, we may want to see it 
sorted in a specific way. This is called sorting or indexing in database language. 
Perhaps we want to see the results of our search sorted first by the station’s numeric 
Arbitron Market Rank and then in descending order by the highest revenue 
generating stations. This sort is easy to accomplish using BIAfn’s MEDIA Access 
Pro™. There is a tab on the Selection Criteria screen that walks you easily through 
this process. See New Search section for greater detail on sorting. 

Categories of Fields 
MEDIA Access Pro™ contains one record for every commercial radio and television 
station or daily newspaper in the United States. Each record contains fields for most 
of the information you would like to know about each of these stations or 
newspapers including: 

Contacts  

• Call Letters or Newspaper Names 

• Station or Newspaper Personnel 

• Phone and Fax Numbers  

• E-mail and Web Site 

• Market Name and Rank 

• Technical Data 

• Format, Affiliation or Publication Frequency 

• Ownership Information 

Analyzer  

• All the information in Contacts, plus: 

• Station Ratings or Newspaper Circulation 

• Estimated Station or Newspaper Revenues 
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• Estimated Market Revenues 

• Market Growth Statistics 

• Demographic Data 

• Historical Transaction Data 

• Group Owners Tallies 

• and much, much more... 

Refer to Field Names under the Help menu in MEDIA Access Pro™  for a complete 
listing of available fields. 
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4: Getting Started 

Overview 
BIAfn's MEDIA Access Pro™ is an easy-to-use, powerful interface to the BIAfn 
databases profiling more than 13,000 radio, 10,000 television stations, and 1,400 
newspapers, their owners and markets. With between 600 and 1,000 fields of data for 
every entity, it has been designed to help you find exactly the information you want, 
to print reports and labels, or export files that can be used with other programs. 

Below is a quick and easy overview to help you get started using the program. 
MEDIA Access Pro™ was designed to be as easy or as comprehensive as you need. 
For more detailed information, browse through the online Help, consult the User's 
Manual provided on the CD-ROM with your MEDIA Access Pro™ program, or call 
(607-936-6737) or e-mail your customer support executive (mahelp@bia.com) for 
personalized assistance. 

For information on opening MEDIA Access Pro™, see Starting the Program under 
Installation. 

Quick Search 
The easiest way to get started with your first search is to use the Quick Search 
feature of MEDIA Access Pro™. With a couple of clicks of your mouse you can find 
a station or newspaper by its call letters or name, the entities operated by precisely 
the owner you're looking for, a list of the stations and/or newspapers in a specific 
market, or from any one of the other available fields you choose. It's an easy 3-step 
process.  
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1. Press the Quick Search screen button and Select either Calls or 

Newspaper; Owner; Market or City, ST; or select a custom search field 
(e.g., Format) by clicking on its adjacent radio button. 

2. To find the specific data you are looking for either… 

• Type in the CALL letters (newspaper name), owner, market name 
(city, ST) or applicable data for the custom search field (e.g., Jazz) 
you want to search for in the gray box; or  

• Click on the Display Pick List button to obtain a list of all the 
unique possibilities for the selected field on which to perform your 
search. 

3. Click the Search button to display your search results. 

Sub-Sort - To further refine your results from the Quick Search screen, you 
can apply a Sub-Sort to your data to apply a secondary sort by: 

• CALLS or Newspaper Name 

• Owner 

• Parent Company (Radio and TV) 

• Market Name (Radio and TV) 

• City, ST (Newspaper) 

Search Only - When checked the Search Only box is checked the selection 
box for customizing the types of Radio and/or Television stations you wish 
to see is visible. See Search Only for more information. 

For a more detailed search with multiple criteria, you'll want to check out the New 
Search features. 

Viewing Results 
Once you've clicked the Search button a "Running Query..." box will appear with an 
indicator showing the progress of the search. When it reaches 100% you'll receive 
your results in a spreadsheet type view on the Results Tab of the Station Information 
Screen. The Results Tab displays approximately 40 of the most popular fields for 
each station (newspaper). Move across the screen using the scroll bar at the bottom 
to see format, technical, market, and other data on the stations (newspapers) your 
search selected. 
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Double-click on a field of data in any station (newspaper) record (the background of 
the record turns yellow) to display detailed data for contacting that station 
(newspaper). Depending on the version (Contacts or Analyzer) and the features 
(Ratings or Coverage Maps) that you are licensed to use, you will see a number of 
other tabs of information for each station. Click on the Owners Tab to view the 
entity's owner information. In addition to the Contacts and Owners Tabs, with the 
Analyzer version is included the Station or Newspaper, Transactions, Market #1, 
Market #2, Market #3 (TV only) and Web Site tabs. Add-on modules have the 
Ratings or Rankers (Radio only) and Maps Tabs. 

Notice also in the title bar at the top as well as in the bottom left hand corner of the 
MEDIA Access Pro™ screen that it displays the number of records that met your 
criteria out of the total number of records in the database. 

Printing Reports 
At this point you can print any number of custom reports based on the results of your 
search.  For more information, see Printer Setup. 

1. Click on Print from the menu bar at the top of MEDIA Access Pro™. 

2. Click on Custom Reports. Depending on the version and features you 
are licensed to use, you will see a list of 10 to 25 built-in reports from 
which to choose.  

 
3. Click on the Contacts Report in the list. 

4. Click on the Preview button for a view of what the report will look like 
when it’s printed. 
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5. Click on the radio button next to General Manager. 

6. To print the report press on the print button    in the Print Preview 
Toolbar. The report will print to the printer you have designated as your 
default printer in your Windows setup. 

For more information, see sections on Printing and Custom Reports. 

Printing Labels 
Printing mailing labels is just as easy. 

1. Select Print from the menu bar at the top of MEDIA Access Pro™.  

2. Click on Mailing Labels. You'll receive the Label Options Screen. 
Click on the type of labels on which you want to print (BIAfn has built 
in six of the more popular Avery brand label formats for you).  

 
 

3. Click the radio button next to either Station (Newspaper), Owner, or 
Parent.  

4. Click on the down arrow in the Contact Type list box, and click on the 
job classification of the person you want to reach.  

5. Click on Preview to see how the labels will look.  
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6. Make sure your printer has the correct label stock loaded, and click on 

the print button   in the Print Preview Toolbar. 

NOTE: MEDIA Access Pro™ gets rid of the duplicates for you and only prints one 
mailing label per contact name at the same address.  

Exporting Data 
It's just as easy to export the data you've requested in your search to nearly any type 
of popular software or database available on the market.  

1. Click on Export in the menu bar at the top of MEDIA Access Pro™. 

 

 
 

2. Click on Microsoft Excel. You will receive a Save As dialog box.  

3. Click on the folder to which you would like to save this file, give it a 
name, and press the Save button. 

4. MEDIA Access Pro™ then gives you the option of previewing or 
printing out a Field List Report which provides brief definitions to the 
abbreviated field names that the program will export with your data. 
Click on the No Report button to continue.  

5. To see the results of your export, open Microsoft Excel and the file that 
you created. 

It's just that easy! 
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5: Information Screens 

This chapter reviews the information found on the tabs of the Information screens. 

Information Screens Overview 
This is the screen that allows you to view the results of your search in a browse view 
(Results) or through several full screen view categories of information for an 
individual station or newspaper. The full screen view tabs available to you are 
dependent on the features for which you are licensed. In this User Manual, if a tab is 
available only through specific databases, an indication is made in the text next to the 
tab title. 

The Information Screens can be accessed by clicking on the Station Info or Paper 
Info buttons. 

Results Tab 

 
The Results Tab appears either after a completed search or when you click on the 
Station Info or Paper Info buttons. It is a scrolling list of all the records (stations or 
newspapers) returned in your search (or the entire database if you have not yet 
executed a search). 
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After executing a search, the results will be displayed in the Results Tab. This screen 
looks very much like a spreadsheet display. Each new record will be in a row and 
each field in a separate column.  

Adjusting Column Size 
You can shrink (to see more fields on one screen) or widen the width of any column 
by positioning the cursor at the intersection of two columns in the name area. Your 

cursor will become a double-headed arrow  . Click and drag (click the left 
mouse button and hold it while you move the mouse) to the left to shrink and to the 
right to widen. 

Resorting Results 
The Results screen provides you with the functionality to resort the selected records 
by any of the output fields available. Just right click on a field name (CALLS, 
Owner...) and the records will be reordered in ascending order (A-Z). In ascending 
order the field name title will appear in bold type. 

 
Right click on it again and the order changes to descending order (Z-A). In 
descending order the field name will be bold and underlined.  

 
NOTE: The field that you select for resorting will automatically move to the 
position of the first cell in the table shifting the other fields to the right.  

You will need to establish  secondary and tertiary sorts through the Sort Tab of the 
New Search. 

Reordering Columns 
You can rearrange the order of the displayed fields by positioning, left clicking and 
holding the cursor on the name of any field until it is highlighted black with reverse 
type and dragging the field to the left or right.  

 
This is useful to drag a field in which you are interested in seeing next to another 
field. This makes it easy to scroll down a list of fields and see the information you 
care about on the same screen. 

NOTE:  While dragging field names is useful for browsing important information 
quickly, any changes you make in the field order this way will not be saved. To 
change the order in a way that you can use in the future, add the fields you want to 
see in the order you want to see them in the Output Fields tab of the New Search 
screen. For more information see the section on Output Fields. 
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Split Screen View 
Another way to get fields next to each other on the browse screen is to split the 
browse window. You can split the screen into two vertical windows. This is helpful 
to freeze information on the left like CALL letters, while you scroll information on 
the right that pertains to the stations. 

 
To split the screen, move your mouse to the small solid black vertical box in the 
lower left corner of the screen. When you are in the right position, the cursor changes 
to a split double arrow .  When this symbol appears, drag to the right. You will 
see the screen split into two windows, which you can now scroll separately. To 
return the screen to normal, click on the small solid black vertical box again to 
reactivate the split screen tool and drag it back to the left. 

Comments (Memo) Fields 
In the Results Screen, if your Output Fields includes any of the comments fields, 
deal terms, or other notes fields, when the comments field is empty, you will see the 
word “memo” with a lower case “m.” You will see the word Memo with a capital 
“M” if there is a comment contained in the field.  

 
If you double click on the word Memo, a box will open to show you the contents of 
that field.  
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This is necessary because comments are unlimited in length. It would not be possible 
to provide a box big enough to show the full contents of an unknown and unlimited 
length field. 

Full Screen View Tabs 
Because there is so much information on each station, it is impossible to see it all at 
once using the Results Screen view. To see all of the information on a particular 
station, first select that station or newspaper by either double-clicking anywhere in 
that record (row) and you will open the Contacts Tab for that record.  

To go directly to a full screen view other than Contacts (i.e., Owners, Market #1, 
etc.) from the Results Tab, click anywhere in the desired record (row) so that the row 
is highlighted in yellow, then click on one of the other tabs in the Station or Paper 
Information screen (Contacts, Owners, etc.).  

Navigation Buttons 
In the full screen views, you can scroll through the records in your results screen to 
compare more detailed information about each station or newspaper. On your 
keyboard, press Page Down to look at the next record, Page Up to look at the 
previous record or use the up and down navigational arrow buttons on each screen.  

 

Print Screen Button 
There is also a print button on each screen that prints all of the data on that screen to 
your printer. 

 

Closing the Screen 
To return to the Selection Set screen, either press Esc (Escape) on your keyboard or 

click on the close symbol   in the upper right corner of the screen. 
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Contacts Tab 
The Contacts Tab contains the information necessary to contact a particular station 
or newspaper and identify its key personnel. It also reflects the pertinent technical 
data about the station or newspaper and its facility, its market and geographic 
location, and format (Radio), affiliation (TV) or frequency (Newspaper). It is on this 
screen that you have customizable fields that give you the ability to type in your own 
notes about the station or newspaper, set custom and search flags, and track contact 
dates much like in a contact management software. In addition, you can maintain the 
names and titles of personnel contacts at the station or newspaper not supported by 
BIAfn’s data gathering. 

Radio Contacts Tab 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station Identifiers - This area provides identifying information for the 
station selected including present and most previous Call Letters, the 
specific format, the general format category to which BIAfn assigns 
their format, and whether or not the station operates as a commercial 
operation.  

2. Technical Data - Important technical facilities information on this 
station such as frequency, FCC Class, Power, antenna height (HAAT), 
latitude and longitude, etc. 

3. Owner Name - The popular name of the licensed Owner of this station.  

NOTE: When the words “Pending” appear in red text on the screen 
next to the owner name field, the owner indicated is the proposed 
owner pending the closing of a transaction to purchase the station or 
newspaper. 

 
4. Station Contact Information - Station’s mailing and physical address, 

phone, fax, e-mail, and Web site. 
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5. Station Personnel - A list of the contacts for the key positions at the 
station. 

6. Market Identifiers - Fields such as official City and State of License, 
Arbitron designated home radio market name and rank (if located in a 
rated market which will also be indicated by a “T” for True in the 
Metro field), and the Television DMA® and region of the country in 
which the Radio station is located. 

7. Custom Contacts - While BIAfn tracks the key professionals for both 
stations and owners, to accommodate your special needs, BIAfn 
provides a Custom Contact utility wherein you can track up to two 
other contacts important to you at each level. For more information see 
Customizable Features. 

8. Station Slogan - The popular slogan of the Radio station as reported to 
Arbitron Inc. 

9. Customizable Fields - The Contacts Tab provides an area that can be 
used as a Contact Manager. You can enter notes for the station on your 
network or local hard drive, input dates for your last call and call back, 
and custom flag the records. For more detailed information and hints 
for using these features see Customizable Features in the on-line Help 
or User Manual. 

10. Market Selector -  If there is more than one market name indicated, 
this scroll box indicates a station receives audience shares in more than 
one Arbitron Radio market. The “home” market to which the station is 
assigned appears first followed alphabetically by the other markets.   

11. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

12. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer. 

13. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 
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Television Contacts Tab 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station Identifiers - This area provides identifying information for the 
station selected including present and most previous Call Letters, the 
station’s network affiliation, and the type of  service (i.e., main, 
satellite, public) provided by the Television facility. 

2. Technical Data - Important technical facilities information 
interchangeable by clicking on the button for the analog and digital 
signals of this station such as channel, Power, antenna height (HAAT), 
latitude and longitude, etc. 

3. Station Contact Information - Station’s mailing and physical address, 
phone, fax, e-mail, and Web site. 

4. Station Personnel - A list of the contacts for the key positions at the 
station. 

5. Market Identifiers - Fields such as official City and State of License, 
Nielsen Television DMA® name and rank, and region of the country in 
which the Television station is located. 

6. Translator Stations - If not grayed out, clicking this button will open a 
screen that lists, along with the technical attributes of each, the subject 
station’s translator facilities that transmit the subject station’s signal. 
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7. Custom Contacts - While BIAfn tracks the key professionals for both 
stations and owners, to accommodate your special needs, BIAfn 
provides a Custom Contact utility wherein you can track up to two 
other contacts important to you at each level. For more information see 
Customizable Features. 

8. Owner Name - The popular name of the licensed Owner of this station.  

NOTE: When the words “Pending” appear in red text on the screen 
next to the owner name field, the owner indicated is the proposed 
owner pending the closing of a transaction to purchase the station or 
newspaper. 

 
9. Customizable Fields - The Contacts Tab provides an area that can be 

used as a Contact Manager. You can enter notes for the station on your 
network or local hard drive, input dates for your last call and call back, 
and custom flag the records. For more detailed information and hints 
for using these features see Customizable Features in the on-line Help 
or User Manual. 

10. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer. 

11. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

12. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

Newspaper Contacts Tab 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  
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1. Newspaper Identifiers - This area provides identifying information for 
the newspaper selected including the name of the publication and the 
City and State from which it is published. 

2. Owner Name - The popular name of Owner of this newspaper.  

NOTE: When the words “Pending” appear in red text on the screen 
next to the owner name field, the owner indicated is the proposed 
owner pending the closing of a transaction to purchase the station or 
newspaper. 

 
3. Newspaper Contact Information - Newspaper’s mailing and physical 

address, phone, fax, e-mail, and Web site. 

4. Newspaper Personnel - A list of the contacts for the key positions at 
the newspaper. 

5. Frequency - Designates the frequency (D=Daily, W=Weekly, etc.) and 
the number of days per week the newspaper is published 

6. Custom Contacts - While BIAfn tracks the key professionals for both 
newspapers and owners, to accommodate your special needs, BIAfn 
provides a Custom Contact utility wherein you can track up to two 
other contacts important to you at each level. For more information see 
Customizable Features 

7. Customizable Fields - The Contacts Tab provides an area that can be 
used as a Contact Manager. You can enter notes for the newspaper on 
your network or local hard drive, input dates for your last call and call 
back, and custom flag the records. For more detailed information and 
hints for using these features see Customizable Features in the on-line 
Help or User Manual. 

8. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer. 

9. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the newspapers available on the Results 
Tab. 

10. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 
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Owners Tab 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station or Newspaper Identifiers - This area provides identifying 
information for the station or newspaper selected. It can include: 

• Name of the newspaper or call letters for the radio or television 
station 

• Affiliation of the television station or format of the radio station 

• Market name and rank of the radio or television station or the city 
and state where the newspaper is published. 

2. Owner or Parent - Select to view the address and contact information 
for either the Owner or the Parent Holding Company (if any) by 
clicking on the appropriate radio button. 

NOTE: When the words “Pending Sale to” appear in red text on the 
screen next to the owner name field, the owner indicated is the 
proposed owner pending the closing of a transaction to purchase the 
station or newspaper. 

3. Owner or Parent Headquarters - Shows the mailing and physical 
addresses, phone, fax, Web site, e-mail, and stock symbol for the 
selected owner or Parent Holding Company (if any). Group is flagged 
“T” when more than two newspapers are owned or more than two 
stations are owned in more than one market. 

4. Owner or Parent Contacts - Lists the mailing and physical address, 
phone, fax, and e-mail for the contact selected in the drop down 
Position box. To view the name and address information for each of the 
executive positions with the Owner or Parent, click on the down arrow 
to the right of Position under Contacts and click on the position you 
would like to view. For more information on inputting and retaining 
your own customized contacts for an Owner or Parent, see the section 
on Customizable Features. 



 

MEDIA Access Pro™ Version 4.0 User Manual 5: Information Screens  •  55 

 
5. Stock Symbol - If the owner or parent is a publicly-traded company, 

the appropriate stock symbol will appear in the stock symbol box. 

6. Multi-media Flags - When marked “T” for True, these fields indicate 
that this owner also owns entities in the other medias. 

7. Also Owns - Click this button to view a pop-up window with a list of 
all the stations or newspapers owned by the Owner or owned/operated 
by the Parent company. 

 
8. Owner or Parent Stats - Summarizes the present number of stations or 

newspapers owned, in the number of markets, with total estimated 
revenues in thousands (if available), and the owner’s (parent’s) rank 
based on BIAfn estimated revenues (if applicable). The previous owner 
is also listed if available.  

NOTE: this section only available in the Analyzer databases. 

9. Show Contacts Button- Clicking this button will pop-up a window 
displaying the list of contacts available for the Owner or Parent. You 
can add custom contacts in this window and print this screen. 
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10. Print Screen Button - This button allows you to print a replicated 

copy of the information found on this screen to your Windows default 
printer.  

11. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the owners of stations or newspapers 
available on the Results Tab. 

12. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

Station and Newspaper Tabs (Analyzer Only) 
The Station and Newspaper Tabs are found only with the Analyzer databases of 
MEDIA Access Pro™.  This tab highlights performance, financial, technical, and 
market information applicable to the station or newspaper.  

Radio Station Tab (Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  
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1. Station Identifiers - This area provides identifying information for the 
station selected including present and most previous Call Letters, and 
the specific format. 

2. Arbitron 12+ Shares - For the last 16 ratings periods, 12+ share by 
period and the format aired by that station.  

3. Estimated Station Advertising Revenues - Presented in thousands of 
dollars (7,400 = $7,400,000), BIAfn’s proprietary estimate of 
advertising revenues earned by an Arbitron-rated station for the past 
eight years.  

4. Technical Information - Important technical facilities information on 
this station such as frequency, FCC Class, Power, and antenna height 
(HAAT). 

5. Market Identifiers - Fields such as Home Market and Market 
Designation Date as designated by Arbitron, Inc., official FCC county 
and city of license, and the Nielsen DMA® market name and rank. 

6. Density Code - Indicates population density of the county of license 
(A=highest to D=lowest). 

7. Network - Abbreviated code for the name of the affiliated radio 
network (could be more than one) of the station. Click on 
Abbreviations under the Help menu for a key to these codes. 

8. Station Affiliations - A list of the stations affiliated with the subject 
station that are part of a Local Marketing Agreement (LMA) or 
operated by a common ownership interest as represented under Combo. 
If marked “T” for True, the Duopoly field indicates that this station is 
one of two more stations of the same transmission cycle (AM or FM) 
owned in the same market by the same owner. 

9. Performance Ratios - Ratios such as Revenue Share (share of  revenue 
per Arbitron 12+ share), Local Commercial Share (average 12-month 
Arbitron 12+ share adjusted for lost listening to out-of-market and non-
commercial stations), and Power Ratio (estimated revenue share per 
Local Commercial Share). 

NOTE: Power ratios are only calculated for stations with a LCS greater 
than 0.9%. 

10. # of Books and Viability - The number of ratings periods per year that 
this station is rated by Arbitron, Inc. (2 = Spring and Fall). Viable is 
marked “T” for True when a station is considered a viable entity in the 
market. 

11. Latitude and Longitude - Station’s geographic location. 

12. Distance Indicator - Indicates the distance of the featured station from 
the last station specified in a distance search. For more information, see 
Built-in Searches under the section on Saved Searches.  

13. Coverage Area Population - Estimated population reached by the 
station’s contour coverage. 

14. Market Selector -  If there is more than one market name indicated, 
this scroll box indicates a station receives audience shares in more than 
one Arbitron Radio market. The “home” market to which the station is 
assigned appears first followed alphabetically by the other markets.  
When you click on a different market name, the data in the applicable 
market fields will change to reflect those of the highlighted market. 
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15. Metro Cume - The total number of different persons who tune to a 
radio station during the course of a daypart for at least five minutes. 

16. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer. 

17. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

18. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

Television Station Tab (Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station Identifiers - This area provides identifying information for the 
station selected including Call Letters, network affiliation, television 
DMA® market rank and name, type of facility, and channel. 

2. Station Ratings - Total day Nielsen ratings shares received by a station 
for the previous 16 ratings periods and daypart shares by time slot for 
the last 8 ratings periods. 

3. Performance Ratios - Average  Local Commercial (LC) Share 
(average 12-month Nielsen total day share adjusted for lost listening 
viewing to out-of-market, cable channels and non-commercial stations), 
and Power Ratio (estimated revenue share per Local Commercial 
Share). 

4. Estimated Station Advertising Revenues - Presented in thousands of 
dollars (8,800 = $8,800,000), BIAfn’s proprietary estimate of 
advertising revenues earned by the television station for the past eight 
years.  

5. On Air and Acquired Dates - The year the station first went on the air 
and the year and month the present owner acquired the station. 
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6. CP - If flagged “T” for True, this field indicates that the station has 
applied for a construction permit to change channel, power, or its 
antenna height to upgrade its technical facilities. The station is also 
authorized to operate at the indicated power or height for testing 
purposes. 

7. County Name - Indicates the official FCC county of license in which 
the station is located. 

8. Density Code - Indicates population density of the county of license 
(A=highest to D=lowest). 

9. Technical Information - Important technical facilities information on 
this station such as frequency, FCC Class, Power, and antenna height 
(HAAT). 

10. Coverage Area Population - Estimated population reached by the 
station’s contour coverage. 

11. LMA or JSA - A list of the stations affiliated with the subject station 
that are jointly operated as part of a Local Marketing Agreement 
(LMA) or a Joint Sales Agreement (JSA). 

12. Previous Calls - The most recent call letters previously assigned to this 
station. 

13. Previous Affiliation and Date - The most recent previous network 
affiliation and the date by month/year that the station switched 
affiliation. 

14. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer. 

15. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

16. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 
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Newspaper Tab (Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Newspaper Identifiers - This area provides identifying information 
including the newspaper’s name and the city and state from which it is 
published. 

2. Estimated Circulation - If flagged with an asterisk (*), data is 
reprinted by permission and obtained from Copyrighted materials of the 
Audit Bureau of Circulations providing estimated historic daily and 
Sunday circulation and the date, by month and year, of the audit. When 
not flagged with an asterisk (*) data, such as current circulation, is 
estimated by BIAfn. 

3. Estimated Advertising, Circulation and Total Revenues - Presented 
in thousands of dollars (5,200 = $5,200,000), BIAfn’s proprietary 
estimate of revenues for the prior year derived from advertising and 
circulation.  

NOTE: Total revenue estimates will also include revenues garnered 
from other sources besides advertising and circulation. 

4. Publication Frequency Indicators - Include the frequency code 
(D=Daily, W=Weekly, etc.), the number of days per week the paper is 
published and, if checked, the days of the week that the publication is 
circulated. 

5. Joint Operating Agreement - If information is included, the 
newspaper listed shares with or provides operating facilities to the 
selected newspaper. JOA Type indicates whether the owner of the 
newspaper whose record is selected is considered the P=Parent or 
C=Child of the agreement of the newspaper named in the field above. 
Percent JOA provides an estimate of the subject record’s share of 
revenue derived from the operations. 

6. Copyright Information - Provides copyright information concerning 
the source of circulation estimates. 
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7. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer. 

8. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

9. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

 

Transactions Tab (Analyzer Only) 

 
The Transactions Tab provides an overview of up to eight of the historic buying and 
selling activities associated with the station or newspaper. The example screen 
shown above is representative for all media industries.  

NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station or Newspaper Identifiers - This area provides identifying 
information for the station or newspaper record selected. Included is the 
city and state the newspaper is published or the home market rank and 
name in which the station is rated. For radio stations only -- if the 
station market information is blank, the station is not located in a rated 
market. 

2. Proposed Date - This is the date the station sale was first proposed. 
The closing date of the transaction may or may not be later. 

3. Buyer - The name of the intended purchaser of the station or 
newspaper in this transaction. 

4. Seller - The name of the intended seller of the station or newspaper in 
this transaction. 
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5. Price - If known, or not part of a group deal (more than one station or 
newspaper), the announced transaction price of this deal is presented in 
thousands (53,200 = $53,200,000). 

6. Code - An abbreviated code signifying the type of transaction involved 
in the sale. See Price Codes under Help in the main menu of MEDIA 
Access Pro™. 

7. Terms - If known, the terms of the deal, the broker and/or the attorney 
representing the seller/and/or the buyer are listed here. Double click in 
this area to expand the view to see the complete terms of a specific 
transaction. Right click or double click again to close it. 

 
8. No Deal - If a “T” for True appears in this column, the transaction was 

never consummated. 

9. Owner or Parent Stats - Lists the current owner and summarizes the 
present number of stations or newspapers owned, in the number of 
markets, with total estimated revenues of this owner’s specific industry 
holdings in thousands (if available). 

10. Pending - If checked, this field indicates that the current deal is 
pending the official closing. 

NOTE: If the Pending box is checked, the date entered in the “Closed 
Date” field represents the proposed date of the current transaction. 
Once the deal has been finalized, this date will be updated with the 
actual year/month of the closing. 

11. Parent / Licensee / Previous Owner - The company which is the 
controlling entity for the Owners of a group of stations or newspapers 
is referred to as the Parent. The Licensee field contains the name of the 
legal entity that holds the FCC license to the subject station. Previous 
Owner provides the popular name of the most recent seller of the 
station or newspaper. 

12. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer. 

13. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

14. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 
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Market #1 Tab (Analyzer Only) 

Radio Market #1 Tab (Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station and Market Identifiers - This area provides identifying 
information for the station and market selected. If the market 
information is blank, the station is not located in a rated market.  

2. Demographic Statistics - The market’s estimated historic and 
projected market Population (Pop), Households (HH), Retail Sales 
(RS), and Effective Buying Income (EBI) figures and growth rates. If 
blank, station does not receive ratings in a rated market. Data is 
licensed from Market Statistics. See Copyrights. 

3. Market Revenues - BIAfn’s proprietary, historic and projected 
estimated revenues for the market. If blank, the station is not located in 
a rated market. See Copyrights. 

4.  Local Commercial Share (LCS) - By historic ratings period, the 
adjustment for lost listening (radio) to non-commercial and out-of-
market stations. 

5. Market Financial Statistics - The market’s estimated per capita, 
median, and average household income for the market. If blank, station 
does not receive ratings in a rated market. Data is licensed from Market 
Statistics. See Copyrights. 

6. Technical Overview - Provides an overview of the technical 
operations in the market by station type and FCC Class. 

7. Market Revenue Growth Rates - Estimated compound average 
annual growth rate for market revenues for the historic and projected 
periods indicated. If blank, station is not located in a rated market. See 
Copyrights. 
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8. Market Ethnic Percentages - Percentage breakdown of the White, 
Black, Asian, and Hispanic Origin population in the market. If blank, 
station does not receive ratings in a rated market. Data is licensed from 
Market Statistics. See Copyrights. NOTE: Ethnic percentages do not 
total 100%. Hispanic Origin persons are also included in the other 
categories. 

9. Revenue Confidence Rating - BIAfn’s rating for its confidence in its 
revenue estimates for  this market. 

3 - Highest - Multiple reliable outside sources 

2 - Moderate - Limited outside sources 

1 - Cautious - Estimated with BIAfn’s resources 

10. Market Selector - This box indicates the one or more markets in which 
this station is rated. Clicking on a market name other than the one that 
is highlighted will change the market information to correspond to the 
new market. For example, clicking on the name Flint, MI will change 
the demographic info, revenue estimates and LCS from Lansing-East, 
MI to Flint, MI.  Note that the station’s revenue estimates are only 
included in the home market, and will not be included in the other 
market totals. 

11. Revenue Breakdown - An estimated percentage breakdown of the 
revenue derived from local and national sources. 

12. Other Stations in Market - Clicking this button will give you a pop-
up screen containing a quick overview of the other stations in the 
market organized by Owner name and call letters. Screen includes an 
Also Owns button indicated by a question mark that, when clicked, 
opens an Owner Also Owns window. For more information, see #7 
under the Owner Tab. 

 
13. Print Screen Button - This button allows you to print a replicated 

copy of the information found on this screen to your Windows default 
printer.  

14. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

15. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 
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Television Market #1 Tab (Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station and Market Identifiers - This area provides identifying 
information for the station and market selected.  

2.  Households Using Television (HUT) - Provided for the last eight (8) 
Nielsen ratings period and broken down by critical dayparts, HUT is a 
unit of measurement of viewing audience, defined as the percentage of 
the total number of sets turned on during an average quarter hour 
(AQH). 

3. Market Revenue Breakdown - Provides an estimated percentage 
breakdown of the source of advertising revenue for the stations in the 
market. 

4. Market Revenue Growth Rates - Estimated compound annual growth 
rate for market revenues for the historic and projected periods 
indicated. See Copyrights. 

5. Market Revenues - BIAfn’s proprietary, historic and projected 
estimated revenues for the market. See Copyrights. 

6. Allocation Notes - If any, this area notes the available channels not 
presently on-the-air which are allocated to the market. 

7. Cable%, ADS%, VCR% and TV HH- This area provides the 
estimated percentage of households with Cable service, using an 
Alternate Delivery Service (e.g. satellite), equipped with a Video 
Cassette Recorder, and the number of television households (TV HH) 
in the market.  

8. Market Financial Statistics - Estimated per capita and average 
household income for the market, as well as the percentage of 
television households (TV HH) in the market. Data is licensed from 
Market Statistics. See Copyrights. 

9. Market Notes - If any, special notes that affect the market will appear 
here. 
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10. Market Ethnic Percentages - Percentage breakdown of the White, 
Black, Asian, and Hispanic Origin population in the market. If blank, 
station does not receive ratings in a rated market. Data is licensed from 
Market Statistics. See Copyrights.  

NOTE: Ethnic percentages do not total 100%. Hispanic Origin persons 
are also included in the other categories. 

11. Other Stations in Market - Clicking this button will give you a pop-
up screen containing a quick overview of the other stations in the 
market organized by Owner name and call letters. Screen includes an 
Also Owns button indicated by a question mark that, when clicked, 
opens an Owner Also Owns window. For more information, see #7 
under the Owner Tab. 

 
12. Market Map Button - Clicking this button will generate a color map 

of the market. Press ESC to return to the Market #1 tab. Right click on 
the map to adjust the zoom, save the map to a file, or print the map. 

 
For best results in printing the Market Map, set the parameters as 
outlined and shown in the sample below. 
• Measurement Units = Pixels 
• Print = Whole Image(s) 
• Center = checked 
• Isometric = checked 
• Click Fit to Page button 
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13. Revenue Confidence Rating - BIAfn’s rating for its confidence in its 

revenue estimates for  this market. 

3 - Highest - Multiple reliable outside sources 

2 - Moderate - Limited outside sources 

1 - Cautious - Estimated with BIAfn resources 

14. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer.  

15. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

16. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 
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Newspaper Market #1 Tab (Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Paper and Market Identifiers - This area provides identifying 
information for the newspaper and the city and state where it is 
published.  

2. Market Indicator - Label that identifies the market level definition. 
Primary market is defined by the single county in which the newspaper 
is published. 

3. Demographic Statistics - The primary market’s estimated historic and 
projected market Population (Pop), Households (HH), Retail Sales 
(RS), and Effective Buying Income (EBI) figures based on the primary 
county listed in item #5. Data is licensed from Market Statistics. See 
Copyrights. 

4. Demographic Growth Rates - The estimated historic and projected 
rate of growth for the demographic statistics outlined in #3 above. Data 
is licensed from Market Statistics. See Copyrights. 

5. Primary County - Name of the primary county designated as the 
primary market along with its Federal Information Processing 
Standards (FIPS) county code. 

6. Market Financial Statistics - Estimated per capita, median and 
average household income for the primary market. Data is licensed 
from Market Statistics. See Copyrights. 

7. Market Demographic Breakdown - The breakdown of the primary 
market’s population by gender and age group. Data is licensed from 
Market Statistics. See Copyrights. 

8. Other Media Market Definitions - Provides the Arbitron Radio and 
Nielsen Television DMA® market name and rank in which the subject 
newspaper’s primary county is located. 

9. Market Ethnic Percentages - Percentage breakdown of the White, 
Black, Asian, and Hispanic Origin population in the market. Data is 
licensed from Market Statistics. See Copyrights.  
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NOTE: Ethnic percentages do not total 100%. Hispanic Origin persons 
are also included in the other categories. 

10. Other Papers in Market - Clicking this button will give you a pop-up 
screen containing a quick overview of the other newspapers with 20% 
or greater penetration in the selected newspaper’s home county. Data is 
organized by Owner name. Screen includes an Also Owns button 
indicated by a question mark that, when clicked, opens an Owner Also 
Owns window. For more information, see #7 under the Owner Tab. 

 
11. Print Screen Button - This button allows you to print a replicated 

copy of the information found on this screen to your Windows default 
printer.  

12. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

13. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 
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Market #2 Tab (Analyzer Only) 

Radio Market  #2 Tab (Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Market Counties - A list of the counties comprising the Radio Metro 
with population listed in thousands (000s). 

2. Station and Market Identifiers - This area provides identifying 
information for the station and market selected. If the market 
information is blank, the station is not located in a rated market.  

3. Available Allocations - Lists any new station allocations for the 
market available through Docket 80-90 or other FCC rulemakings. 

4. Market Demographic Breakdown - The breakdown of the market’s 
population by gender and age group. If blank, selected station is not in 
a rated market. 

5. Allocation Notes - Notes, if any, the available radio frequencies not 
presently on-the-air which are allocated to the market. 

6. Other Markets - If any, lists the other radio markets in which some 
stations may be rated. 

7. Market Selector - This box indicates the one or more markets in which 
this station is rated. On most tabs of the Station Information screen, 
clicking on a market name other than the one that is highlighted will 
change the market information to correspond to the new market. 

8. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

9. Market Map Button - clicking this button will generate a color map of 
the market. If station is not located in a rated market, a blank gray 
screen will generate. Press ESC to return to the Market #2 tab. Right 
click on the map to adjust the zoom, save the map to a file, or print the 
map. 
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For best results in printing the Market Map, set the parameters as 
outlined and shown in the sample below. 
• Measurement Units = Pixels 
• Print = Whole Image(s) 
• Center = checked 
• Isometric = checked 
• Click Fit to Page button 

 
 

10. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer. 

11. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 
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Television Market #2 Tab (Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station Identifiers - This area provides identifying information for the 
station selected and its market. 

2. Historic Market Trends - A 7-year historical overview highlighting 
technical factors and viewing statistics that reflect trends in the specific 
market.  

3. Demographic Statistics - Estimated historic and projected market 
Population (Pop), Households (HH), Retail Sales (RS), and Effective 
Buying Income (EBI) figures. Data is licensed from Market Statistics. 
See Copyrights. 

4. Demographic Growth Rates - Estimated historic and projected 
growth rates for Population, Households, Retail Sales, and Effective 
Buying Income. Data is licensed from Market Statistics. See 
Copyrights. 

5. Market Demographic Rankings - the market’s national ranking by 
Population (Pop), number of Households (HH), total Retail Sales (RS) 
dollars, and Effective Buying Income (EBI). 

6. Print Screen Button - Allows you to print a replicated copy of the 
information found on this screen to your Windows default printer.  

7. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

8. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 
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Newspaper Market #2 Tab (Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Paper and Market Identifiers - This area provides identifying 
information for the newspaper and the city and state where it is 
published.  

2. Market Indicator - Label that identifies the market level definition. 
Primary market is defined by the county in which the newspaper is 
published. Secondary Market includes all of the counties in which the 
newspaper registers 20% or greater circulation penetration and will 
include the primary market county as well. 

3. Demographic Statistics - The sum of the counties composing the 
secondary market’s estimated historic and projected market Population 
(Pop), Households (HH), Retail Sales (RS), and Effective Buying 
Income (EBI) figures. Data is licensed from Market Statistics. See 
Copyrights. 

4. Demographic Growth Rates - The estimated historic and projected 
rate of growth for the demographic statistics outlined in #3 above for 
the secondary market. Data is licensed from Market Statistics. See 
Copyrights. 

5. Secondary Market Counties - A list of the counties comprising the 
subject newspaper’s secondary market with population listed in 
thousands (000s). 

6. Market Financial Statistics - Estimated per capita, median and 
average household income for the secondary market. Data is licensed 
from Market Statistics. See Copyrights. 

7. Market Demographic Breakdown - The breakdown of the secondary 
market’s population by gender and age group.  

8. Market Ethnic Percentages - Percentage breakdown of the White, 
Black, Asian, and Hispanic Origin population in the secondary market. 
Data is licensed from Market Statistics. See Copyrights.  
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NOTE: Ethnic percentages do not total 100%. Hispanic Origin persons 
are also included in the other categories. 

9. Other Papers in Market - Clicking this button will give you a pop-up 
screen containing a quick overview of the other newspapers that are 
located in the secondary market counties. Data is organized by Owner 
name. Screen includes an Also Owns button indicated by a question 
mark that, when clicked, opens an Owner Also Owns window. For 
more information, see #7 under the Owner Tab. 

 
10. Print Screen Button - This button allows you to print a replicated 

copy of the information found on this screen to your Windows default 
printer.  

11. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

12. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

Market #3 Tab (Television Analyzer Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  
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1. Station Identifiers - This area provides identifying information for the 
station selected and the market in which it is located.  

2. Adjacent Station Share - Provided for the for the critical dayparts 
during the last 8 Nielsen ratings periods, this chart represents the 
percentage of viewing in the market lost to stations in adjacent markets. 

3. Local Market Share - Provided for the critical dayparts during the last 
8 Nielsen ratings periods, this chart represents the total average share of 
viewing to local broadcast stations. 

4. Print Screen Button - Allows you to print a replicated copy of the 
information found on this screen to your Windows default printer.  

5. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

6. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

Rankers Tab (Radio Rankers Users Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

Rankers provides you with audience performance indicators for rated radio stations 
based on their Arbitron ratings. With the exception of the most current 12+ actual 
share shown on this screen, the other data represent a station’s ranking as compared 
to all the other stations in the market. This is shown broken down by the various 
demographic categories and critical dayparts. As shown in the example above, this 
News/Talk/Sports-formatted station is ranked #7 with Persons (Men and Women), 
aged 35 to 64 in its market. 

NOTE: If ranking data does not appear on this tab, either the station is not located in 
a rated market or it did not receive ratings for the time period indicated. Also note 
the Period - BIAfn updates the ratings as they are released by Arbitron, therefore, the 
period indicated from market to market may be different. In addition, while most 
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markets are rated four times per year some are rated only twice. In theses instances, 
the ratings for the most currently available period for these markets will appear. 

1. Station Identifiers - This area provides identifying information for the 
station selected and the market in which it is located. If the market 
information is blank, the station is not located in a rated market. 

2. Share - Current 12+ Arbitron ratings share for this station for the 
ratings period indicated. 

3. Period Indicator - Indicates the ratings period applicable for 
information displayed. 

4. Demographic Ranking - The ranking of the station with Men, Women 
or Persons for the age group indicated, with number one being the best. 

5. Daypart Ranking - The station’s overall ranking with listeners in the 
market broken down by daypart. 

6. Current Market Indicator - Indicates the name of the market for 
which data is currently displayed. 

7. Market Selector - This box indicates the one or more markets in which 
this station is rated. On most tabs of the Station Information screen, 
clicking on a market name other than the one that is highlighted will 
change the market information to correspond to the new market. 

8. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer.  

9. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations available on the Results 
Tab. 

10. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

Ratings Tab (Radio Ratings Users Only) 

Ratings Tab Overview (Radio Ratings Users Only) 
Ratings provides you with audience performance indicators for rated radio stations 
based on their Arbitron shares. The data on this screen represent a station’s estimated 
share, number of persons, and ranking as compared to all the other stations in the 
market. This is shown broken down by the various demographic categories and 
critical dayparts.  

NOTE: If share data does not appear on this tab, either the station is 1) not located in 
a rated market or 2) it did not receive ratings for the time period indicated. Also note 
the Period - BIAfn updates the ratings as they are released by Arbitron, therefore, the 
period indicated from market to market may be different. In addition, while most 
markets are rated four times per year some are rated only twice. In theses instances, 
the ratings for the most currently available period for these markets will appear. 

The Ratings tab toggles between two views so that you can access the estimated rank 
and share of the station by daypart or the estimated number of persons (in hundreds - 
00s) attributed to the station’s share of the listening market. Click on the appropriate 
radio button in the gray box on the right of the screen to view the information you 
wish to see.  
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Ratings Tab Rank / Share View (Radio Ratings Users Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station Identifiers - This area provides identifying information for the 
station selected and the market in which it is located. If the market 
information is blank, the station is not located in a rated market. 

2. Period Indicator - Indicates the ratings period applicable for 
information displayed. 

3. Rank and Share - The ranking of the station with Men, Women or 
Persons for the age group indicated, with number one being the best, 
along with the current Arbitron ratings share for this station, for the 
demographic or daypart category, and for the ratings period indicated. 

4. Ratings View Selector -Click on the radio buttons to toggle between 
the Rank / Share and the Persons view of the Ratings Tab. 

5. Daypart Ranking and Share- The station’s overall ranking and the 
current Arbitron ratings share with listeners in the market broken down 
by daypart. 

6. Met Cume and TSA - Cume is the total number of different persons 
who tune to a radio station during the course of a daypart for at least 
five minutes. Total Survey Area (TSA) AQH is the estimated number 
of different persons (in hundreds) listening for at least 5 min in an 
average quarter hour (AQH) Monday-Sunday 6AM-12AM.  

7. Current Market Indicator - Indicates the name of the market for 
which data is currently displayed. 

8. Market Selector - This box indicates the one or more markets in which 
this station is rated. On most tabs of the Station Information screen, 
clicking on a market name other than the one that is highlighted will 
change the market information to correspond to the new market. 

9. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 
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10. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer.  

11. Station Navigation Buttons - These up and down buttons allow you to 
scroll through the current tab view of the stations available on the 
Results Tab. 

Ratings Tab Persons View (Radio Ratings Users Only) 

 
NOTE: For specific field definitions see Field Names under the Help menu in 
MEDIA Access Pro™.  

1. Station Identifiers - This area provides identifying information for the 
station selected and the market in which it is located. If the market 
information is blank, the station is not located in a rated market. 

2. Period Indicator - Indicates the ratings period applicable for 
information displayed. 

3. Persons (00) - The estimated number of Persons in hundreds (00) by 
gender and age category who listened to this station during an average 
quarter hour. 

4. Ratings View Selector - Click on the radio buttons to toggle between 
the Rank / Share and the Persons view of the Ratings Tab. 

5. Daypart Persons - The estimated number of Persons in hundreds (00)  
listening in the market broken down by daypart. 

6. Met Cume and TSA - Cume is the total number of different persons 
who tune to a radio station during the course of a daypart for at least 
five minutes. Total Survey Area (TSA) AQH is the estimated number 
of different persons (in hundreds) listening for at least 5 min in an 
average quarter hour (AQH) Monday-Sunday 6AM-12AM.  

7. Current Market Indicator - Indicates the name of the market for 
which data is currently displayed. 

8. Market Selector - This box indicates the one or more markets in which 
this station is rated. On most tabs of the Station Information screen, 
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clicking on a market name other than the one that is highlighted will 
change the market information to correspond to the new market. 

9. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

10. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer.  

11. Station Navigation Buttons - These up and down buttons allow you to 
scroll through the current tab view of the stations available on the 
Results Tab. 

Maps Tab (Coverage Maps Users Only) 

 
NOTE: This tab will be visible but rendered inoperable if you are not a licensed user 
of  Coverage Maps.  

1. Station Map Area Selector - Select the area you want to cover with 
your map. 

• Market - The market in which the selected television or radio 
station is rated (if applicable) (default selection). 

• 50 Mile Radius - Within a 50-mile radius of the station currently 
selected. 

• Selected Stations - All of the stations selected in your search 
results. 

• This Station - The individual station selected. 

2. Station Identifiers - This area provides identifying information for the 
station selected and the market in which it is located. If the market 
information is blank, the station is not located in a rated market. 

3. Map Market Selector - If you wish to map a rated market other than 
the market of the selected station, locate and click on the market in this 
scroll box. 
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4. Map Results Order - Click here to pick the order in which you would 
like to have the BIAfn Map Viewer display the stations you have 
selected—alphabetically or in the order of your results. 

5. Multi-Media Map Selector - Rendered inactive unless utilizing the 
multi-media function that allows you to select the capability to map the 
other media to which you are licensed.  

6. Build Map Button - Click on this button to open up the BIAfn Map 
Viewer to create a base map with the specifications you have outlined 
on this tab. 

7. Newspaper Map Area Selector - Sample portion of the Map Tab 
screen for Newspaper wherein you can select the area you want to 
cover with your map. 

• The selected newspaper (default selection). 

• All the newspapers located in the secondary market. 

• All of the newspapers selected in your search results. 

8. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations or newspapers available on 
the Results Tab. 

9. Correction Link - Click on this link to activate an e-mail to BIAfn to 
report corrections. 

Web Site Tab (Analyzer Only) 

 
When you click on either an active Web Site Link on the Contacts Tab or access the 
Web Site tab for a station or owner record that contains a Web address, MEDIA 
Access Pro™ will automatically launch your Internet connection and display the 
designated address on the Web Site Tab within the program. To deactivate this 
automatic feature, click on File > Change Version and deselect the Web Browsing 
check box. See Change Version under the System Maintenance section for more 
details on the operation of this tab. 
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1. Web Navigation Buttons - Allows you to reverse and advance through 
the Web sites you’ve viewed in the present session. 

2. Stop Button - Halts the Web site loading process. 

3. Refresh Button - Clicking this button refreshes the Web site presently 
in the view. 

4. Home Button - Clicking this button will access the BIA.com Web site. 

5. Station or Newspaper Identifiers - This area provides identifying 
information for the station or newspaper selected.  

6. Web Selection  - Indicates whether you are viewing the Web site of the 
Station or Newspaper, Owner, or Parent company of the selected 
station or newspaper. Clicking on an alternate selection will launch the 
Web site for that entity. A Web site is not available for that particular 
entity when the selection is grayed out. 

7. Web Address - Indicates the Web address being accessed or displayed. 
You can access any Web address you desire while still within MEDIA 
Access Pro™. 

8. Print Screen Button - This button allows you to print a replicated 
copy of the information found on this screen to your Windows default 
printer.  

9. Navigation Buttons - These up and down buttons allow you to scroll 
through the current tab view of the stations or newspapers available on 
the Results Tab. 

10. Web Page - Displays the Web site shown in the Web address or, if not 
available, a link to access BIAfn’s Web site. 

11. Scroll Bars - Allows the scrolling up and down and right and left of the 
Web page. 
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6: Multi-Media 

Overview 
If you are a MEDIA Access Pro™ user licensed for the Multi-Media feature and data for more than one 
industry (Radio and Television; Radio and Newspaper; Television and Newspaper; or Radio, Television and 
Newspaper) you will gain access to the Multi-Media feature. This gives you the ability to view the data on a 
combined basis in various integrated formats.  

How to Access the Multi-Media Screens 
1. With MEDIA Access Pro™ open, select a Primary Media industry 

(Radio, Television, or Newspaper) from which you want to first base 
your search. 

2. Perform a search to get a sub-set of data  (Example: With Television  as 
the primary media, perform a Quick Search on Market equals Boston). 

3. From the Results screen, click on the Multi-Media button found in the 
screen buttons just below the menu bar. 

NOTE: If you do not subscribe to the Multi-Media feature, the Multi-
Media button will not be selectable (i.e., “grayed out”). 

4. The Multi-Media Search Results screen will open. This screen contains 
tabs that allow you to view the integrated data in three different ways. 

• Results by Media Type - Allows you to view the integrated data 
for each media database for which you are licensed via scrolling 
screens of data based on links by either County, Owner, Parent, 
Radio Market (MSA), Television Market (DMA®), or Coverage.  

• Combined by Coverage - Based on the counties covered by the 
record highlighted under the Primary Media in the Results by 
Media Type screen. 

• Multi-Media Maps - Provides you the ability to plot integrated 
coverage maps of the medias for which you are licensed. 
 

 

 



 

84  •  6: Multi-Media MEDIA Access Pro™ Version 4.0 User Manual 

Multi-Media Results by Media Type 
 

This screen provides you with a view of your data for each media to which you are 
licensed. Results are displayed with the primary media in which you originated your 
search at the top and linked by the link type selected at the top of the screen. 

NOTE: All linked media relate only to the highlighted Primary Media record. There is 
always a one-to-many relationship between a single primary record and multiple linked 
records. 

1. Link on Types - Click on the radio button next to the type of link on 
which you would like to set the relationship of the data between media. 

• County - Based on the individual record selected (highlighted in 
yellow) under the Primary Media section, the records shown in the 
corresponding media tables are linked on the primary (home) 
county serviced by the highlighted record.  

• Owner - Links the other media to the owner of the highlighted 
record in the Primary Media section. If blank in linked media 
sections, Owner does not presently own media properties of those 
types. 

• Parent - The Parent holding company of the Owner is the basis of 
the link to the other media sections. If blank in linked media 
sections, Parent does not presently hold media properties of those 
types. 

• Radio Market (MSA) - When checked, the corresponding media 
sections will provide you with those entities that provide service 
within the counties covered by the Arbitron Metropolitan 
Statistical Area (MSA).  

• TV Market (DMA®) - When checked, the corresponding media 
sections will provide you with those entities that provide service 
within the counties covered by the Nielsen Media Ratings’ 
Designated Marketing Area (DMA®).  

• Coverage - Based on all of the counties covered by the individual 
record selected under the Primary Media section, the linked media 
display the entities that also cover these counties. 
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2. Filter on Check Box- Enables the primary media table to adjust along 
with the secondary media tables, based on the users selection /actions 
from the Link on section within the Multi Media screen.  

3. Excel Export - Clicking this button opens Microsoft Excel and exports 
the integrated data into one workbook file with each industry’s data 
presented on a separately labeled spreadsheet.  

NOTE: Microsoft Excel must be installed on your computer for this 
feature to work. 

4. Show Counts - When this box is checked the program will provide you 
with the counts of the number of records in the linked media sections.  

 NOTE: Providing the counts for these searches can require significant 
processing time. You can speed the results of your integrated media 
searches by removing the check from this box. You can reinstate the 
count at any time by clicking on the box. 

5. Primary Media - Displays the results of your initial search in the 
media that you selected for your base search. The data provided 
highlights either the default fields or those you have custom selected in 
the Output Fields for your search. Double-click on any record to see the 
record detail. You can scroll through the records in the Primary Media 
results using the navigational arrows on the detailed information 
screens. To return to the integrated Multi-Media data, press ESC on 
your keyboard or click on the X in the upper right hand corner to close 
the detail screens. 

NOTE: Whatever record you were last viewing in the detail screens 
will be the linked record you return to when you return to the Multi-
Media screens. 

6. Link Base - Reflects the identity of the link being used from the 
individual record highlighted in the Primary Media. This changes as 
you alter link types and spells out the County, Owner, Market, etc. on 
which the link is based. 

7. Linked Media  - This section displays records from the other licensed 
media resulting from the record and link selected. The fields of data 
provided are those that are included in the standard default search 
results fields and cannot be customized without changing your default 
settings for that medium. To see the detailed screens of a station or 
newspaper in this section, double click on the record to enter the 
information screens for that entity. To return to the integrated Multi-
Media data, press ESC on your keyboard or click on the X in the upper 
right hand corner to close the detail screens. 

NOTE: You cannot scroll record-by-record through the information 
screens while in the Linked Media view, only those in the Primary 
Media view. 

8. Record Count - Displays the count of the number of records for the 
referenced media that corresponds to the link type and selected record 
under the Primary Media section. This will not display if you do not 
have a check next to “Show Counts” at the top right of the Multi-Media 
screen. 

9. Linked Media - If present, provides data for the third media for which 
you are licensed. See #6 above for additional details. 
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10. Record Count  - If a third media is licensed and the “Show Counts” 
box is checked, you will see the number of entities that are linked. 

Multi-Media Results Combined by Coverage 

 
This screen provides a compilation of the integrated media concerns for which you 
are licensed that link to the record selected previously in the Results by Media Type. 
The results provide a compilation of all of the media entities that are located in the 
counties covered by the selected record. 

1. Media Type - Denotes the Primary Media type from which your search 
results were based. 

2. Entity Identification - Lists the initial record on which the relationship 
and county coverage is based. 

NOTE: To change this initial record, click on the Results by Media 
Type, select a new entity, and click back on the Combined Coverage 
Tab. 

3. Number of Counties - Displays the total of counties covered by the 
subject entity. 

4. Excel Export - Clicking this button will launch Microsoft Excel to 
create an export file of the data presented in this tab in an Excel 
workbook. 

5. FIPS Code - Lists the Federal Information Processing Standards code 
assigned to the subject county listed in the County field for this record. 

6. County - Provides the county name associated with the FIPS code and 
affiliated with the media entities highlighted in the other media fields. 

7. State - Lists the state in which the subject County of the record is 
located. 

8. Radio Calls - If you are licensed to the Radio database, this column 
provides the call letters of the radio stations that have coverage in the 
County noted in the corresponding field of the subject record. 
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9. TV Calls - If you are licensed to the Television database, this column 
provides the call letters of the television stations that have coverage in 
the County noted in the corresponding field of the subject record. 

10. Newspaper Name - If you are licensed to the Newspaper database, this 
column provides the name of the newspapers that have coverage in the 
County noted in the corresponding field of the subject record. 

 

Multi-Media Maps Tab 

 
If you are a licensed Multi-Media and Coverage Maps subscriber, you will have 
access to the Multi-Media Maps tab. From this tab you can access the BIAMapX™ 
Coverage Maps program and plot the coverage of the integrated media to which you 
are licensed. 

See the section on Coverage Maps for more details on the operation of the 
BIAMapX™ program. 

NOTE: If you are not a licensed Coverage Maps user, this tab will appear but, when 
you click the “Build Map” button, you will receive a notice stating how you can gain 
more information on this feature. 

1. Station or Newspaper Identification Information - This area will 
provide you with the call letters or newspaper name and the 
corresponding identification and market information. 

2. Map Area Selector - Select the area you want to cover with your map. 

• Market - The market in which the selected television or radio 
station is rated (if applicable) or the area in which the newspaper 
located. 

• 50 Mile Radius - Within a 50-mile radius of the radio or television 
station currently selected. 
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• Selected Stations (or Newspapers) - All of the stations or 
newspapers selected in your search results. 

• This Station (or Newspaper) - Only the individual station or 
newspaper selected. 

3. Map Market Selector (Radio & TV Only) - If you wish to map a 
rated market other than the market of the selected station, locate and 
click on the market in this scroll box. 

4. Map Results Order (Radio & TV Only) - Click here to pick the order 
in which you would like to have the BIAMapX™ Viewer display the 
stations you have selected—alphabetically or in the order of your 
results. 

5. Multi-Media Map Selector - Check to add to your map the other 
media to which you are licensed. If you are not licensed to a particular 
media, the corresponding option will be grayed out. 

6. Build Map Button - Click on this button to open up the BIAMapX™ 
Viewer with all of the options you selected ready to display. See 
Coverage Maps chapter for more information. 
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7: New Search 

The real power of MEDIA Access Pro™ is accessed through the New Search button. 
This chapter provides you with quick step-by-step instructions, as well as greater 
detail on the powerful tools contained in this screen. 

Quick Step-by-Step Instructions 

 
To perform a New Search, you will need to open up the Selection Set screens by 
clicking on the New Search button. The screen will open with the Selection Criteria 
tab on top. 

1. From the Field List using either the Contents, Index or Favorites view, 
click on the Field on which you want to search. 

2. In the Conditions box, click on the filter condition that will get you the 
results you desire. 

3. In the Value(s) box, type in the value for which you wish to search. 

4. Click on the Add button to insert your search statement into the criteria 
box. 
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5. Repeat instructions 1 through 3 to add other criteria to further refine 
your search, and, if necessary, clicking on the And or Or buttons after 
each addition as appropriate to get the results you desire. 

6. Once you are satisfied with your selection criteria, press the Proceed 
button to see your results. 

NOTE: MEDIA Access Pro™ retains your last search under Saved Searches until 
you create the next new search. This means that if you don’t quite get the results you 
expected, you can go back and refine the search and try again (just hit ESC on your 
keyboard to take you back one screen). 

Selection Criteria 
The information below will take you through the purpose and use of three of the four 
basic areas on the Selection Criteria screen and the associated function buttons. The 
remaining Overview Tab is discussed in the section on Saved Searches. 

Field List Folders 
The Field List folders are found on the Selection Criteria Tab, Output Fields Tab, 
and the Sort Order Tab. It is from these folders that you select, from the hundreds 
available, just those fields for which you would like to search, see and sort in your 
output. There are three optional methods available for finding the fields you desire: 

• through a categorized field list (Contents) 

• through an alphabetical field list (Index) 

• or through a list of personally selected most-used fields (Favorites) 

Contents 
The Contents folder is just one of the ways you can locate fields on which to search, 
sort, or output. The Contents folder provides you with a list of the available fields 
logically categorized into four main folders--Market, Owner, Parent, and Station. 
Clicking on the “+” signs next to the folders or the actual folder name will expand 
the view to include the subcategories (sub-folders) and specific fields applicable to 
these categories. You can also search for specific fields by entering keywords in the 
“Highlight items containing” box.  

Contents Field List Step-by-step Guide 
As an example, let’s say you are looking for a specific Chief Engineer whom you 
know works in radio but you don’t know with which station he is now employed. 
There are two different methods in the Contents tab - Category Selection or Field 
Search - to find the Chief Engineer field on which to search.  

Category Selection 
A Chief Engineer is one of the key personnel found at a radio station, therefore, 
fields for station Personnel can be found in the Station folder. 
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1. Click on the word “Station” in the Field List Box. The field name 

“Station” is now shown in white type framed in dark blue and the sub-
folders of the Station category are now visible. 

2. Scroll down and click on the word “Personnel.” The field name 
“Personnel” is now shown in the white type framed in dark blue and the 
sub-folders of the Personnel category are also now visible. 

3. Click on the words “Chief Engineer.” The field name “Chief 
Engineer” is now shown in the white type framed in dark blue and the 
sub-folders of the Chief Engineer category--”First Name” and “Last 
Name”--are now visible.  

NOTE: the Field Help at the bottom of the Selection Set screen 
indicates that you can search for the Chief Engineer’s last name using 
the highlighted sub-folder. If this field was not a searchable field, the 
Field Help and the Conditions box above would both direct you to 
“Click on a sub-category or field to search..” 

4. You can now set the Conditions (see below) for searching for the Chief 
Engineer by his last name. 

Field Search 
If you’re not certain under which category you might find the type of field for which 
you are seeking, instead of clicking around trying to find it, you can search for it. 
The Contents field search will expand the appropriate folders and sub-folders and 
highlight all those fields containing the text that you’ve typed in the search box. 

 
1. Click in the “Highlight items containing” box. 

2. Type in the words “Chief Engineer” and press Enter. Note that 
MEDIA Access Pro™ expands the field list categories and highlights 
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in yellow those fields containing the words “Chief Engineer.” You may 
notice field names highlighted that do not contain the text you 
requested. When searching for the text you have typed, MEDIA Access 
Pro™ consults not only the actual field names, but also searches 
through lists of aliases and synonyms created by BIAfn. (e.g., Type in 
“Ratings” and you’ll get all the “Shares” fields from Arbitron or 
Nielsen). 

3. Click on the word “Chief Engineer.” The field name “Chief Engineer” 
is now shown in the white type framed in dark blue.  

NOTE: the Field Help at the bottom of the Selection Set screen 
indicates that you can search for the Chief Engineer’s last name using 
the highlighted sub-folder. If this field was not a searchable field, the 
Field Help and the Conditions box above would both direct you to 
“Click on a sub-category or field to search..” 

4. You can now set the Conditions (see below) for searching for the Chief 
Engineer by his last name. 

Hints for Using Contents 
Multi-field Searches: With pre-established Multi-fields you can search 
across various same-type fields. For example, while Personnel is a sub-
category (or sub-folder) of the Station category, it also a Multi-field of all 
the Last Name fields for all of the key personnel fields (i.e.., General 
Manager, Sales Manager, Chief Engineer, etc.). This is indicated by the 
presence of an Index name and specific help in the Field Help located at the 
bottom of the screen. A non-searchable folder will profile the message 
“Click on a sub-category or field to search.” 

Field Expander: To open up all the folders and sub-folders, click on the 
Field Expander button [ + ] located to the right of the “Highlight items 
containing” box. Each time you click on the [ + ] button it expands the 
folders to the next level of sub-folders and available fields.  

Field Collapser: To return the field list to its main categories, click on the 
Field Collapser button [ - ] located to the right of the “Highlight items 
containing” box. Each time you click on the [ - ] button it  collapses the 
fields back into the previous level of sub-folders and main folders. 

Clear Highlighting: To remove the highlighting caused by searching for a 
field either 1) search for a new field name or 2) highlight and delete the 
previous field name search and then press Enter with the cursor in the blank 
“Highlight items containing” box. 

Index 
The Index folder is another one of the methods you can use to locate fields on which 
to search, sort, or for outputting. The Index folder provides you with a list of the 
available fields in alphabetical order by field name. You can also filter for specific 
fields by entering keywords in the “Show only items containing” box.  

Index Field List Step-by-step Guide 
Follow the steps below to select the Fields of your choice using the Index Field List 
for application to the Selection Criteria, Output Fields or Sort Order. 
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1. Click anywhere in the Index field list to activate it. A field name will be 

highlighted and its description will appear below the Field List box in 
the Field Help. 

2. Find the field on which you want to base your search criteria and click 
on it to highlight it. There are three ways to do this: Scroll, Rapid Type, 
or Search. 

• Scroll - scroll down through the list by either 1) tapping on the 
down arrow key; 2) repeatedly clicking on the down arrow in the 
scroll bar; or 3) clicking, holding and pulling down on the scroll 
button in the scroll bar. 

• Rapid Type - instead of manually scrolling, if you’ll type, 
rapidly, the first few letters of your selection, MEDIA Access 
Pro™ will take you to the first instance in the list that begins with 
those letters. 

• Search - in the “Show only items containing” box, type in a 
keyword such as “Owner” and hit Return or click on the GO 
button. This will filter out only those fields that contain the word 
“Owner” in either its field name, its alias, or a synonym reference 
established by BIAfn. To restore the complete list of fields, click 
on the All button located to the right of the Go button. 

3. Use one of the following methods to apply the field name it to its target 
destination: 

• For setting your Selection Criteria pick a Condition, insert a Value 
and click on ADD. 

• For Sort Order or Output Fields, either 

o Drag and drop: click the field name, hold down the left mouse 
button, drag the arrow to the destination box, and release the 
left mouse button 

o Double click on the Field Name 

o With the field name highlighted, press Enter 

o With the field name highlighted, click on the Add > button 
next to the destination box. 

• For Unique Fields, either 

o Drag and drop: click the field name, hold down the left mouse 
button, drag the arrow to the destination box, and release the 
left mouse button. 
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o Click on the Add > button next to the destination box. 

NOTE: To remove a field name from Sort Order, Unique Fields, or 
Output Fields, reverse any of the above procedures or highlight the 
field in the box and click on the < Remove button next to it. 

Favorites 
The Favorites folder allows you to customize MEDIA Access Pro™ to more easily 
locate the fields on which you repeatedly search, sort, or output. You build the 
Favorites folder from the list of any of the available fields. These are then stored in 
alphabetical order by field name.  

Favorites Field List Step-by-step Guide 
Adding Fields to Your Favorites 

 
1. When you first install MEDIA Access Pro™, your Favorites field list is 

empty. You will want to build it with the fields that you use 
recurrently. 

2. From either the Contents or Index field selection tabs, click on one of 
the fields you wish to add to your Favorites tab, making sure it is 
highlighted (white type with a dark blue background). 

3. Click on the Favorites tab. You should see the field name you 
highlighted now showing in the “Current selection” window.  

4. Click on the Add button to include it in your Favorites tab. 

5. Repeat steps 2 through 4 above for each field you wish to add to your 
Favorites. 

Selecting Fields 
Follow the steps below to select the Fields of your choice and apply them to the 
Selection Criteria, Output Fields or Sort Order . 

1. Click anywhere in the Favorites field list to activate it. A field name 
will be highlighted, it will appear in the “Current selection” window, 
and its description will appear below the Field List box in the Field 
Help. 

2. Find the field on which you want to base your search criteria and click 
on it to highlight it. There are two ways to do this: Scroll or Rapid 
Type. 
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• Scroll - scroll down through the list by either 1) tapping on the 
down arrow key; 2) clicking on the down arrow in the scroll bar; or 
3) clicking, holding and pulling down on the scroll button in the 
scroll bar. 

• Rapid Type - instead of manually scrolling, if you’ll type, 
rapidly, the first few letters of your selection, MEDIA Access 
Pro™ will take you to the first instance in the list that begins with 
those letters. 

3. Use one of the following methods to apply the field name it to its target 
destination: 

• For setting your Selection Criteria pick a Condition, insert a Value 
and click on ADD. 

• For Sort Order or Output Fields, either 

o Drag and drop: click the field name, hold down the left mouse 
button, drag the arrow to the destination box, and release the 
left mouse button 

o Double click on the Field Name 

o With the field name highlighted, press Enter 

o With the field name highlighted, click on the Add > button 
next to the destination box. 

• For Unique Fields, either 

o Drag and drop: click the field name, hold down the left mouse 
button, drag the arrow to the destination box, and release the 
left mouse button. 

o Click on the Add > button next to the destination box. 

NOTE: To remove a field name from Sort Order, Unique Fields, or 
Output Fields, reverse any of the above procedures or highlight the 
field in the box and click on the < Remove button next to it. 

Conditions (Filter Conditions) 
The conditions from which you can choose in the Condition box automatically 
change depending on the type of field selected at the time. If the highlighted field is a 
character (text) field the condition list will be different than if the field is numeric 
(contains a number) or logical (true or false). The tables on the following pages 
profile the various condition and provides definitions, examples and notes to 
consider when using these filter conditions.  

Text Conditions 

 



 

96  •  7: New Search MEDIA Access Pro™ Version 4.0 User Manual 

 

Numeric Conditions 
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Logical Conditions 

 
Logical fields will offer only a True or False condition. Click on the one you want, 
then click on the ADD Button to add the statement to the criteria box. No value is 
needed. 

The Home Market field also offers unique conditions. You can choose True, False or 
Ignore. Select the appropriate condition, then click on the ADD Button. No value is 
needed. 

Not Conditions 
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Text and Numeric conditions can be “inverted” to an opposite value by clicking on 
the NOT button next to the Conditions box. For example “is in the list” becomes “is 
not in the list”, etc. 

Memo Field Conditions 

 
Memo fields are used for fields that require unlimited space capacity such as Notes 
fields (e.g., Local Comments, Network Comments, Deal Terms, etc.).  A memo field 
only takes up as much space on your hard disk as there is content in the field, thereby 
saving valuable disk storage capacity. These field types have only one option for 
searching -- “Contains the text.”   

Distance Search Conditions 

 
BIAfn’s custom filter conditions that allows you to all the Radio and/or Television 
stations within a specified radius of either a designated station (CALLS) or using a 
latitude and longitude locator. 

Search Only 
Search Only Radio 

 
Search Only Television 

 
The “Search Only” selection box  is created to facilitate easier searching of Radio 
and Television stations. By selecting only those types of stations you wish to see in 
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your search results through this special filter, you need not scroll through unwanted 
records nor apply complicated criteria to get exactly what you want. 

By default, this box automatically appears anytime you click on the Quick Search, 
New Search or Saved Search buttons. This feature can be turned off by either of two 
different methods.  

1. Click on the check box next to Search Only located in the upper right 
corner of the Selection Criteria screen.  

 
2. Click on File > Change Version in the menu bar and remove the check 

next to “Search Only” toolbar.  

 

Value(s) 
The value box is where you type in or select the values that will get you the results 
you desire from your search. See the Field Name Descriptions for help in 
determining the format for a selected field’s value. Use the Display Pick List to get a 
list of unique values from which to choose. 

Semicolon 
The semicolon is used to separate values in selection criteria. 

 
Examples: 

• Market Rank is between 25;50 

• Format is in the list Country;News/Talk;CHR 
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Display Pick List 

 
The Display Pick List button runs a search of the entire database and returns all of 
the unique possible values alphabetically that will work for the field you currently 
have selected. Click on the value you want to use from the list that appears and it 
will be inserted into the Value(s) box for you.   

NOTE: Because computers and databases are very literal, if you are uncertain of the 
spelling of a name, it is highly suggested that you use this feature to achieve better 
search results. 

HINT: When working with long Pick Lists, instead of scrolling down through the 
list by clicking on the down arrow or clicking, holding and pulling down on the 
scroll button, if you’ll type, rapidly, the first few letters of your selection, MEDIA 
Access Pro™ will take you to the first instance in the list that begins with those 
letters. 

HINT: The Display Pick List is also useful in just determining if a value is actually 
present in the database as opposed to running a search that may return no results or 
other results you were not expecting (i.e., more than one market beginning with 
Portland--Portland, OR and Portland, ME) . 

Criteria Box 

 
The Criteria box stores and allows you to reorder the filter conditions you have 
created to do your search. The buttons along the top help you to set the conditions of 
your search to retrieve the results you desire. Descriptions of each function follows. 

1. ADD Button - The ADD button adds the search criteria statement you 
built to the Criteria box on the Selection Criteria screen. You must add 
each statement that you want to have included in your search. Only 
statements listed in the Criteria box will be executed. 

2. Parentheses - Parentheses are used to group multiple search statements 
together so MEDIA Access Pro™ recognizes them as one condition. 
Just like in High School algebra, the statements within the parentheses 
are run first, then the rest of the conditions are compared against that 
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result.  This allows you to do things that could not be done (or would 
be much more difficult to do) without parentheses. 

When you use multiple Or statements in your criteria, you may need to 
group several of them together so they are evaluated as one condition. 
For example, you may have the conditions: 

Market Name equals Washington Or Market Name equals New York 
Or Market Name equals Chicago And Revenue-Station 2001 is greater 
than $10,000,000. 

If you proceed without grouping all of the Or conditions together, you 
will get all of the stations in Washington (regardless of their revenue), 
all of the stations in New York (regardless of their revenue), and all of 
the stations in Chicago that are estimated to be billing more than 
$10,000,000. This is probably not what you wanted. 

To group all of the Or conditions together so they are evaluated as one 
statement, use the parentheses. Put a left parenthesis at the beginning of 
the first line and a right parenthesis at the end of the last line in the 
group (i.e. the Market equals Chicago line). You only have to 
determine whether you want an opening (left) or closing (right) 
parenthesis. You do not have to worry about where in the line to put the 
parentheses, MEDIA Access Pro™ puts them in the right place for you. 

For example: 

(Market Name equals Washington OR 

Market Name equals New York OR 

Market Name equals Chicago) AND 

Revenue-Station 2001 is greater than 10000 

Applying the parentheses in this search will cause the entire statement 
to be evaluated as Market equals Washington or New York or Chicago 
and revenue is more than $10,000,000. This is probably what you 
wanted. 

Adding Parentheses 

You add parentheses by highlighting the line in the Criteria box that 
needs a parenthesis, then clicking on the add left parenthesis button. To 
enter the closing parenthesis, highlight the line that holds the last 
statement, then click on the add right parenthesis button .  

Removing Parentheses 

To remove a parenthesis, highlight the line containing the parenthesis, 
then click on the delete left or delete right parenthesis button, 
depending on which one you want to delete. 

If you reorder the conditions, make sure the parentheses still make 
sense before you proceed. 

3. And/Or Buttons - The And button and the Or button are used to string 
multiple statements together in the Criteria box. If you have more than 
one search criteria line, MEDIA Access Pro™ needs to know how to 
process the search. You will receive vastly different results when 
applying one or the other. 

And means that the conditions of both statements must be met in order 
to include the data in your results. 
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“And” Search Criteria Example: 

Owner equals CBS And 

State of License equals New York 

Search Results: 

All the CBS stations in the State of New York 

HINT: Because the default string is “And,” when combining two 
statements in MEDIA Access Pro™, you don’t need to click on the 
And button after each entry. It automatically includes it for you. 

Or tells the program that if the conditions of either statement are met 
than include the data in your results. 

“Or” Search Criteria Example: 

Owner equals CBS Or 

State of License equals New York 

Search Results: 

All the stations in the country owned by CBS stations plus all of the 
stations in the State of New York 

Switching a Statement from And to Or / Or to And 

Follow the steps below, when you need to edit a statement from And to 
Or (or Or to And): 

o In the Criteria box, highlight the line you want to change. 

o Click once on the button (And or Or) you want to change the 
statement condition to. 

NOTE: Clicking on the And or Or button twice will remove the 
connecting condition all together. You must have an And or an Or 
between each statement. If it is missing, you will receive an error 
message.  

Also, because an And or an Or indicates that there are further filter 
conditions for MEDIA Access Pro™ to consider, the last condition (or 
a single condition) of your search criteria should never include one of 
these connecting conditions. If an And or Or is present on the final line, 
you will receive an error message. 

4. Change Button   

Use the Change button when you need to change an existing filter 
condition in the Criteria box. 

o Click in the Criteria box and highlight the filter condition you want 
to change. 

o Create the replacement filter condition from the Field List by 
applying a Condition and typing in a Value or picking it from the 
Display Pick List. 

o Click on the Change button and the new filter condition will 
replace the original one. 

o Click on Proceed to view your new results. 



 

MEDIA Access Pro™ Version 4.0 User Manual 7: New Search  •  103 

5. Delete Button - When clicked, the Delete Button above the Criteria 
window deletes the filter condition statement you have highlighted in 
the Criteria box on the Selection Criteria screen. 

6. Append Button - Use this button when you need to add another 
value(s) to a list of items in a filter condition. 

Example: 

To begin with, you wanted to see all the stations in Markets 20, 25, 30, 
and 35 in order to analyze station revenues as you drop in market size. 
Your beginning filter condition looked like this: 

 Market Rank is in the list 20;25;30;35 

You decide after receiving your results that, in order to make your 
analysis more meaningful, you need to extend the search to include 
Markets 40, 45, and 50. You perform the following steps: 

o Return to the Selection Criteria screen. 

o Click in the Criteria box on the “Market Rank” filter condition to 
highlight it.  

o Click in the Value(s) line and type in the following: 

 40;45;50 

o Click on the Append button and the new Values will be appended 
to the end of your filter condition and now looks like this: 

 Market Rank is in the list 20;25;30;35;40;45;50 

o Click on Proceed to view your new results. 

7. Reorganization Buttons - Left click and hold on the button next to a 
line of criteria you wish to move and drag it to the desired position in 
the criteria sequence.  

NOTE: Be certain to check the connecting string statement of “And” 
or “Or” at the end of the reorganized criteria lines to confirm that the 
appropriate connector has been used to achieve your desired results. 
Remember that the last line of a criteria search string should not 
contain an “And” or “Or.” 

8. Criteria Statements - This window contains the statements that create 
the criteria that, when applied, will deliver you the filtered results you 
desire. 
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Output Fields 

Output Fields: Quick and Easy Instructions 

 
The Output Fields tab allows you to select the fields that will be viewed in the 
Results screen. These same fields will be available for exporting to another program. 

1. Click on the Remove All Button to clear the Output Fields List. 

2. Using either the Index or Favorites Field List Folder, hold down the 
Ctrl button and in the Field List find and click on the various fields that 
you want in your search results. Each field name will be highlighted in 
the Field List. 

3. Click on the Add > button to include the highlighted fields in the 
Output Fields box. 
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Output Fields Selection 

 
The Output Fields screen determines what fields will be displayed on the results 
screen. If you choose to export your search results, these same fields will be 
exported. The order in which the fields will be displayed will be in the same 
sequence as the Output Fields list. 

1. Selecting (and Removing) Fields for Output - The Field List column on 
the left lists all of the fields that are available from which to choose. 
The Output Fields column on the right lists the fields that will be 
displayed and exported when you Proceed. Use one of the procedures 
below to select fields for Output. 

Several at  a Time (applicable only from the Index and Favorites Field 
List Folders) 

o Holding down the Ctrl button, find and click on the various fields 
in the Field List that you want in your search results. Each field 
name will be highlighted in the Field List. Click on the Add > 
button to include the highlighted fields in the Output Fields box. 

o Click on the << Remove All button to clear the Output Field List.  

One at a Time  

o Double click on a field name in either column to move it to the 
other column (applicable only in the Index and Favorites Field List 
Folders). You should be sure the fields in the Output Fields column 
are the ones you want to use before proceeding. 

o Click on a field in either column and then click on the Add > or < 
Remove buttons to move it to the other column (applicable in all 
Field List Folders). 

o Click, hold, drag and drop fields from one list to the other 
(applicable only in the Index and Favorites Field List Folders). 

2. Re-ordering Output Fields 
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o To re-order the fields in your results, in the Output Fields selection 
box, click on the box to the left of the field you wish to move. A 
double, up and down arrow will appear on the box. 

o Clicking on the box and holding down the left mouse button, drag 
the field to the position that will get you the results you desire. 
(NOTE: You can also hold down the Ctrl key and use the up and 
down arrows on the keyboard.) 

3. Add / Remove Buttons 

These buttons are tools to help you add and remove field names to and 
from destination boxes found on the Sort Order and Output Fields 
Tabs. 

Add > 

With a field name highlighted in the Field List, clicking on the Add > 
button next to its destination box will add the field to the list. 

< Remove 

With a field name highlighted in the Sort Order, Unique Field List, our 
Output Fields, clicking on the < Remove button will delete the field 
from the box. 

<< Remove All 

Found on the Output Fields tab, this button will remove the entire list 
of fields shown in the Output Fields.  

4. Reset Default 

Found on the Output Fields tab, this button will reset the fields for 
Output to the fields originally designated by BIAfn. 

5. Search Action Buttons 

Proceed - Starts the query for the Selection Criteria you have selected. 
This button can be found on every tab of the Selection Set screen. 

Save Button - Executes the saving of the search highlighted in the 
Save As box (See section on Saved Searches). The Save Button can be 
found on every tab of the Selection Set screen. 

Delete Search Button - When clicked will delete the search criteria for 
the search highlighted in the Saved Search Box. The Delete button can 
be found on every tab of the Selection Set screen. 

Cancel Search Button - Clicking on this Cancel button will cancel 
your search and close down the Selection Criteria window altogether. 
This button is found on every tab of the Selection Set screen allowing 
you to discontinue a search at any point in the building of your criteria. 
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Sort Order and Unique Field Selection 

 
The Sort Order Tab allows you to determine the exact order of your search results 
and to set the fields that will provide unique results. 

Sort Order Selection 
You can sort the results of your search in an unlimited number of ways on the Sort 
Order screen. You can add as many fields to sort on as you want, each field can be 
sorted individually in ascending or descending order, and you can reorder the sort by 
re-ranking the fields to be sorted. The data will be sorted on each field with priority 
given to the first fields in the list. For example, if you sort by Market Rank, then 
owner, then CALLS, your results will show each market by rank first then, within 
each market, the results would be in order by owner, and within the same owner, by 
CALL letters. 

Setting Sort Order 
1. From any of the Field List Folders on the Sort Order Tab of the 

Selection Set screen, click on the first field you desire to add the Sort 
Order selection box. 

2. In the Sort Direction box select the direction, + Ascending (A-Z) or - 
Descending (Z-A), for which you wish to sort your results. 

3. Click on the Add > button. 

Repeat steps 1-3 to add other sub sorts. 

Re-ranking Sort Order 
To re-rank the hierarchy of the fields on which you want to sort, in the Sort Order 
selection box, click on the box to the left of the field you wish to move. A double, up 
and down arrow will appear on the box. Click on the box and holding down the left 
mouse button, drag the field to the sort position that will get you the results you 
desire.  

NOTE: You can also hold down the Ctrl key and use the up and down arrows on the 
keyboard.) 
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Unique Field Selection 
The Unique Field Selection allows you to retrieve unique results (only one instance) 
for your selected field(s). 

Example: You want a list of the Top 50 Group Owners. You would select Owner as 
your unique field. If you did not select owner as a unique field, because MEDIA 
Access Pro™ is a station-centric database, it would return a list of all of the stations 
owned by the Top 50 owners. This would be a list of thousands of stations as 
opposed to a list of the 50 unique owners. 

Creating a Unique Field List 
1. From any of the Field List Folders on the Sort Order Tab of the 

Selection Set screen, click on the first field to add the Unique Field List 
selection box. 

2. Click on the Add > button next to the Unique Field List or drag and 
drop the field name from the Field List. 

Repeat steps 1-2 to add other unique fields. 

Re-ranking Unique Order 
To re-rank the hierarchy of the fields on which you want to obtain unique results, in 
the Unique Field List selection box, click on the box to the left of the field you wish 
to move. A double, up and down arrow will appear on the box. Click on the box and 
hold down the left mouse button, drag the field to the unique position that will get 
you the results you desire. 

NOTE: You can also hold down the Ctrl key and use the up and down arrows on the 
keyboard.) 
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8: Saved Searches 

In this chapter you will learn about the Overview Tab, the system default and built-in 
searches, and how to save and retrieve your own customized searches. 

Overview Tab 

 
The Overview Tab provides a summary of all the components of the search that is 
highlighted in the Saved Searches box. It is also the area where you can save newly 
created searches or select and run previously saved searches. 

1. Saved Searches Box - Lists the System, Built-In and the Saved 
Searches available. 

2. Active Saved Search - The highlighted search is the currently active 
search that is ready to run as is by double-clicking or clicking the 
Proceed button or to edit by clicking on the Selection Criteria, Output 
Fields or Sort Order tabs. 

3. Sort Order Summary - Lists the order of the records in which the 
search results will appear for the search highlighted in the Saved 
Searches box. 
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4. Output Fields Summary - Provides an overview of the fields that will 
display in the Results Tab as a result of the search highlighted in the 
Saved Searches box. 

5. Save Search As Box - Displays the name of the Saved or System 
Search highlighted above in the Saved Searches box. This is also the 
space where you type the name of any new saved search. 

6. Selection Criteria Summary - Summarizes the criteria set for the 
search highlighted above in the Saved Searches box. 

7. Unique Field List Summary - Provides you with an overview of the 
field(s) on which the selected search will provide unique results. 

8. Proceed Button - Click this button to execute the highlighted search in 
the Saved Searches box. 

9. Save Button - Click this button once you have typed in a name for a 
new saved search in the “Save Search As” box or have edited an 
existing search that you wish to revise for future use. 

10. Delete Button - Clicking this button will permanently remove the 
saved search highlighted in the Saved Searches box. 

11. Cancel Button - Clicking this button will exit you from the Selection 
Set windows. 

System Searches 

 
There are two default system searches. The three dots in the name tell MEDIA 
Access Pro™ that these are system searches and, while they can be modified, they 
cannot be deleted. 

…Default Selection 

The Default Selection Search stores the values that will be used by default, until you 
change them by creating your own selection criteria, a sort order, unique field 
options, and output fields. For the Radio and Television databases, it provides the 
default sort order of CALLS and approximately 50 output fields that represent a 
summary of the station, its market and owner. For the Newspaper database, it 
provides the default sort order of Newspaper Name and approximately 20 of the 
more popular output fields. 

…Last Selection 

Stores the values used in your last search, even if you have since left the program. To 
rerun this search as is, double click on Last Selection in the Saved Searches box. To 
modify this search click once on Last Selection and then click on either the Selection 
Criteria, Sort Order or Output Fields tab and make the necessary changes to your 
search to get the results you desire. Click on Proceed when you are ready to run it 
again. 
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Built-in Searches (Analyzer Only) 
BIAfn’s MEDIA Access Pro™ has added the following built-in searches for your use 
to run as is or to modify to achieve your desired results. 

• Arbitron (or Nielsen) Markets (Radio & TV) - Results in a unique 
list of the Radio or Television rated markets and corresponding market 
statistics.  

• Comparable Sales - A sample search that can be modified to provide 
you with a list of the comparable station or newspaper acquisition 
transactions that meet your specific criteria. 

• Distance Sample Search (Radio & TV Only) - Allows you to find all 
the stations within a specified radius of either a designated station or 
using a latitude and longitude locator. The default results include the 
technical facilities of the station, market and owner data. 

• FCC Geographic Market Stations  (Radio Only) Provides a list of 
all the stations that are home to a particular market rank plus all stations 
that are physically located in one of the counties in the market but are 
home to another market according to the Arbitron definition. This 
includes non commercial stations as well as the commercial stations. 
The FCC Geographic Market Definition Report was designed to 
complement this saved search. 

• Highest Billing Stations (Newspapers) - This search will give you a 
list from the highest billing to the lowest billing stations based on 
stations with revenues of more than $20 Million (Radio) or $50 Million 
(TV) and Newspapers of more than $50 Million. The results include the 
estimated revenues and other performance statistics; CALL letters or 
paper name; format (Radio), affiliation (TV), or publishing frequency 
(Newspaper); market identifiers; and owner. 

• Mailing Labels - Owners (Newspapers / Stations) - A sample search 
that provides you with mailing list information for the Owner Main 
Contact, Newspaper Publisher, or Station General Manager.  

• Newspaper Owners that Also Own Radio (Television) - Provides a 
list of those newspaper owners that also own radio and/or television 
entities and includes the statistical fields for their total newspaper 
holdings. 

• Newspapers by DMA® (MSA) - Compiles a list of all the newspapers 
sorted by Nielsen DMA® Television rank or Arbitron Radio MSA rank 
and includes important supporting newspaper and market statistical 
fields. 

• Newspapers Ranked by Daily Circ. Revenue (Daily Circulation / 
Sunday Circulation / Total Est. Revenue) - Provides a ranked list of 
newspapers by the various categories. 

• Owners Ranked by # Stations (Newspapers) - Results from this 
search rank Owners from the highest to lowest number of total stations 
or newspapers owned. Types of data output include number of stations 
or newspapers, estimated owner revenues, number of markets covered 
by the owner, a stock symbol (if applicable), and the owner’s parent 
company (if applicable). 
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• Parents Ranked by # Stations (Radio & TV Only)- Results from this 
search rank Parent Owners from the highest to lowest number of total 
stations owned. Types of data output include number of stations, 
estimated parent owner revenues, number of markets covered by the 
parent, and a stock symbol (if applicable). 

• Top 50 Owners by Revenue - Ranks the Top 50 owners by highest 
revenue. Resulting data includes BIA Revenue Rank, owner company 
name, estimated owner revenues, number of stations or newspapers 
owned, number of markets covered by the owner, a stock symbol (if 
applicable), and the owner’s parent company (if applicable). 

• Top 50 Parent Owners by Revenue - Results from this search rank 
Parent Owners from the highest to lowest total estimated revenues. 
Types of data output include Parent Owners name, number of stations 
or newspapers operated, estimated parent owner revenues, number of 
markets covered by the parent, and a stock symbol (if applicable). 

Saved Searches 
MEDIA Access Pro™ gives you the ability to save searches making it easy to edit 
and rerun them in the future. 

The Saved Searches Screen button takes you directly to the Overview Tab of the 
Selection Set screens. This is where you can view a summary of all the components 
of each of your saved searches as well as the two default searches. 

Saving a Search 
1. After running a successful search that you would like to save, click on 

the Saved Searches Button. This will take you to the Overview Tab on 
the Selection Set screen. In the Saved Searches box, “...Last Selection” 
should be highlighted and in the other boxes you should see a summary 
of all the aspects of the search you just ran and wish to save. 

2. In the Save Search As space, type in the descriptive name you wish to 
assign to the search. 

3. Click on the Save Button. 

4. Click on Yes to the question, “Do you want to add the set...?” 

5. MEDIA Access Pro™ will rerun the search and bring up your results 
on the Results Tab. The Saved Search will now be included in 
alphabetical order in the list of Saved Searches on the Overview Tab. 

Running a Saved Search 
1. Click on the Saved Searches Button to open the Overview Tab in the 

Selection Set screen. 

2. In the Saved Searches box, click on the desired search. 

3. Review the Selection Criteria, Sort Order, Unique Field List, and 
Output Fields to verify that they still meet your needs. If yes, click on 
the Proceed Button. If no, click on the Selection Criteria Tab to edit the 
search. 
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4. Using the Change Button, Delete Button, or ADD Button, modify the 
selection criteria to get the results you desire. 

5. Click on the Proceed Button to run the revised Saved Search. 

6. If you wish to save the newly revised search, follow the steps above for 
Saving a Search and click on Yes when asked “Do you want to 
overwrite the set ...?”. 

Modifying a Saved Search 
1. Click on the Saved Searches Button to open the Overview Tab in the 

Selection Set screen. 

2. In the Saved Searches box, click on the search you wish to modify and 
review the Selection Criteria, Sort Order, Unique Field List, and Output 
Fields. 

3. To modify the Criteria, with the subject sample search highlighted, 
click on the Selection Criteria tab and using the Change Button, Delete 
Button, or ADD Button, modify the selection criteria to get the results 
you desire. 

4. To modify the Output Fields, click on the Output Fields tab and add, 
delete or adjust the placement of the fields you wish to view in your 
results. 

5. To modify the Sort Order or Unique Field List, click on the Sort Order 
tab and add, delete, or adjust the order of the fields on which you want 
to sort or from which you want to obtain unique results. 

6. Click on the Proceed Button to run the modified Saved Search. 

7. If you wish to save the newly modified search, either give it a new 
name in the Saved Search As box and clicking Save, or overwriting the 
existing search by clicking on Save and then clicking on Yes when 
asked “Do you want to overwrite the set ...?”. 

Loading a Saved Search to the Network 
BIAfn’s MEDIA Access Pro™ allows network users to create custom saved searches 
and share the searches network-wide with their colleagues. Follow these simple 
instructions. 

1. In the Saved Searches box on the Overview Tab of the Selection Set 
screens, right click on the custom saved search you wish to incorporate 
in the network wide Saved Searches selection list. 

2. Click on the Yes button when prompted “Would you like to make this 
search public so that other users on the network will be able to run it 
the next time they start MEDIA Access Pro™?” 

When your colleagues next start up MEDIA Access Pro™ on their computers, they 
will find the custom search you saved in their list of Saved Searches. 
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9: Printing 

This chapter provides information on Printer Setup;  printing custom reports, mailing 
labels and coverage maps; as well as creating your own customized mailing label 
formats. 

Printer Setup 

When printing using any of the Print Screen buttons , MEDIA Access Pro™ 
uses the default printer set in your Windows control panel. 

To change your default printing destination or other printing properties, click on the 
Windows Start button > Settings > Printers, and select the new default printer or 
change the properties. For more information, consult your Windows Help. 

To print to another printer without changing your default printer in Windows, access 
the Print dialog box by clicking on the Print button on the bottom of the Reports 
Options or Mailing Label Options boxes. Then, from the drop down menu next to 
Name, click on the destination printer you desire. Click on the Properties button to 
adjust any of the printing properties (i.e., Landscape or Portrait, etc.) necessary to 
create your desired results and click on OK. Click on OK again in the Print dialog 
box and your document should be produced by the target printer you designated. 

NOTE: When printing to Adobe Acrobat  to create a PDF file, the system may 
require that you save the file to the \BIADATA\MASTER directory. It is suggested 
that you save the file to this directory and then move it to the desired directory. 

Printing Reports 
Below are quick, step-by-step instructions for printing a custom report from MEDIA 
Access Pro™. For more information regarding the individual Custom Reports 
available or how to create your own customized built-in reports, see section on 
Custom Reports. 

1. Select Print from the menu bar at the top of MEDIA Access Pro™. 

2. Click on Custom Reports and the Report Options screen will appear. 

3. Click on the Custom Report of your choice from the scroll list. 

4. Under Report Description you will see the title of the report as it will 
print. You can add a Report Subtitle by typing it in the space 
provided. 
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5. Click on the Preview button for a view of what the report will look like 
when it’s printed.  

6. If you have selected a Contacts Report, you will need to click on the 
button next to position title that you would like the report to include. 

7. To print the report press the print button in the Print Preview Toolbar. 
The report will print to the printer you have designated as your default 
printer in your Windows setup. For more information, see Printer 
Setup earlier in this section. 

Print Preview 

 
MEDIA Access Pro™ allows you to preview your print jobs before they go to the 
printer through the Print Preview. 

After selecting a Custom Report or Mailing Label format to print, press the 
Preview button to see how your printed page will appear. The following toolbar will 
be displayed on top of your previewed document. 

1. First Page - Views the very first page in a print job. 

2. Previous Page - Views the previous page. 

3. Go to Page - Allows you to go directly to the page number in the print 
job that you indicate. 

4. Next Page - Takes you to the next page in the print preview. 

5. Last Page - Takes you to the very last page in the print job. 

6. Zoom View - Allows you to adjust the zoom level of the screen 
preview. 

7. Close Preview - Clicking this button closes down the Print Preview 
function. 

8. Close Toolbar - Click on this X to remove the toolbar from the screen 
view. 

9. Print - Sends job to the designated Windows default printer. 

Mailing Labels 

Mailing Label Overview 
BIAfn’s MEDIA Access Pro™ makes it very easy for you to print your results to the 
more popular Avery brand labels. With a base knowledge of FoxPro Report 
Designer, you can also create your own custom label formats. If you prefer, BIAfn 
also offers Custom Report design services. Call your Customer Support Executive 
for more information. 
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NOTE: The Mailing Label print function automatically deletes duplicates. 
MEDIA Access Pro™ has a built-in feature to print only one mailing label per 
contact name at the same address.  

Printing Labels 
The following provides quick and easy instructions for printing labels using one of 
the pre-defined Avery label formats built-in to MEDIA Access Pro™. 

1. After you have received your search results successfully in the Results 
screen, click on the Print menu. 

2. Click on Mailing Labels. You’ll receive the Label Options Screen.  

3. Click on any of the six built-in Avery brand label formats.  

4. Click the button next to either Station (or Newspaper), Owner, or 
Parent. 

5. From the Contact Type drop down box, click on the job classification 
of the personnel you want to reach.  

6. Press Preview to see how the labels will look. 

7. Make sure your printer has the correct label stock loaded, and press on 

the print   button in the Print Preview Toolbar. 

Modifying or Creating New Label Formats 

 
You can modify an existing label format to add an identifying code or to create a 
whole new label format based on an existing label.  

1. Label Type - Click on the standard Avery label type that meets your 
needs.  

2. Labels for - Click on the button next to the category of personnel for 
which you wish to print labels (Station or Newspaper, Owner or Parent 
Company). 
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3. Contact Type - From this drop down box, select the title of the 
personnel for which you wish to direct your mailing. 

4. Label Sort Order - Select the preferred sorting level here--either Zip 
Code order (default), or the order of your search results (None). 

5. Label Selection Name - The name of the currently selected label 
appears here. To modify or create a new label, type in a new name, 
label dimensions, and number of columns on a label sheet. 

6. Preview Button - This button allows you to see how your labels will 
look when they are printed.  

7. Print Button - Click on this button when you are ready to send your 
document to the printer. Remember to place correct paper or label stock 
in your printer. 

8. Modify Button - With this button you can create your own customized 
label formats by modifying an existing label and saving it with a new 
name, label dimensions, and column count. Requires some knowledge 
of FoxPro Report Designer. 

9. Delete Button - Clicking this button allows you to delete a label format 
from the selection list. Click on the label format and click on Delete. 

10. Cancel Button - Clicking on the Cancel Button will cancel any 
selections and close the screen. 

Step-by-step Instructions for Customizing Labels 
1. From the Label Options Screen select the built-in Avery label format 

that most closely duplicates your new format requirements. 

2. In the Label Selection Name space, type in a new label name, the label 
dimensions, and number of columns on your label page. 

3. Click on the Modify button. 

4. Answer Yes to the create-new-label question. This will open up the 
FoxPro Report Designer and the existing label format. 

5. Make any modifications necessary to the label, including inserting an 
identifying code, by using the FoxPro Report Designer tools. 

NOTE: Consult the FoxPro User Manual for any further help in modifying and 
creating reports. 

Deleting Mailing Label Formats 
The following provides instructions for deleting unwanted label formats, either built-
in or customized, from the list of possible label formats from the Label Types on the 
Label Options screen. 

1. From the Label Options Screen select the label format that you wish to 
remove from the list. 

2. Click on the Delete button. 

3. Answer Yes to the “are you sure you want to delete” question. This will 
remove the label format from the options list. 
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Coverage Maps Printing 
The following instructions give you a quick overview on printing a coverage map 
you have generated through the BIAMapX™ Coverage Maps module. For more 
information on Maps see section on Coverage Maps. 

1. With the map drawn to your liking in the screen view of the 
BIAMapX™ Viewer, click on the File menu. 

2. Click on Print Preview to see a sample of how your map will look 
when printed. If you are printing to a color printer, the preview map 
will appear in color, as will your printed map. If your printer provides 
black ink only, then the preview will be in black and white, as will your 
printed map. 

3. Click on the Print... button in the upper left corner of the Preview 
screen and a print dialog box will appear.  

4. Click on OK to print the map. 
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10: Custom Reports 

This chapter reviews the built-in custom reports available with MEDIA Access 
Pro™. 

Custom Reports Overview 
BIAfn has built in several powerful custom reports for you to use.  Depending on the 
features for which you are licensed, you will see a list of 10 to 25 built-in reports 
from which to choose. With a knowledge of FoxPro and its report writing features, 
you can also create your own customized reports to use over and over again. See 
section on Customizable Features for help in creating your own reports. 

Custom Report Descriptions 
Below is a table listing the types of custom reports built into MEDIA Access Pro™ 
and the industry databases in which each report is available.  
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Analysis Report 
The Analysis Report provides you with a quick overview of the technical, 
operational and transactional information for the stations found in your search 
results. 

• Call Letters or Newspaper Name 

• City of License or Publication 

• State of License or Publication 

• Power (Radio & TV) or Number Days/Week Published (Newspaper) 

• Night Power (Radio, if applicable) 

• HAAT (Radio) or Antenna Height (TV) 

• Antenna Polar (TV Only) 

• Frequency (Radio) or Channel (TV) 

• FCC Station Class (Radio) or Type (TV) 

• Date Station or Newspaper was Last Acquired (YY/MM) 

• Station or Newspaper Sales Price (in thousands) 
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• Price Code 

• Combo Code 

• LMA Code (Radio & TV)  

• Duopoly or JOA 

• Format (Radio) or Affiliation (TV) 

• National Sales Rep (TV Only) 

• Nielsen Total Day Shares (for last 8 books - TV Only) or 12+ Arbitron 
Total Day Share (for last ratings period - Radio Only) 

• Estimated Station Revenues (Radio & TV) or Advertising and 
Circulation Revenues (Newspaper) 

• Power Ratio (TV Only) 

• Local Commercial Share (TV Only) or Daily and Sunday Circulation 
Estimates (Newspaper) 

Comparable Sales Report 
The Comparable Sales Report provides you with a comparison of the station or 
newspaper sales transactions in markets of comparable size, technical facilities and 
operational performance. 

HINT:  You will want to do a specific search first. BIAfn offers a built-in saved 
search for Comparable Sales which you can easily modify to your specifications. 
From the Overview Tab, click on the Comparable Sales saved search in the Saved 
Searches box. Then click on either the Selection Criteria, Sort Order, or Output 
Fields tabs to make your necessary changes to the search to receive the results you 
desire. 

IMPORTANT NOTE: Keep the following aspects in mind when formulating your 
selection criteria in order to return the most meaningful results from your 
Comparable Sales Report. 

• Pick a range of markets of comparable size, usually the 5 markets 
ranked above and below the market in which the subject station or 
newspaper is located (e.g., “Market Rank is between 10;20” when 
subject station or newspaper  is in Market #15). 

• Select the comparable technical indicators such as AM or FM; Class A, 
B, or C (Radio); UHF or VHF (TV Type); and possibly the a 
transmitting power range. 

• Set comparable operational indicators such as format (Radio) or 
affiliation (TV), a ratings range or circulation level, estimated station or 
newspaper revenue range, or power ratio. 

• Look for trading parameters such as not earlier than a certain time 
period or a price in a specific range. 

Contact Print Screen 
The Contact Print Screen Report allows you to print a replica of the data found on 
the Contacts Tab of the Station or Paper Information Screens for every record in 
your search results. 
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You can also print the Contact Print Screen Report directly from the Contacts Tab by 
clicking on the Print Screen Button found in the bottom right corner of the Tab. The 
report generated will only profile the station contact information for the station or 
newspaper which is currently shown on your screen. 

Contacts Report 
This report lists basic contact information for the various key positions profiled at a 
newspaper or radio or television station: 

• Call Letters or Newspaper Name 

• Name of Contact for Position Selected 

• Address, City, State, Zip 

• Phone 

NOTE: Through the Custom Reports, you can only print a report for one position 
title at a time. Before you can print or preview, you will be required to select the 
position title you desire. If you require a report with combined position contacts, 
select exactly the fields you need for your report on the Output Fields tab of the 
Selection Criteria screen and export the data to a spreadsheet or word processing 
program.  

Data Download Report 
When you can’t find a report that has everything you need, these reports print 
whatever fields you have selected in the Output Fields directly to your printer. 
These reports lack the formatting and attractive look of the other reports, but they do 
let you get the information out of MEDIA Access Pro™ and onto paper. 

It is very important that you select just the fields you want to print from the Output 
Fields screen before you run any of these reports. All Data Download reports print 
the data for each record in your search and just the fields selected from the Output 
Fields screen. If you have too many fields selected, the station information will wrap 
to the next line. It will still be readable, but much more difficult to use. For best 
results, use the report page orientation option that keeps all station information on 
the same line. 

• Portrait Regular - Portrait (tall) report with a normal font. Use this 
report if you only have a few fields selected. 

• Portrait Compressed - Uses a compressed font to squeeze more 
information on each line. 

• Landscape Regular - Turns the paper sideways to give more room to 
print each line with a normal font. 

• Landscape Compressed - Sideways and compressed (smaller) font. 
This report gets the most information on each line. 

NOTE: If you still do not receive the visual results you desire, try exporting the data 
to your favorite spreadsheet or word processing program and use the formatting 
features available there. See the section on Exporting Data. 
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Daypart Share Report (Television Only) 
The Daypart Share Report for Television provides you with an overview of the last 
four Nielsen ratings periods for each station in your search results. The following 
dayparts are covered in this report: 

• Early Morning 

• Mid-Morning 

• Afternoon 

• Early Fringe 

• Evening News 

• Prime Time 

• Night News 

• Late Night 

NOTE: If a rating period is blank, it means that a station received less than a one 
share for that time slot. 

FCC Geographic Market Definition Report 
This Radio report lists all the stations that are home to a particular market rank plus 
all stations that are physically located in one of the counties in the market but are 
home to another market according to Arbitron definition. This includes non 
commercial stations as well as the commercial stations. 

NOTE: You must first run the FCC Geographic Market Stations under Saved 
Searches in Radio in order to access this report. 

Data in this report includes: 

• CALL Letters 

• AM or FM 

• Frequency 

• Type Station (C=Commercial; NC = Non-commercial) 

• Format 

• Home Market 

• Home Market Rank 

• Owner Name 

• City and State of License 

• County of License 

Field Name Conversion List Report 
Due to limitations inherent in databases for field naming conventions and other 
changes with the timing and programming of MEDIA Access Pro™, BIAfn assigns 
aliases to the database named fields making them more readily understandable. 
When you export data, however, the sometimes cryptic database field names are 
exported with the data. Unless you know the aliases assigned to these field names, it 
can be confusing. This report provides you with a list of the field name aliases that 
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are associated with the program database field names assigned by BIAfn. Therefore, 
to help you track exactly what you are exporting, it is highly suggested that you print 
this report for your reference. 

NOTE: When you export data, MEDIA Access Pro™ will automatically give you 
the option of printing or saving a Field List Report, which is the same as the Field 
Name Conversion report found in Custom Reports. 

“Investing in®...” Page Reports (Radio & TV Only) 

MEDIA Access Pro™ allows you to print a replica of the various pages found in 
BIAfn’s “Investing in®” publications for Radio or Television. The information found 
on these pages will be current as of the date of your last data update, and, therefore 
may not necessarily duplicate what is in BIAfn’s published editions of the books. See 
Appendix D for a detailed description of the data found on these pages. 

Radio Market Page - Duplicates the layout and provides current 
market data for the Arbitron-rated Radio markets in the U.S. found in 
BIAfn’s Investing in Radio Market Report. 

Radio Competitive Page - Profiles the radio competition in the 
Arbitron-rated markets of the U.S. duplicating the layout in BIAfn’s 
Investing in Radio Market Report. 

TV Ratings Overview -  Duplicates the layout and provides current 
market data for the Nielsen-rated TV markets in the U.S. found in 
BIAfn’s Investing in Television Market Report. 

TV Competitive Overview - Profiles the TV competition in the 
Nielsen-rated markets of the U.S. duplicating the layout in BIAfn’s 
Investing in Television Market Report. 

Ownership File - Provides an overview of all the stations held by the 
owners profiled in your search results. This report duplicates the layout 
found in BIAfn’s Investing in Radio (Television) Ownership File. 

Market #1 Print Screen 
The Market #1 Print Screen Report allows you to print a replica of the data found on 
the Market #1 Tab of the Station Information or Newspaper Information 
Screens for every record in your search results. 

You can also print the Market #1 Print Screen Report directly from the Market #1 
Tab by clicking on the Print Screen Button found in the bottom right corner of the 
Tab. The report generated will only include the market data for the station or 
newspaper which is currently shown on your screen. 

Market #2 Print Screen 
This Market #2 Print Screen Report allows you to print a replica of the data found on 
the Market #2 Tab of the Station Information and Newspaper Information 
Screens for every record in your search results. 

You can also print the Market #2 Print Screen Report directly from the Market #2 
Tab by clicking on the Print Screen Button found in the bottom right corner of the 
Tab. The report generated will only include the market data for the station or 
newspaper which is currently shown on your screen. 
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Market #3 Print Screen (Television Only) 
This Market #3 Print Screen Report allows you to print a replica of the data found on 
the Market #3 Tab of the Station Information Screen for every record in your 
search results. 

You can also print the Market #3 Print Screen Report directly from the Market #3 
Tab by clicking on the Print Screen Button found in the bottom right corner of the 
Tab. The report generated will only include the market data for the station which is 
currently shown on your screen. 

Market Demographic Report 
The Market Demographic Report provides you with the critical demographic 
statistics necessary to analyze an individual market or to compare markets. 
Information includes: 

• Market Name 

• Market Rank 

• Population (in thousands) 

• Projected Population (Pop) Growth Percentage 

• Number of Households (in thousands) 

• Projected Household (HH) Growth Percentage 

• Total Estimated Retail Sales (in millions) 

• Projected Retail Sales (RS) Growth Percentage 

• Total Estimated Effective Buying Income (in millions) 

• Projected Effective Buying Income (EBI) Growth Percentage 

• Per Capita Income  

• Median Effective Buying Income 

• Average Household Effective Buying Income 

• Percentage of White, Black, Asian, and Spanish-Speaking Population 

Market Financial Report 
The Market Financial Report provides you with the critical financial benchmarks 
necessary to analyze an individual market or to compare markets. Information 
includes: 

• Market Name 

• Market Rank 

• Market Revenue Rank 

• Number of Entities in the Market  

• Estimated Historic and Projected Revenue Growth Rates 

• VCR Market Penetration Percentage (TV) 

• Households 
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• Cable Market Penetration Percentage 

• Number of Counties in the Market  

• Estimated Historic, Present, and Projected Market Revenues (in 
thousands) 

Market Map 
This report gives you a map of the Arbitron Radio MSA or Nielsen Television 
DMA®. This is the same map report that is accessible from the Market screens 
found in the Station Information screens of either the Radio and Television 
databases. 

Market Ranker Report 
This powerful report is available only if you are a licensed user of either BIAfn’s 
Radio Rankers or Radio Ratings feature. The Market Ranker Report provides a 
ranking of the radio stations in a market based on their Average Quarter Hour 
Arbitron shares for either men, women or total persons in various age groups and 
popular dayparts. See the list below for the breakdown. 

The report also compares the stations rankings for the current ratings period to the 
last ratings period and indicates any change in ranking. 

Age and Time Periods Covered: 

• 12+ 

• Teens 

• 18-24 

• 18-34 

• 18-49 

• 25-34 

• 25-49 

• 25-54 

• 35-44 

• Morning Drive Time 

• Mid-Day 

• Evening Drive Time 

Market Share Report 
The Market Share Report for Television provides you with an overview of the 
Nielsen shares returned in the market from Local Viewing (L), Households Using 
Televisions (H or HUT), and Adjacent Stations (A) from outside the defined market. 
The report profiles the past four ratings periods broken down by the critical dayparts, 
including 

• Early Morning 

• Mid-Day 
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• Afternoon 

• Early Fringe 

• Evening News 

• Prime Time 

• Night News 

• Late Night 

Newspaper Analyzer Print Screen 
This Newspaper Analyzer Print Screen Report allows you to print a replica of the 
data found on the Newspaper Tab of the Newspaper Information Screen for every 
record in your search results. 

You can also print the Newspaper Analyzer Print Screen Report directly from the 
Newspaper Tab by clicking on the Print Screen Button found in the bottom right 
corner of the Tab. The report generated will only profile the newspaper information 
for the station which is currently shown on your screen. 

Newspaper Competitive Overview 
The Newspaper Competitive Overview Report provides you with a comparison of 
the newspapers found in your search results. Each market is presented on a separate 
page. 

Data points included are: 

• Newspaper Name 

• City of Publication 

• State of Publication 

• Home County of Publication 

• Number of Days Per Week Published 

• JOA Indicator 

• Owner’s Name 

• Date Newspaper Acquired by Current Owner 

• Sales Price in Thousands ($000s) 

• Estimated Current Daily Circulation 

• Estimated Current Sunday Circulation 

• Estimated Total Revenues for the Most Current Year Available 

Owner Ratings History (Radio) 
Organized by market and then grouped and totaled by owners within each market, 
the Owner Ratings History Report provides you with a quick Arbitron 12+ total day 
share performance history for the owners selected in your search results. It portrays 
the last five ratings periods and tracks the corresponding format being aired during 
that period. 

Data points included are: 
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• Market Rank 

• Market Name 

• Popular name of the licensed owner 

• Arbitron 12+ Total Day Shares for the last five ratings periods 

• Shares totaled by Owner for each market 

• Corresponding formats for each ratings period 

• Station ranking based on its 12+ share for the most recent ratings 
period 

Owners Print Screen 
This Owners Print Screen Report allows you to print a replica of the data found on 
the Owners Tab of the Station Information or Newspaper Information Screens 
for every record in your search results. 

You can also print the Owners Print Screen Report directly from the Owners Tab by 
clicking on the Print Screen Button found in the bottom right corner of the Tab. The 
report generated will only profile the owner information for the station or newspaper 
which is currently shown on your screen. 

Owners Report 
This Owners Report lists basic summary contact information for the primary 
executives  of the owners or parent companies of the stations or newspapers in your 
search results: 

• Call Letters or Newspaper Name 

• Proposed Code (if a “p” shows, the owner named is the proposed owner 
- deal has not yet closed) 

• Owner or Parent Company Name 

• Owner’s or Parent’s Contact Name for the position you selected 

• Selected Contact’s Address, City, State and Zip 

• Phone Number 

• Fax Number 

NOTE: Through the Custom Reports, you can only print a report for one position 
title at a time. Before you can print or preview, you will be required to select the 
position title you desire. If you require a report with combined position contacts, 
select exactly the fields you need for your report on the Output Fields tab of the 
Selection Criteria screen and export the data to a spreadsheet or word processing 
program.  

Parent Contacts Print Screen 
The Parent Contacts Print Screen report provides a replica of the data found in the 
Parent view of the Owners tab.  It can also be accessed directly from the Parent view 
of the Owners tab in the Station Information and Newspaper Information screens.  
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Rankers Print Screen 
This Radio Rankers Print Screen Report allows you to print a replica of the data 
found on the Radio Rankers Tab of the Station Information Screen for every 
record in your search results. 

You can also print the Radio Rankers Print Screen Report directly from the Radio 
Rankers Tab by clicking on the Print Screen Button found in the bottom right corner 
of the Tab.  The report generated will only profile the Rankers information for the 
station which is currently shown on your screen. 

Ratings History Report for Radio 
The Ratings Report allows you to compare the listening performance of the 
Arbitron-rated stations in your search results. The following information is included: 

• Call Letters 

• Market Name 

• Market Rank 

• Specific Station Format 

• Number of Books Station is Rated Each Year 

• Station Arbitron Shares for the Last 16 Ratings Periods 

NOTE:  If a rating period is blank, it means that a station either received less than a 
0.1 share for that ratings period, or if the rating period is blank for every station in 
that specific market, it is possible that the Arbitron ratings for that market have not 
yet been released for that ratings period. 

Ratings Print Screen 
This Radio Ratings Print Screen Report is available only to Expanded Radio Ratings 
feature subscribers and allows you to print a replica of the data found on the Radio 
Ratings Tab of the Station Information Screen for every record in your search 
results. 

You can also print the Radio Ratings Print Screen Report directly from the Radio 
Ratings Tab by clicking on the Print Screen Button found in the bottom right corner 
of the Tab.  The report generated will only profile the Ratings information for the 
station which is currently shown on your screen. 

Station Print Screen 
This Station Print Screen Report allows you to print a replica of the data found on 
the Station Tab of the Station Information Screen for every record in your search 
results. 

You can also print the Station Print Screen Report directly from the Station Tab by 
clicking on the Print Screen Button found in the bottom right corner of the Tab. The 
report generated will only profile the station information for the station which is 
currently shown on your screen. 
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Summary  Report 
The Summary Report lists the following basic summary information for the stations 
or newspapers in your search results: 

• Market Rank (if applicable) 

• Market Name (if applicable) 

• Station Call Letters or Newspaper Name 

• Frequency (Radio) or Channel (TV) 

• Format (Radio) or Affiliation (TV) or Number of Days/Week Published 
(Newspaper) 

• Address, City, State, Zip 

Technical Reports (Radio & TV) 

MEDIA Access Pro™ Technical Reports list the following basic technical 
information for the stations in your search results: 

• Call Letters  

• City of License  

• State of License  

• Affiliation (TV)  

• FCC Station Class (Radio) or Station Type (TV) 

• Power (Radio and TV) 

• Nighttime Power (if applicable for Radio) 

• HAAT (Radio) or Tower Height (TV)) 

• Frequency (Radio) or Channel (TV) 

• Latitude and Longitude (TV) 

• Polarization (TV) 

Transaction Print Screen 
This Transaction Print Screen Report allows you to print a replica of the data found 
on the Transaction Tab of the Station Information and Newspaper Information 
Screens for every record in your search results. 

You can also print the Transaction Print Screen Report directly from the Transaction 
Tab by clicking on the Print Screen Button found in the bottom right corner of the 
Tab. The report generated will only profile the transaction information for the station  
or newspaper which is currently shown on your screen. 

User Notes/Comments Report 
The User Notes/Comments Report allows you to print out the Network and Local 
Comments you have entered for the stations or newspapers in your search results. 
Fields profiled include: 

• Call Letters or Newspaper Name 
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• Frequency (Radio) or Channel (TV) 

• Custom Flag (prints “Yes” if flagged) 

• Network Comments, if any (first 20 characters of this field are 
displayed on the report) 

• Local Comments, if any 
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11: Exporting Data 

This chapter provides you with instructions on how to export data from MEDIA 
Access Pro™ for import into other databases, spreadsheet and word processing 
programs. 

Exporting Data Overview 
MEDIA Access Pro™ gives you the powerful capabilities of exporting data to nearly 
any type of program. Exporting features for some of the more popular programs are 
built into MEDIA Access Pro™ (see below). Follow the simple instructions below to 
export your search results. 

1. After completing your search and receiving the results you desired, 
click on the Export menu. 

2. Click on the program or file format to which you wish to export 
(Delimited ASCII, Microsoft Excel, etc.). 

3. In the Windows Save As box, select the appropriate directory and 
folder to place your exported file. 

4. Type in a File Name in the space provided. NOTE: No file extension is 
necessary (i.e., .xls, .dbf, etc.). MEDIA Access Pro™ will 
automatically assign a file extension based on the export format you 
selected. 

5. Click on the Save button. 

6. MEDIA Access Pro™ will rerun the search and an Export Field List 
request box will appear. Click on either Preview, Print or No Report, 
depending on your preference. Entering a Report Title is optional. 

7. An export file has now been created in the directory and folder to 
which you assigned it.  

See each export type for more information and any special conditions that can be 
expected. 

Delimited ASCII (.txt) 
Delimited ASCII is the most generic export type. While there is usually no header or 
formatting information, just raw data with each field separated by commas, MEDIA 
Access Pro™ provides the option of  placing a header row in your text file. Just click 
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on “Yes” when prompted, “Include field names in line 1 of the export file?” Text 
information will have quotation marks at the beginning and end of each field, 
numeric information will not have quotes around it. It is highly suggested that you 
print out a Field List Report to help identify the fields of data you are exporting as 
the database fieldnames that are exported are sometimes cryptic. 

The data file looks something like this; 

“WAAA”,”AM”,”Washington, DC”,”123 Main 
Street”,”Columbia”,”MD”,”555-1234" 

“WBBB”,”FM”,”Youngstown”,”234 South 
Maple”,”Youngstown”,”OH”,”555-2345" 

“WCCC”,”FM”,”Riverside, CA”,”345 N. Erdman 
Ave”,”Springdale”,”CA”,”555-3456" 

This file type is useful to bring information into programs that do not read one of the 
other file formats. For example, Macintosh computers cannot read any file that was 
created on a PC, but they can open and import delimited ASCII files. Special 
databases, in-house proprietary programs, personal information managers (PIMs) 
and other unique programs can also use this format to exchange data. 

FoxPro DBF (.dbf) 
This is the native format for MEDIA Access Pro™ data. However, we pull 
information from several tables or databases and combine the results into what 
appears to be one simple list of information. You may want to create a new database 
containing just the information you want, without using multiple tables or 
complicated relationships. 

After exporting as a DBF file, the new flat file (non-relational) database table can be 
manipulated in any of the common PC databases like FoxPro, dBase, Access, 
Approach or any program that reads the industry standard .DBF format. Most 
Personal Information Managers (PIM) can also read this data format. 

NOTE: Notes or memo fields, such as Local Comments, Network Comments, and 
Deal Terms, will not export to a .dbf file. A memo field can be identified by the 
word Memo appearing in the field in the Results Tab on the Station Information 
Screen. See more information on Memo fields in the section on Database Basics. 
Memo fields are exportable to Microsoft Excel and Delimited ASCII. 

Lotus 123 (.wk1) 
Export the information you want to a Lotus spreadsheet file. The file format is a 
Lotus 1-2-3 version 2 file (WK1), which can be read by any later version of Lotus 1-
2-3. 

NOTE: Notes or memo fields, such as Local Comments, Network Comments, and 
Deal Terms, will not export to a Lotus file. A memo field can be identified by the 
word “Memo” appearing in the field in the Results Tab on the Station Information 
Screen. See more information on Memo fields in the section on Database Basics. If 
you must have this type of data in Lotus, first export your data to Microsoft Excel 
and convert that file to Lotus. 



 

MEDIA Access Pro™ Version 4.0 User Manual 11: Exporting Data  •  137 

Microsoft Excel (.xls) 
You can export the information you want to a Microsoft Excel version 1 file (*.xls) 
which can be read by any of the later versions of Excel. With an Excel file you can 
create Mail Merges using Word. 

Each time you create an Excel Export, MEDIA Access Pro™ will include in the 
same directory an additional file labeled HEADER.XLS that includes the descriptive 
field names of those fields you exported. 

System Data Format 
System Data Format is very similar to Delimited ASCII, but instead of commas 
between each field, each field starts in a new column. There is no header or 
formatting information, just raw data with each field separated by spaces so that each 
field starts in a new column. It is highly suggested that you print a Field List Report 
to help identify the information you are exporting. 

The system data format file looks something like this; 
WAAA AM Washington, DC 123 Main Street Columbia MD  

WBBB FM Youngstown 234 South Maple Youngstown OH  

WCCC FM Riverside, CA 345 N Erdman Ave Springdale CA  

This file type is useful to bring information into programs that do not read one of the 
other file formats. For example, Macintosh computers cannot read any file that was 
created on a PC, but they can open and import Delimited ASCII and System Data 
files. Special databases, in-house proprietary programs, personal information 
managers (PIM) and other unique programs can also use this format to exchange 
data. 

WP Mail Merge 
You can easily export the results of your search to a WordPerfect mail merge format 
file. This export creates an .SEC secondary file that is compatible with both older 
and newer versions of WordPerfect. This file can then be used from WordPerfect to 
create a set of merged letters, envelopes, labels or whatever you would like to 
produce from within that application.  

It is highly suggested that you print a Field List Report to help identify the 
information you are exporting. 

Field List Report 
Due to limitations inherent in databases for field naming conventions and other 
changes with the timing and programming of MEDIA Access Pro™, BIAfn assigns 
aliases to the database named fields hopefully making them more readily 
understandable. When you export data, however, the sometimes cryptic database 
field names are exported with the data. Unless you know the aliases assigned to these 
database field names, it can be confusing.  

When you select an export type from the Export menu, you will receive a dialog 
request box providing you the opportunity to print the Field List Report. 
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Through this box you can 

• assign a customized title to the report by positioning your cursor in the 
box and typing the desired text; 

• preview the report before printing by clicking “Preview”; 

• click “Print” and send the report directly to your Windows default 
printer; or 

• bypass the Export Field List Report altogether by clicking on the “No 
Report” button. 

NOTE: The Field List Report is also available through Print > Custom Reports and 
will provide you with the field list information based on the output fields selected in 
the most current search. 

The Field List Report, a sample of which appears below, provides you with a list of 
the field name aliases that are associated with the program database field names 
assigned by BIAfn. Therefore, to help you track exactly what you are exporting, it is 
highly suggested that you print this report for your reference. 

Sample Field List Report 

 
 

MEDIA Access Pro™ Name displays the Field Name Aliases assigned by BIAfn 
to make the database field names more understandable. 

Table Reference refers to the name of the MEDIA Access Pro™ database file 
wherein this field resides. 

Fieldname gives you the database field name, the sometimes cryptic references 
understandable only to the programmers of MEDIA Access Pro™. 
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12: Customizable Features 

This chapter explains how to create Custom Contact Records, Custom Reports and 
how to use Custom and Search Flags, the Calendar/Diary, Last Call, Call Back, 
Network Comments, and Local Comments. 

Custom Contact Records 

Custom Contacts 
In addition to the personnel tracked and updated by BIAfn, MEDIA Access Pro™ 
allows you to enter data, search, print and export into two (2) personally 
customizable fields found on the Contacts Tab. This information is never overwritten 
by data updates.  

NOTE: these fields assume that your contact is located at the same address as the 
personnel BIAfn tracks. 

 
To use, click in the yellow-highlighted fields located in the lower right hand corner 
of the screen typing the first name, last name, and title into each field separately. 
This data is then saved in the user files on your network or, in the case of a stand 
alone installation on the hard drive of your computer.  

To search for this information select one of the fields named “Custom 1” or “Custom 
2.”  

HINT: For best results limit the type of contact that you put into each 
field (e.g., Custom 1 = Regional Manager and Custom 2 = Traffic 
Director). This will make it easier for you in creating searches by 
personnel type on which to do mailings. 
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Custom Owner or Parent Contacts 
In addition to customizing station contacts, you also have the option of tracking two 
(2) personalized contacts at the owner and parent company levels. This information 
is never overwritten by data updates. NOTE: Unlike the station contacts, these 
custom contacts require that you type in a mailing and physical address, phone, fax 
and e-mail.  

To enter data, follow these steps: 

1. Search for and select the owner for which you wish to record a custom 
contact.  

NOTE: Data entered for an Owner in one record will be reflected for 
all the stations owned by that owner. 

2. Click on the Owners Tab. 

3. Click on the down arrow next to Positions on the upper far right corner 
of the Owners Tab and select either Custom 1 or Custom 2. 

 
4. Click in the yellow-highlighted fields and enter the appropriate 

information, pressing the tab key to move from field to field. The 
information is automatically saved. 

To search for this information select one of the fields named “Owner Custom 1,” 
“Owner Custom 2,” “Parent Custom 1,” or “Parent Custom 2.”  

HINT: For best results limit the type of contact that you put into each 
field (e.g., Custom 1 = Regional Manager and Custom 2 = Corporate 
PD). This will make it easier for you in creating searches by personnel 
type on which to do mailings. 

The first and last names and title of your custom contacts will also appear on the 
Owner Contacts screen accessed by clicking on the Display Contacts button on the 
Owners Tab.  

These fields can be edited or entered on this screen, but address and phone 
information is only available for editing in the Contacts fields available from the 
Position drop down box on the Owners Tab. 
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Custom Report Writing 

Creating Custom Reports 
MEDIA Access Pro™ has an advanced feature wherein you can design your own 
custom reports. While not a pre-requisite, it is extremely helpful to have a knowledge 
of FoxPro Report Designer. Below are some cursory instructions. For more complex 
scenarios, we recommend training in Microsoft Visual FoxPro or contact your BIAfn 
Customer Service Executive (607-936-6737 or mahelp@bia.com) for a price quote 
to design a custom report to meet your specifications. 

1. For best results, select a report from the Custom Report Options (Print 
> Custom Reports) to use as a guide. Look for the report that has the 
layout that most closely resembles your desired results. 

 
2. Replace the name of the sample report with the title of your new 

custom report. 

3. If desired, type in a Report Subtitle in the space provided. 

4. Click on the Modify button. 

 
5. Click on OK to create the new report and open the Report Designer. 

 

6. Access the Report Controls by clicking on the Report Control icon  
available in the Visual FoxPro Report Designer toolbar shown below. 
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7.  Using the controls in the Report Controls toolbar you can modify 

titles, headings and fields to get the report results you desire. 

  

 
NOTE: If the Report Designer or Report Controls toolbars are not 
present when you open the report for modification, the Report Controls 
can also be accessed from the menu bar by clicking on Report > Insert 
Control. 

8. When completed, close the Report Designer by clicking on the boxed X 
in the upper right corner of the program screen. 

NOTE: To make additional modifications to your custom report, 
highlight the report name in the Report Options box and click on 
Modify and OK. 

Save Custom Report 
The Save Custom Report feature allows you to call up a report you personally 
modified and previously saved in order to save an additional copy to a disk or 
another directory. This is a useful tool for creating backup copies to protect your 
hard work (highly suggested when doing a program reinstall). The Save feature also 
assists you in distributing copies of your customized reports to other licensed users 
within your organization. 

NOTE: MEDIA Access Pro™ will not allow you to change any of the built-in 
reports that ship with the program. However, you may use these built-in reports as 
templates for new reports you wish to create, and you must give a different name to 
your new customized report. 

How To: Save Custom Report 
1. From the Print menu, click on Save Custom Report. The Save Custom 

Report selection box will appear. 

2. Click on the report you want to save to a diskette or other directory. 
The Save As dialog box will appear. 

3. Select or create the directory to which you would like to save a copy of 
your report. 

4. Press the Save button. 
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Load Custom Report 
The Load Custom Report feature allows you to add a report from a disk or another 
directory to the list of Custom Reports from which you can select. This is a useful 
tool for reinstalling backup copies of your customized reports and for adding reports 
created by someone else or from scratch in Visual FoxPro. 

How To: Load Custom Report 
1. From the Print menu, click on Load Custom Report. The Load Custom 

Report selection box will appear. 

2. Click on the Load button and the Windows Open dialog box appears. 

3. Locate the file you want to load and click on OK. 

4. The new report will now appear in your list of Custom Reports. 

Customizable Fields 
On the bottom left corner of the Contacts Tab in the Selection Criteria Screen, 
MEDIA Access Pro™ provides a group of fields for you to customize. 

 

Custom and Search Flags 

 
These two buttons, when clicked, create toggled logical fields that allow you to flag 
records that meet a certain criteria you have identified. To flag the record, click on 
the Custom or Search buttons and a “T” for True will appear. To remove the flag, 
press the Custom or Search buttons again and an “F” for False will appear.  

To globally set and clear flags for either the entire database or your specific search 
results, see Set/Clear Flags later in this section.  

To search for records with Custom or Search Flags, your Selection Criteria 
Statement would read “Flag-Custom = True” or “Flag-Search = True.”  

HINT: If you flag your own clients with a True, you can build marketing and sales 
leads lists that exclude these clients. Just make sure you include the following filter 
condition: “Flag-Custom = False” in your Selection Criteria. 

Last Call 

 
The Last Call button allows you to stamp the station record with the date of your last 
contact with the station. Using this feature expands MEDIA Access Pro™ into a 
contact management tool. You can search this field from the Selection Criteria 
Screen with the statement “Date-Last Call equals MM/DD/YYYY” or “Date-Last 
Call is greater than MM/DD/YYYY.” 



 

144  •  12: Customizable Features MEDIA Access Pro™ Version 4.0 User Manual 

Call Back 

 
The Date-Call Back field is another contact management tool that provides a field for 
you to type in a date to set as a reminder to call back your contact at this station. You 
can search this field from the Selection Criteria Screen with the statement “Date-Call 
Back equals MM/DD/YYYY” or “Date-Call Back is greater than MM/DD/YYYY.” 

Network and Local Comments 

 
While only a portion of the text for each of these notes appear, these are unlimited 
length fields in which you can type notes regarding the subject station.  

1. From the Contacts screen containing the record of the desired station or 
newspaper, click on the Network Comments button to open the full 
window.  

 
2. Click on the Home key on your keyboard to place your cursor at the 

beginning of the note  

Or 

Click on the Page Down key on your keyboard to put your cursor at the 
end to add notes at the bottom of the text on the screen. 

3. If you are operating MEDIA Access Pro™ from a workstation 
installation that points to a network to access the program and data, any 
information entered into the Network Comments will be posted to your 
company’s network. In this way, everyone in the company with access 
to MEDIA Access Pro™ will have the ability to make notes in, refer to, 
and search on these fields.  
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The Local Comments reside only on your computer and are accessible only at your 
workstation and operate identically to the Network Comments. 

To search a Network or Local Comments field, include a filter condition like the 
examples below: 

“Comments-Local contains the text 20030713” 

“Comments-Net contains the text Customer” 

HINT: If you are using MEDIA Access Pro™ as a contact management tool, it is 
suggested that you type the most recent notes at the top of the Comments field so 
you can scroll from newest down to oldest. This way you can easily refer to the most 
recent activity with the station or newspaper. Also, for best results, begin your notes 
with the date, the time and your initials for easier tracking. 

Set/Clear Flags 

 
Through this screen, accessed from the File menu, you can globally set flags for your 
current search results, or clear the Custom or Search flags. 

Calendar/Diary 
The Calendar/Diary is a tool to assist you in using MEDIA Access Pro™ for project 
planning and contact management. 

To access the Calendar/Diary, click on File menu > Calendar/Diary. 
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Monthly Calendar - Click on the day of the month for which you wish to enter 
appointments or notes. 

Daily Note Pad - Click on the day of the month and year in the calendar for which 
you would like to enter notes. Click in the notepad and type in your notes. 

NOTE: At this time, this diary feature is only available on stand alone workstations 
(not Networks). BIAfn is presently working on this feature to make it available in a 
future program update for network users. 

Month Navigators - Use these buttons to scroll forward and backward through the 
months of the year. 

Year Navigators - Click on these buttons to scroll back and forth by year. 

Today Button - Click on this button to return to the notes page for today. 
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13: Coverage Maps 

This chapter gives you the prerequisites for operating BIAMapX™ Coverage Maps 
and procedures for viewing and printing maps.  

Overview 
BIAMapX™ Coverage Maps is a feature available in Radio, Television, and/or 
Newspaper that works with either the Analyzer or Contacts versions of MEDIA 
Access Pro™. If you are licensed to use Coverage Maps, the Map tab on the Station 
Information or Newspaper Information screen will be fully operational (launches the 
BIAMapX™ Viewer).  

The map program allows you to draw City Grade and Secondary Grade contours for 
Radio stations, Grade A and Grade B contours for Television stations (see the table 
below for grade specifications), and county coverage for Newspapers. Within a 
specific media, you have the ability to draw contours for just one station or compare 
contours for many stations. Also, if you are licensed for the multi-media 
functionality, you have the ability to integrate the data and see combined maps for 
those media for which you are licensed. 

Radio Contour Definitions 
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Television Contour Definitions 

 

Newspaper Coverage Definition 
Newspaper coverage is based on the Secondary Market counties outlined on the 
Newspaper Market #2 Tab in which the subject newspaper has a certain significant 
percentage of subscribers. 

Coverage Maps Prerequisites to Operation 
• MEDIA Access Pro™ must be installed and open. 

• BIAMapX™ must be installed on the user’s hard drive. 

• If a network installation wherein the base layer map elements and 
contour data are maintained on the network, the user’s BIAMapX™ 
Path Properties must be directed to the appropriate network location 
(see #14 through #18 in Coverage Maps Network and Workstation 
Installation). 

• If a custom installation was elected and the user will be accessing the 
base layer map elements (Cities, States, Street, etc.) from the MEDIA 
Access Pro™ CD, the CD must reside in the CD drive, and the user’s 
BIAMapX™ Path Properties must be directed to the CD drive (see #7 
through #10 in Coverage Maps Stand-Alone Default Installation). 
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Installation 

Stand-Alone Default Installation 
The following instructions take you through the steps of installing the BIAMapX™ 
Coverage Maps program to the hard drive of your computer, accepting all the 
defaults. 

1. Place the MEDIA Access Pro™ CD-ROM in the CD-ROM drive. 

2. Click on Start > Run to open the Run window. 

3. Click on Browse. 

4. Double click on the BIAMapX subdirectory. 

5. Double-click on the Setup.exe file to open the BIAMapX InstallShield 
Welcome screen. 

6. Read any notes and warnings on the Welcome screen and click on 
Next. 

7. Read the “License Agreement” and click on Yes if you agree with the 
agreement’s terms and conditions. Clicking on No will close the setup 
program. 

8. In the Customer Information screen type in your Name and 
Organization Name. 

9. Under the “Install this application for:” area, click on the button next to 
either, “Anyone who uses this computer (all users)” or “Only for 
me,” and then click on the Next button. 

10. In the Setup Type screen, click on Complete and Next. 

The Installing BIAMapX window appears and the InstallShield 
program installs the appropriate BIAMapX files and reflects the 
progress in the bar under Status. 

11. The InstallShield Wizard Completed screen will appear when 
installation is complete. Click on Finish to complete the installation 
process for Stand-Alone and Network installations. 

Stand-Alone with Data Run from the CD-ROM 
The BIAMapX™ installation includes some 400+ megabytes of base layer data 
(Counties, Cities, Streets, etc.) that is installed to your hard drive by default when 
you select the Complete setup. However, if hard drive space is at a premium, by 
selecting the Custom installation, you can opt to access this data from the program 
CD by following the instructions below. 

1. Follow steps 1 through 9 under Coverage Maps Stand-Alone Default 
Installation.  

2. In the Setup Type screen, click on Custom and Next. 

3. In the Custom Setup screen click on the plus sign to the left of the 
BIAData folder to see the BIAMaps subfolder. 
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4. Click on the down arrow next to the BIAMaps subfolder and click on 
the “X  This feature will not be available” and then click on Next to 
proceed with the custom installation. 

The Installing BIAMapX window appears and the InstallShield 
program installs the appropriate BIAMapX files and reflects the 
progress in the bar under Status. 

5. The InstallShield Wizard Completed screen will appear when 
installation is complete. Click on Finish to complete the installation 
process for Stand-Alone and Network installations. 

6. With the MEDIA Access Pro™ CD-ROM in your CD-ROM drive, go 
to the Windows Desktop and double click on the BIAMapX™ icon to 
open the program. 

 
7. Click on File > Properties to open the Properties window. 

8. Under Paths, click in the browse box   to the right of MapX Data 
Line. 

9. While in the Browse by Folder window Open your CD-Rom Drive, 
double click each folder listed: 
BIAMapX 
BIAData 
Until you reach the BIAMaps directory and click on OK. 

10. In the Properties window, click on OK to save the changes. 

11. Close the BIAMapX™ viewer to set the new properties. 

Network and Workstation Installation 
The following instructions provide you with the information for setting up the 
BIAMapX™ Coverage Maps for operation and data updating via a shared network 
drive and installing to the workstation user’s computer. 

Network Installation 

1. Place the MEDIA Access Pro™ CD-ROM in the CD-ROM drive of a 
workstation computer. 

2. Create the folder \BIAData\ on one of your network drives. 

3. Copy the contents of the BIAData folder (approximately 425 MB) from 
the MEDIA Access Pro™ CD-ROM (including the BIAMaps sub-
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folder) to the newly created folder on the network. Therefore, on your 
network, you should have a BIAData folder with:  

• BIA.DAT 

• CONTOUR.DAT 

• CONTOUR.NDX, and 

• A BIAMaps sub-folder with the files BIA.GST and 
BIA_DATA_DIC.DAT, as well as Cities, County, Other and 
Streets sub-folders. 

Workstation Installation 

1. Click on Start > Run to open the Run window. 

2. Click on Browse. 

3. Double click on the BIAMapX subdirectory. 

4. Double-click on the Setup.exe file to open the BIAMapX InstallShield 
Welcome screen. 

5. Read any notes and warnings on the Welcome screen and click on 
Next. 

6. Read the “License Agreement” and click on Yes if you agree with the 
agreements terms and conditions. Clicking on No will close the setup 
program. 

7. In the Customer Information screen type in the Name of the 
workstation user and the Organization Name. 

8. Under the “Install this application for:” area, click on the button next to 
either, “Anyone who uses this computer (all users)” or “Only for 
me,” and then click on the Next button. 

9. In the Setup Type screen, click on Custom and Next. 

10. In the Custom Setup screen click on the plus sign to the left of the 
BIAData folder to see the BIAMaps subfolder. 

 

 
 

11. Click on the down arrow next to the BIAMaps subfolder and click on 
the “X  This feature will not be available” and then click on Next to 
proceed with the custom installation. 

The Installing BIAMapX window appears and the InstallShield 
program installs the appropriate BIAMapX files and reflects the 
progress in the bar under Status. 
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12. The InstallShield Wizard Completed screen will appear when 
installation is complete. Click on Finish to complete the installation 
process for Stand-Alone and Network installations. 

13. With the MEDIA Access Pro™ CD-ROM in your CD-ROM drive, go 
to the Windows Desktop and double click on the BIAMapX™ icon to 
open the program. 

 
14. Click on File > Properties, Under Paths. 

15. MA Map Data, this should be pointing to the directory where the 
BIA.DAT file is located.  If you accepted the defaults, it should be 
C:\BIADATA. 

16. CONTOURS- from the default drive of C: to point to the shared 
network drive (e.g., D:\BIAData) where the Contour.dat and 
Contour.ndx files are located on the network and click on OK. 

17. MapX Data.Change the drive letter from the default drive of C: to 
point to the shared network drive (e.g., F:\BIAData\BIAMaps) where 
the BIAMaps subdirectory files are located on the network (Cities, 
States, etc.) and click on OK. 

18. In the Properties window, click on OK. 

19. Close the BIAMapX™ viewer to set the new properties. 

BIAMapX™ Viewer 

 
Below is an overview of the areas on the BIAMapX™ Coverage Map screen. 
Detailed information follows in subsequent sections. 
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1. Menu Items - Click on these menu items to perform file functions, 
access tools and consult online help. 

NOTE: Most items available through the menu items also have an icon 
available on the toolbar. See #2, Toolbar, below. 

• File Menu 

o Print… - Opens the Print window. 

o Print Preview - Allows you to preview the printed output. 

o Export - Provides a way to save map as an electronic image 
(JPEG, Bitmap, etc.). 

o Properties - Opens the window where you define some of the 
overriding properties of the program. 

o Exit - Closes the BIAMapX™ program. 

• Tools 

o Arrow - Provides you with the tool for selecting stations, 
newspapers, markets, toolbars, and most other items required 
for creating a map. 

o Zoom In - This tool allows you to zoom in on a map to reveal 
more details. 

o Zoom Out - Use this tool to zoom out and widen the aspect of 
the map in your viewer. 

o Extent - Selecting this menu item will adjust and center the 
map to accommodate the stations and newspapers plotted 
within the view. 

o Pan - This tool gives you the hand for grabbing and moving 
the map within the viewer (left click, hold, and drag). 

o Label - The label tool allows you to apply a label to elements 
on your map.  

o Scale Bar - Clicking this menu item will apply a scale bar to 
the upper left corner of your map. 

o Layer - The layer tool opens the Layer Control selection box. 

o Annotation - This tool provides you with the flexibility of 
applying custom notes to your map and adjusting the font type 
and style of the note. 

• Help - Consult this area for online help for the Coverage Maps and 
to access the “About BIAMapX” window, which provides you 
with version information. 

2. Toolbar 

 

  Arrow - Select stations, newspapers, markets, other tools, etc., 
using the arrow. 

  Zoom In - Every time you click using this tool, you will zoom in 
closer on your map to reveal more details. To reverse the process click 
on the Zoom Out icon described below. With this tool selected, holding 
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down the left mouse button and outlining a box on the map you can 
custom design the zoom level you desire. 

  Zoom Out - With each click of this button you zoom out farther 
to get a more expanded view of the map. Click on the Zoom In button 
to reverse the process. With this tool selected, holding down the left 
mouse button and outlining a box on the map you can custom design 
the zoom level you desire. 

  Pan - Click on this tool to manipulate the placement of the map in 
the viewer. Left click, hold, and then drag the map. Release the left 
mouse button and the map will redraw to incorporate the new view. 

  Label - The label tool allows you to apply a label to elements on 
your map. Click on this tool and the cursor changes to a cross-hair. 
Click in the area you wish to apply a label (NOTE: the cross-hairs 
depict the center of the placement of the label). After a few moments, a 
table will appear with all of the available items that can be labeled in 
that location. Click on the desired item and then click on OK. Your 
label should appear. You cannot move this label once you place it, so 
you will need to use the Remove Label tool to delete it and then 
reapply the label in the more desirable location. 

  Remove Label  - Click on this tool when you wish to remove a 
label. The cursor changes to an outlined arrow. Click on the label and it 
will turn to red and then disappear from the map view.  

  Annotate - Use this tool to customize your map with text. Click 
on the map in the location you want to place the text. A small, gray-
bordered box will appear with a blinking cursor inside. Begin typing 
and the box will expand to accommodate your text. To adjust the point 
size of your annotation, place your cursor over one of the corners, left 
click and drag to the desired text size. Press Enter to set your text. To 
move your annotation, left click on the text, the gray box will reappear 
and a crossed double arrow will appear. Left click, hold, and drag the 
text to the desired position. To delete an annotation, click on the text to 
activate the gray box and then press the Delete button on your 
keyboard. 

  Layer Control - Clicking on this button will open the Layer 
Control window wherein you can adjust the display of various elements 
on your map. See section on Layer Control for more detailed 
information. 

  View Extent - Click on this button to automatically adjust the 
zoom and center your map to include the elements that you have 
mapped. 

  Scale Bar - Click on this tool to apply a scale bar to the upper left 
corner of your map. As you adjust your zoom, the scale bar will change 
accordingly. 

  Print - When clicked, this icon will launch the Print dialog box. 
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  Print Preview - Click this button to view your map output prior 
to printing.  

  Export - Activate the export option by clicking on this button. 
See section on Exporting for more detailed information. 

  Properties - Open the Properties box by selecting this icon. See 
section on Setting Properties for more detailed information. 

3. Map View Window - Displays the base map and elements that you 
select to include in your output. 

4. Map Name - Customizing feature wherein you can type in the title you 
desire to appear on the printed version of your map output. 

5. Reload - Every time you make an adjustment to the feature -- add or 
remove a station, change the aspects of a layer -- you click on this 
button to reveal the results in the Map View Window.  

6. Zoom Factor - Provides you with the zoom scale of the present map 
displayed in the Map View Window. 

NOTE: You can manually alter the Zoom Factor by typing in your 
desired zoom scale and clicking on the Reload button. 

7. Center - Provides the longitudinal and latitudinal center of the map 
displayed in the Map View Window. 

NOTE: You can manually alter the center location of your map by 
typing in the desired longitude and latitude in the spaces provided and 
clicking on the Reload button. 

8. Station / Service / Status - From this window you can:  

• select the stations that you want to plot on your map by clicking in 
the check box to the right of the station’s listing, 

• view technical information about the station by left clicking on the 
station name, or 

• modify the color of the station’s contour by right clicking on the 
station name and selecting the color from the Color window. 

9. Market Areas - Allows you to display a layer that depicts a specific 
market’s or a newspaper’s coverage. Click on one of the displayed 
markets to open the Region Style window to select the pattern and 
color you desire to display the market. See Layer Property Controls for 
more information on Region Styles under Display Mode. 

 

Viewing Maps 
Following are instructions for viewing station and newspaper contour maps using 
BIAMapX™ Coverage Maps.  

1. MEDIA Access Pro™ Results - Perform a search in MEDIA Access 
Pro™ to obtain the results you desire. 

2. Map Tab - From the Results tab within the Station or Newspaper 
Information screens, click on the Map tab. 
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3. Results Selection -  In addition to cursory information (CALLS or 
Newspaper name, market, etc.) about the station or paper in whose 
record you now reside, you will find a gray box on the left side of the 
tab. It is here you will select whether you want to work with:  

Radio and Television stations  

• This Station - the specific station selected as noted to the right,  

• Market - those stations rated in a specific Arbitron (Radio) or 
Nielsen (TV) market,  

• 50 Mile Radius - within a 50 mile radius of the station you have 
currently selected, or 

• Selected Stations - the stations resulting from the search you just 
conducted.  

NOTE: When a specific rated Radio market is selected, the 
BIAMapX™ Viewer will provide only the one market for viewing 
selection under the Market Areas section. To view adjacent markets 
and/or all the markets in which each station garners Arbitron (Radio) 
ratings, choose either the Selected Stations or 50 Mile Radius options. 

Newspapers  

• This Newspaper - the selected paper as noted above on the Maps 
tab, 

• Newspapers in the Area - in the area (meaning other Newspapers 
that share counties in the same coverage area), or 

• All Selected Newspapers - all the selected newspapers in your 
search results. 

Click the button next to your selection 

4. Select Another Market (Optional Step) - If, in the Radio or 
Television databases, you’ve selected Market in step 3 above, confirm 
that the highlighted market in the scroll box is the market that you 
want. If not, click on the desired market from the scroll list. 

5. Select Results Order - For Radio or Television, when the 
BIAMapX™ program opens, it will list the stations in the order that 
you have selected in the Display Results section of the gray box. Click 
on the button next to either CALL Letter Order which will be 
alphabetical, or Search Results Order which will follow the order 
displayed on the Results tab of your current search. 

6. Build Map - Click on the Build Map button. The BIAMapX™ 
program will open and draw the base map for the area you selected.  

NOTE: If BIAMapX™ is already open on your desktop and you run a 
new search and click on Build Map, another instance of BIAMapX™ 
will be launched. 

7. Station Selection - In the Station / Service / Status box, click on the 
check box next to the station or stations you wish to view.  

8. Reload - Click on the Reload button and the BIAMapX™ will draw 
the contours for the stations you’ve selected in the color indicated in 
the box next to the station’s CALLS in the list on the left.  
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9. Change Contour Colors - To change the color of  a specific contour, 
right click on the station’s CALLS in the Station / Service / Status box 
to launch the Color selection window. Select from the supplied colors 
or click on the Define Custom Colors>>> for more options. Click on 
OK in the Color window and then on Reload in the BIAMapX™ 
Viewer to initiate the color change. 

10. Add or Remove Stations - To add or remove stations from the view, 
click in the check box to select or deselect a station and click on the 
Reload button. 

11. Resizing - To resize the map so that all of the contours you’ve selected 

are visible in the screen view, click on the View Extent button  in 
the toolbar. 

12. Market Areas - To view Newspaper coverage or Arbitron (Radio) or 
Nielsen (TV) market areas, click on the desired market or newspaper to 
open the Region Style selection window. Under Fill select the desired 
pattern and color of the shading. Under Border, select the Style, Color 
and width of the border line (see Layer Property Controls later in this 
chapter for more detailed information). Click on OK and then the 
Reload button in the BIAMapX™ Viewer to see your selection. 

13. Technical Information - To view technical information on a particular 
station, left click on the call letters to open the Station Info box. Click 
on the Next or Previous buttons to move through the information on 
any of the stations in your results list. 

Printing Maps 
The following instructions will help you to print a coverage map that you have 
generated from MEDIA Access Pro™.  

1. In the BIAMapX™ Viewer click on the Print Preview icon  in the 
toolbar to see a sample of how your map will look when printed. 

2. Included at the top of the screen with the sample of your map as it will 

print, are a few tools. If desired, use the Zoom tools,   , to 
adjust your preview of the printed output.  

3. To make adjustments to your map before printing, click on the Close 
button to return to the BIAMapX™ Viewer. 

4. If the map appears satisfactory, click on the Print button  to open 
the Print window, select the desired options, and click on OK to send 
your map to the printer. 
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Coverage Maps Properties 
 

 
Through the Properties window you set the default behavior of various features and 
functions of the BIAMapX™ Viewer as described below. Make the necessary 
changes and click OK in the Properties window and then click on the Reload button 
in the BIAMapX™ Viewer. 

1. Paths - In this section of the Properties window you set the paths 
where the BIAMapX™ viewer will find the files on your computer on 
network with which to work. 

If you elect to accept the default settings of the MEDIA Access Pro™ 
and BIAMapX™ installation, you will not be required to alter these 
settings. However, if you alter the drives where files are stored, you 
will need to adjust these settings. To change any file path, either 
directly type in the path (accuracy is critical) or click on the browse 
button  found to the right of the file path to access the Browse for 
Folder dialog box and pinpoint the appropriate directory. 

Below is a description of the settings required. 

• MA Map Data - Set this path to find the BIADATA directory on 
your computer where the BIA.dat file is stored.  

NOTE: The BIA.dat file houses the temporary data derived from 
the results of your search in MEDIA Access Pro™ and is the basis 
for the maps creation for each individual user. Therefore, this 
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setting should always point to the user’s workstation hard drive, 
and it must match the setting shown under File > Change Settings 
> Map Data in MEDIA Access Pro™. 

• Contours - Set this path to find the contour files (i.e., contour.dat 
and contour.ndx), which, by default, are installed under the 
BIADATA subdirectory on your computer or network. These are 
the contour files that are updated by BIAfn to reflect technical 
changes filed with the FCC. 

• MapX Data - This path is looking for the location of the City, 
County, Streets and other base map files, which, if installed to your 
computer or network are placed by default in the 
BIADATA\BIAMAPS subdirectory. If you have elected to work 
with this information directly from the MEDIA Access Pro™ CD, 
this path should point to your CD-Rom drive and the CD will need 
to be in place in order for the system to operate properly.  

2. Printing Options - Allows you to set the default print direction, 
Portrait or Landscape, for your map output. Portrait is the installed 
default orientation. 

3. Exporting Options  - This section sets the parameters for exporting 
graphic images of the maps you create. 

• Height - Set the default height of the map image you export. When 
you do, the width is automatically adjusted to provide you with a 
proportional image of the map you export. 

• Width - Sets the default width of the map image you export. When 
you do, the height is automatically adjusted to provide you with a 
proportional image of the map you export. 

NOTE: The visual quality of the image output will increase with the 
size of the image -- the larger the image, the better the quality, 
however, the larger the size of the resulting image file. 

• Export Format - Select your preferred graphic image format for 
output. Built-in formats from which to select include: 

o Windows Metafile (*.wmf) 

o Windows Bitmap (*.bmp) 

o Graphics Interchange Format (*.gif) 

o JPEG (*.jpg) 

o TIFF (*.tif) 

o Portable Networks Graphics (*.png) 

o Photoshop (*.psd) 

• Export Scale - Sets the scale option of your output (1 = regular 
output, 2 = doubles the size, 3 = triples the size of your graphic, 
etc.). 

4. Contour Display - When checked, the appropriate Contours (Primary 
or Secondary) for Radio or Television stations will display on your 
map. Within this box you can also set the default width of the contour 
lines for the Primary and Secondary Contours (1=Narrow and 
4=Thick).  
NOTE: Additionally, 2mV/m contours are available as an option to 



 

160  •  13: Coverage Maps MEDIA Access Pro™ Version 4.0 User Manual 

those who require them.  Radio networks to determine programming 
overlap typically use 2mV/m contours. 

5. User Layers - When the Save User Layer box is checked any changes 
you make in the layer control box will be saved.  For example, if you 
make the county lines a different color, set interstates to not display, or 
any other change, those changes will be remembered every time you 
open the program.  You can revert to the original configuration by 
clicking on the Revert To Default Layers button 

6. Station Selection 

• Licensed - When this box is NOT checked, the BIAMapX™ 
viewer will eliminate all of the Licensed based contours from the 
import into the Viewer program.  

• Construction Permit - When this box is NOT checked, the 
BIAMapX™ viewer will eliminate all of the Construction Permit 
based contours from the import into the program. 

• Special Temporary - When this box is NOT checked, the 
BIAMapX™ viewer will eliminate all of the contours based on 
Special Temporary status provisions authorized by the FCC from 
the import into the Viewer program. 

• Display Status/Service with Callsign - If unchecked, the label for 
the contour will only include the Callsign. When checked, the 
station’s contours will be labeled with: 

 
o the station’s Callsign 

o the FCC service of the station 

AM = AM Radio 

FM = FM Radio 

TV = Analog Television (NTSC) 

TX = Television Translator 

CA = Class A Television 

DT = Digital Television (ATSC) 

DS = Digital Special Temporary Authorization 

o the Status that the contour portrays 

LI or L=Licensed 

CP or C= Construction Permit 

ST = Special Temporary Authorization 

• Display Contour Level with Callsign - When checked a station’s 
label will include the field strength of the contour displayed. 
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Coverage Maps Layer Control 

 
1. Layer Window 

2. Layer Control Navigation 

3. Custom Layer Add and Remove 

4. Layer Properties Control 

5. Layer Display Controls 

6. Layer Label Controls 

Through the Layer Control window you can control how and where the various 
properties of your coverage map will appear. 

To access the Layer Control window you can either 

• Right click in the Map View Area, 

• Click on the Layer icon  in the toolbar, or 

• Click on Tools > Layer in the menu bar, 

 Layer Window 
The BIAMapX™ Viewer uses the power of the copyrighted MapInfo MapX© as its 
platform. MapInfo provides all the aspects you see in the form of layers that are 
listed in the Layer Window. As an analogy, think of using an overhead projector -- as 
you put one transparency over another, you see new layers and more details of a 
graph or picture.  To modify a layer, click to highlight it. From here you can  

• change the prominence of the layer by clicking the Up and Down 
buttons (the closer to the top of the list the more prominent), 
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• modify the properties of the layer (see Layer Properties Control) 

NOTE: Changes in the Layer settings are only temporary. When you exit the 
BIAMapX™ Viewer and reopen it later, the system default settings will be 
reinstated.  

Available Layers 

Listed below in alphabetical order are the layers that are built-into the BIAMapX™ 
Viewer and a short description of each. At the end of each listing is the default 
behavior of each layer [V=Visible; S=Selectable; A=Automatic Labels; E=Editable; 
Yes=Checked; No=Not Checked]. See Layer Property Controls for more 
information. 

• ContourA - This layer depicts the Primary contour of the Radio or 
Television station. [V=Yes; S=Yes; A=Yes; E=No] 

• ContourA All - all processed Contours. The layer used by the system 
that allows for all of the Primary contours to appear for all of the 
stations available for selection. [V=No; S=Yes; A=No; E=No] 

• ContourB - The Secondary contour of the Radio or Television stations 
is provided in this layer. [V=Yes; S=Yes; A=Yes; E=No]. 

NOTE: Secondary contours will only be displayed if View Secondary 
Contours has been checked in the Contour Display section of the 
Properties window. 

NOTE: Technically, there are no secondary contours for Television 
stations with the following FCC Services: Translator (TX), Digital 
Television (DT), Digital Special Temporary Authorization (DS), and 
Class A Television (CA). However, so that a contour appears for each 
station, when selecting to see only Secondary contours (ContourB), the 
Primary contour (ContourA) will display. 

• ContourB All - The layer used by the system that allows for all of the 
Secondary contours to appear for all of the stations available for 
selection. [V=No; S=Yes; A=No; E=No] 

• County - Detailed map if the United States by County. Displays the 
county boundaries and county names. [V=Yes; S=Yes; A=Yes; E=No] 

• County_LowRes  - General map if the United States by County. A low 
resolution version of the County layer used by the system for faster 
redrawing and higher zoom levels. [V=Yes; S=No; A=No; E=No] 

• Inter-States - Contains Interstates in the United States. Provides the 
location and labeling of Interstate highways. [V=Yes; S=Yes; A=No; 
E=No] 

• Large Cities - Contains larger towns and Cities (No metro area.) 
Displays the area and label of larger cities. [V=Yes; S=Yes; A=Yes; 
E=No] 

• Major Streets - Contains the major streets within urban areas. Provides 
the location and labeling for major streets. [V=Yes; S=Yes; A=No; 
E=No] 

• Markets - All Markets boundaries. Defines the area of markets and 
newspaper coverage and applies labeling. [V=Yes; S=Yes; A=No; 
E=No] 
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• Medium Cities -Contains small towns. Displays the area and label of 
medium-sized cities. [V=Yes; S=Yes; A=Yes; E=No] 

• OCEAN – Very large blue box to show water. Defines the areas 
covered by oceans. [V=Yes; S=No; A=No; E=No] 

• Small Cities - Contains very small towns and villages. Displays the 
area and label of small-sized cities. [V=Yes; S=Yes; A=Yes; E=No] 

• State Highways - Contains State Highways in the United States. Plots 
state highways and allows for labeling. [V=Yes; S=Yes; A=No; E=No] 

• Station - Pinpoints the transmission site of the station and provides the 
ability to label that site. [V=Yes; S=Yes; A=Yes; E=No] 

• StationAll - All stations. The layer used by the system that allows for 
all of the Primary and Secondary contours to appear for all of the 
stations available for selection. [V=No; S=Yes; A=No; E=No] 

• US Cities - Contains the top 8000 cities by population in the United 
States. Displays the symbol and label for US cities . [V=Yes; 
S=Yes; A=Yes; E=No] 

• US Major City- Contains the top 1000 cities by population in the 
United States. Displays the symbol and label for major US cities. 

[V=Yes; S=Yes; A=Yes; E=No] 

• US Top 20 Cities - Contains the top 20 cities by population in the 
United States. Displays the symbol and label for US cities . 
[V=Yes; S=Yes; A=Yes; E=No] 

• USA -Map of the United States by state but no islands and no water is 
visible (But higher quality map). Defines the borders of the United 
States. [V=Yes; S=No; A=No; E=No] 

• USA_LowRes - Map of the United States by state but no islands and 
no water is visible. Provides a low-resolution border of the United 
States. [V=Yes; S=No; A=Yes; E=No] 

• World Countries - World Map. Provides the layer portraying all the 
world countries other than the United States. [V=Yes; S=No; A=No; 
E=No] 

Layer Control Navigation 
Using the Up and Down buttons, you can move layers into positions to provide 
greater prominence in your Map View and on your printed output.  

1. In the Layer Window click and highlight the layer you wish to move. 

2. Click on the Up or Down button to position it in the desired location. 

Custom Layer Add and Remove 
You can customize your version of BIAMapX™ to include additional layers not 
already provided by BIAfn. Any type of geographic data can be added to your maps. 
Many other layers are available. Call you BIAfn Account Executive (703-818-2425) 
for more information. 
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Adding a Layer 

1. Right click on the Map View window to open the Layer Control 
window. 

2. Click on the Add button. 

3. The Open window will appear. Locate the MapInfo table (*.tab) for the 
layer you would like to add and double-click on the filename. 

4. The layer will now be included at the bottom of the Layer Window. 
Use the Up and Down buttons to position the layer to gain the 
prominence of the layer you desire. 

NOTE: In order to see your custom layer, you will need to repeat these steps each 
time you close and reopen the BIAMapX™ viewer. 

Removing a Layer 

1. Right click on the Map View window to open the Layer Control 
window. 

2. Click and highlight the custom layer you would like to remove. 

3. Click on the Remove button to delete the layer. 

NOTE: The built-in layers supplied with your BIAMapX™ program can be 
accidentally removed. If this should happen, you can reinstate the missing layers by 
simply closing the program and reopening it. 

Layer Properties Control 
This section of the Layer Control box allows you to change the behavior and 
appearance of the individual layers. Click on the layer to highlight its name in the 
Layer Window and the following settings can be changed. 

NOTE: The changes made to the Layer Properties Control are temporary and will 
revert back to the system default once you have closed the BIAMapX™ viewer. 

Visible - When checked the subject layer will be visible in the Map View and will 
appear in the printed output. To this layer invisible from the Map View, click to 
remove the check mark. 

Selectable - Works with the labeling feature. When checked and you use the custom 
labeling tool, the identifying label for the subject layer will appear in the Select 
Label window. To remove the labeling option for this layer, click to remove the 
check mark. 

Automatic Labels - Labels for the subject layer will automatically appear on your 
map when this box is checked. To remove the automatic labeling feature, click to 
eliminate the check mark. 

Editable - When checked, this feature allows you to edit map objects.  

Display…- Click this button to open the Display Properties window wherein you can 
modify the appearance properties of the selected layer. 
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o Display Mode - Allows you to modify the style in which the 

selected layer appears. Click the check box next to Override Style 
and then click on the down arrow next to the style button to access 
the display option buttons. You can select between (from top to 
bottom): 

  Region Style -Allows you to fill the coverage area 
of the specific layer with a selected pattern and optionally border it 
with a selected line width and style, both in a custom selected 
color. 

 

  Line Style - Customize the line style of your 
selected layer by clicking on the line tool and opening the Line 
Style box. Here you can select from dozens of line styles, 
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customize the color of the line, and set the line width in pixels or 
points. 

 

  Symbol Style - Click on the symbol tool to open 
the Symbol Style box. This allows you to select and customize the 
symbol you want to depict the layer you have selected in the Layer 
Window.  

 

  Text Style -Selecting the text tool opens the Text 
Style box. In this box you can adjust the selected font, font size, 
text color, background enhancements, and text effects of the 
selected layer.  

 
o Zoom Layering - Click the box next to Display within Zoom 

Range to control the display of the layer as it relates to the zoom 
level. The selected layer will only appear if the scale is between 
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the minimum and maximum values that appear in the upper left 
corner of the BIAMapX™ Viewer. 

o Show Line Direction - Place a check mark in the box next to this 
option to provide directional arrows on a selected layer with line 
style. 

Labels… - This button opens the Label Properties window wherein you can control 
the appearance and behavior of the labeling features of the selected style.  

 
• Label With - This area functions with the addition of a Custom Layer. 

When adding a custom layer, select the Dataset table and Field that 
holds the data for the selected custom layer.  

• Visibility - Checking the Display with Range box allows you to control 
the display of the label as it relates to the zoom level. The selected layer 
will only appear if the scale is between the minimum and maximum 
values that appear in the upper left corner of the BIAMapX™ Viewer. 
You can also select the ability to allow overlapped text, duplicated text, 
the labeling of partial objects and the maximum number of labels that 
can appear for a specific layer on a particular map. 

• Styles - Click on the text button  to open the Text Style box 
wherein you can modify the font, font size, text color, background 
enhancements, and text effects of the selected label. Click on the Label 

button  to open the Line Style box. Here you can select from 
dozen of line styles, customize the color of the line, and set the line 
width in pixels or points for the border of the label for the selected 
layer.  
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• Position - You can customize the orientation and rotation of the label 
using the options under the Position section. 

Multi-Media Coverage Maps 
If you are a licensed Multi-Media and Coverage Maps subscriber, you will have 
access to the Multi-Media Maps tab. From this tab you can access the BIAMapX™ 
Coverage Maps program and plot the coverage of the integrated media to which you 
are licensed. 

For more details on Multi-Media Coverage Maps, consult Chapter 6 on Multi-Media. 
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14: System Maintenance 

This chapter covers backing up and restoring your customized files, verifying 
searches, rebuilding your system, reindexing your files, changing the settings, 
switching versions, and setting or clearing custom flags. 

Backing-Up Customized Files 
If you have created saved searches, input notes in the Local Comments fields, 
designed custom reports, or input custom contacts in MEDIA Access Pro™, you will 
want to frequently backup your work. This will help insure your work in the unlikely 
event of it being overwritten or corrupted. It is recommended that if you use the 
customization features of MEDIA Access Pro™ regularly, you should set a schedule 
to back-up daily, weekly, monthly, or as fits your comfort level. There is a built-in 
utility explained below under the heading User Data Backup.  

User Data Backup (Built-in Utility) 
1. With MEDIA Access Pro™ open, click on Utilities in the menu bar. 

2. Click on User Data Backup (or type Ctrl + B on your keyboard). 

3. In the Select a Directory window choose the appropriate directory for 
placing your backup files and click on Select.  

NOTE: It is highly recommended that you choose a directory outside 
of the BIADATA subdirectory and preferably in a location other than 
on the same hard drive location of your MEDIA Access Pro™ program 
and/or data.  

4. Once the process is complete a message will appear stating, “Backup 
Complete.” Click on OK. 

MEDIA Access Pro™ will create a backup copy of all the customized files 
highlighted below.  

NOTE: You may or may not have all of these files depending on the versions for 
which you are licensed.  

For information on recovering your custom data files, see the following section on 
Restoring Backed Up Files. 
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Manual Custom Data Backup 
If for some reason you cannot access the MEDIA Access Pro™ program, you may 
want to backup your custom files manually.  

1. Close MEDIA Access Pro™. 

2. Using the method you are most comfortable with (e.g. Windows 
Explorer), copy the following files including all of the files beginning 
with these names and the varying extensions (.DBF, .CDX, .FPT) from 
your BIADATA\MASTER\USER directory to a diskette or another 
directory you specify.   

NOTE: You may or may not have all of these files depending on the 
versions for which you are licensed.  

Found in the \BIADATA\MASTER\USER subdirectory: 

• favorite (Field List Favorites) 

• lblNames  (Custom Labels) 

• nannotes (Network Local Comments) 

• rannotes  (Radio Local Comments) 

• rptnames  (Custom Reports) 

• sqlsets  (Saved Searches) 

• tannotes  (Television Local Comments) 

Found in the \BIADATA\MASTER\DATA directory: 

• nNetNote* (Newspaper Network Comments and Custom 
Newspaper Contacts) 

• nNetOwn* (Newspaper Custom Owner Contacts) 

• rNetNote*  (Radio Network Comments and Custom Station 
Contacts) 

• rNetOwn* (Radio Custom Owner Contacts) 

• tNetNote*  (Television Network Comments and Custom Station 
Contacts) 

• tNetOwn* (Television Custom Owner Contacts) 

* In the case of a network installation, these files will be found in the 
BIADATA\MASTER\DATA directory found on the network. 

You may now reopen BIAfn’s MEDIA Access Pro™. 

Restoring Backed-Up Files 
In the unlikely event your saved searches, Local Comments notes, or custom reports 
are corrupted or overwritten, if you have created back-up files recently you may 
restore them. The currency of the files depends on how recently you performed the 
backup or created customizations. It is recommended that if you use the 
customization features of MEDIA Access Pro™ regularly, you should set a schedule 
to back-up daily, weekly, monthly, or as fits your comfort level.  



 

MEDIA Access Pro™ Version 4.0 User Manual 14: System Maintenance  •  171 

User Data Restore (Built-in Utility) 
1. With MEDIA Access Pro™ open, click on Utilities in the menu bar. 

2. Click on User Data Restore (or type Ctrl + R on your keyboard). 

3. Click on Yes to the message “Are you sure want to restore from a 
previous backup?”. 

4. In the Select a Directory window choose the appropriate directory 
where you saved your backup files and click on Select.  

5. Once the process is complete a message will appear stating, “Program 
Shutting Down. You will need to restart BIAfn’s MEDIA Access Pro 
in order to finish the user data restore process.” Click on OK. 

6. Go to your Windows Desktop and double-click on the MEDIA Access 
Pro™ icon to re-open the program. 

Manual Custom Data Restore 
In the highly unlikely event that the built-in utility (Utilities > User Data Restore) is 
not operating correctly, you can restore your backed up custom files manually. 

1. Close MEDIA Access Pro™. 

2. Using the method you are most comfortable with, copy the following 
backup files, including all of the files beginning with these names and 
the varying extensions (.DBF, .CDX, .FPT), from the diskette or the 
backup directory you specified, to your BIADATA\MASTER\USER 
directory.   

NOTE: You may or may not have all of these files depending on the 
versions for which you are licensed. 

• favorite (Field List Favorites) 

• lblNames  (Custom Labels) 

• nannotes (Newspaper Notes) 

• rannotes  (Radio Notes) 

• rptnames  (Custom Reports) 

• sqlsets  (Saved Searches) 

• tannotes  (Television Notes) 

3. Copy the following backed up files to the BIADATA\MASTER\DATA 
directory. In the case of a workstation installation, this directory will be 
found on the network. 

• nNetNote (Newspaper Network Comments and Custom 
Newspaper Contacts) 

• nNetOwn (Newspaper Custom Owner Contacts) 

• rNetNote  (Radio Network Comments and Custom Station 
Contacts) 

• rNetOwn (Radio Custom Owner Contacts) 

• tNetNote  (Television Network Comments and Custom Station 
Contacts) 
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• tNetOwn (Television Custom Owner Contacts) 

4. You can now reopen BIAfn’s MEDIA Access Pro™. 

Verify Searches 
When you install a data update, MEDIA Access Pro™ is designed to automatically 
update your saved searches with the most current fields of data. If you should receive 
an error message while trying to run a saved search, we suggest you try this “fix” 
first.  

1. Select the Utilities menu. 

2. Click on Verify Searches. 

3. You will receive a dialog box stating, “This process will verify your 
saved searches. Are you ready to proceed?” Click on the Yes button. 

4. You will see prompts in a rectangular box in the upper right hand 
corner as the verification process is being performed. When this 
disappears, try running your saved search again. 

NOTE: If the saved search still does not work, it is suggested that you rebuild the 
system or, as a last resort, recreate your search criteria from scratch. If you have any 
questions or problems, call (607-936-6737) or email (mahelp@bia.com) your Client 
Services Department for assistance. 

Rebuild System 
Infrequently, due to power surges and other unexpected occurrences, the MEDIA 
Access Pro™ system will deliver an Error Message when you are trying to run a 
search, print a report, or export the data. When this happens, it is suggested that you 
rebuild your system. 

NOTE: It is highly recommended that you back up your customized user files, such 
as saved searches, comments fields, and custom reports before running this process. 

1. Click on the Utilities menu. 

2. Click on Rebuild System. 

3. MEDIA Access Pro™ will display a message informing you that you 
will need to be prepared to Quit and restart the program in order to 
proceed. Click on Yes and MEDIA Access Pro™ will close down.  

4. Restart MEDIA Access Pro™ from the Windows Start button or from 
an icon on your Windows desktop. 

5. You will see prompts in a rectangular box in the upper right hand 
corner as the verification process is being performed.  

NOTE: Depending on the speed of your machine and the number of 
other programs you may have open in the background, this process may 
take several minutes to complete. When the rectangular box disappears, 
try running your saved search again. 

NOTE: If the saved search still does not work after performing both 
the Verify Searches and Rebuild System procedures, it is suggested that 
you recreate your search criteria from scratch. If you have any 
questions or problems, call (607-936-6737) or email 
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(mahelp@bia.com) your Client Services Department for personal 
assistance. 

Reindex Files 
If you are not receiving the results you expect from your search criteria and you have 
double checked the validity of the criteria, it may be that your data files need to be 
reindexed  in order to create the correct results you desire. This option will reindex 
all of the searches you saved on the overview screen. It is unlikely, but possible, that 
your indexes could become corrupted. This is most likely to happen if you turn your 
computer off without exiting MEDIA Access Pro™ first. This is a simple process. 

1. Click on the Utilities menu. 

2. Click on Reindex Files. 

3. You will receive a message warning you that this may take several 
minutes. Click on Yes if you want to proceed. 

4. You will see prompts in a rectangular box in the upper right hand 
corner as the reindexing process is being performed. When the 
rectangular box disappears, try running your search again. 

NOTE: If you are still having problems, call (607-936-6737) or email 
(mahelp@bia.com)  your Client Services Department for personal 
assistance in reviewing your search criteria. 

Change Settings 

 
The Change Path Settings screen allows you to direct MEDIA Access Pro™ to the 
path locations of the required files needed for proper operation. 

The Change Settings screen is accessed by clicking on the File menu > Change 
Settings. 

User Path - Points to the directory where some customizable features such as saved 
searches and output fields default changes are stored.  
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WARNING: If you are working from a network version, it is 
mandatory that all workstations’ User Path point to the workstation 
(e.g., c:\biadata\master\user).  

Custom Version - Reserved for the use of clients whose version of MEDIA Access 
Pro™ has been customized to interact with their own proprietary data (accounting; 
sales; etc.). Call you BIAfn Sales Executive (1-800-331-5086) for more information 
on customizing your version of MEDIA Access Pro™. 

Data Path - This should point to the directory where your data files are stored, either 
on your workstation’s hard drive or the network drive containing the 
BIADATA\MASTER\DATA folders. 

Reports Path - This should point to the directory where your built-in custom reports 
are stored, either on your workstation’s hard drive or the network drive containing 
the BIADATA\MASTER\REPORTS folders. 

Map Data - This should point to the directory where each user’s map data file 
(BIA.dat) is stored on their workstation’s hard drive, usually \BIADATA. 

Map Program - This should point to the directory where BIAfn’s mapping 
program’s executable files are stored, either on your workstation’s hard drive under 
PROGRAM FILES or on the network drive containing the SITESAFE\BIAMAPX\ 
BIAMAPX.EXE file. 

Export Path - This should point to the default directory where the users would like 
their exported data files directed.  

NOTE: This path is network sensitive meaning that if changed by one user, 
it will change for all users. 

Save Button - When correct, press this button to register the new settings.  

Cancel Button - Click on this button to exit the Change Path Settings screen without 
saving your changes. 
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Change Version 

 
There are two options available for changing between the Radio, Television and 
Newspaper versions of MEDIA Access Pro™, either through the File menu, 
explained below, or through the Title Screen. 

File > Change Version 

Click on File and Change Version to access the Choose Media screen.  

From this screen you can select either the Radio, Television, or Newspaper versions 
by clicking on the radio button next to the desired media. If you are a licensed 
Analyzer user, you also have the option of customizing the program to display either 
the Analyzer or Contacts version and, for Radio, to include or exclude the Rankers 
and/or Ratings modules. Those components that are not available under your present 
licensing agreement with BIAfn will be grayed out. To upgrade your MEDIA Access 
Pro™ capabilities, call your BIAfn sales executive (1-800-331-5086). 

Web Browsing - When checked, MEDIA Access Pro™ will automatically launch, if 
not already activated, your default web browser whenever you click on a website 
hyperlink or the Web Site tab in the Station Information or Newspaper Information 
screens. To temporarily remove this automatic feature click on the check mark to 
remove it. To restore it, click on File > Change Version and click to enable the check 
mark. 

“Search Only” Toolbar - When checked the Search Only toolbar will appear every 
time you activate a Quick Search, New Search, or Saved Search. To temporarily 
remove this feature, click to remove the checkmark.  

NOTE: The “Search Only” checkbox on the Quick Search and Selection 
Criteria screen of the Selection Set windows will override the option on the 
Choose Media Screen. 
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Set/Clear Flags 

 
Through this screen, accessed from the File menu, you can globally set flags for your 
current search results, or clear  the Custom or Search flags. 
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Glossary of Terms 

FIPS 
Federal Information Processing Standards code designated for each county in the 
United States. 

MSA 
Arbitron, Inc.'s Metropolitan Statistical Area that designates a rated radio market. 

Primary County 
The main county in which the subject media can garner its largest audience share or 
subscriber base. 

Primary Media 
The original media version from which search results are based for the Multi-Media 
data integration. 

Local Commercial Share 
Average 12-month Arbitron 12+ share adjusted for lost listening to out-of-market 
and non-commercial radio stations. 

Revenue Share 
Share of market revenue per Arbitron 12+ share (Radio) or Nielsen total day share 
(Television). 

Power Ratio 
Estimated revenue share per Local Commercial Share. 

Metro Cume 
The total number of different persons who tune to a radio station during the course of 
a daypart for at least five minutes. 
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DMA 
Designated Marketing Area is a registered trademark of, and defined by, Nielsen 
Media Research denoting a television market. Ranking of such markets is based on 
the number of television households within a given market.  
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